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About this Guide

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information. 

This section provides the following information:

• Document Objectives

• Audience

• Document Organization

• Related Documentation

• Document Conventions

• Obtaining Optical Networking Information

• Obtaining Documentation, Obtaining Support, and Security Guidelines

Revision History
This is the first issue of this publication. 

Document Objectives
The Cisco TransportPlanner DWDM Operations Guide, Release 8.5 explains how to design networks 
using the Cisco TransportPlanner design tool for the Cisco ONS 15454 SONET and SDH systems. It 
contains information about how to design an optical network. Use the Cisco TransportPlanner DWDM 
Operations Guide, Release 8.5 in conjunction with the appropriate publications listed in the Related 
Documentation section.

Audience
This publication is intended for experienced network system engineers who are responsible for planning 
and ordering equipment for Cisco optical networking systems.
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About this Guide
Document Organization
Document Organization
This Cisco TransportPlanner DWDM Operations Guide, Release 8.5 is organized into the following 
chapters:

• Chapter 1, “Overview” provides a list of features, an overview of the network design process, a 
description of the internal architecture, and the Cisco TransportPlanner procedural flow.

• Chapter 2, “Designing Networks with Cisco TransportPlanner” provides instructions for using the 
Cisco TransportPlanner tool to create a network design, adjust and optimize design components, and 
generate reports and bills of materials.

• Chapter 3, “Modeled Network Examples” provides examples of typical optical networks that you 
can model using Cisco TransportPlanner.

• Appendix A, “GUI Information and Shortcuts” provides Cisco TransportPlanner graphical user 
interface shortcuts. 

• Appendix B, “Card Types” provides a list of card types that can be used to build a network, and the 
corresponding Cisco product identifier.

• Appendix C, “Error Messages” provides a list of system errors.

• Appendix D, “Third-Party DWDM Wavelength Interface Model” provides reference information on 
third-party DWDM interface calculation.

Related Documentation
Use this Cisco TransportPlanner DWDM Operations Guide, Release 8.5 with the following referenced 
publications:

• Cisco ONS 15454 DWDM Procedure Guide, R8.5—Provides procedures to install, turn up, 
provision, and maintain a Cisco ONS 15454 node and network.

• Cisco ONS 15454 DWDM Reference Manual, R8.5—Provides reference material for Cisco 
ONS 15454 nodes and networks.

• Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5—Provides general troubleshooting 
procedures and alarm descriptions.

• Cisco SONET TL1 Command Guide, R8.5 and Cisco SDH TL1 Command Guide, R8.5—Provide test 
access TL1 commands, configurations, and parameter types.

• Release Notes for the Cisco ONS 15454, R8.5 and Release Notes for the Cisco ONS 15454 SDH, 
R8.5—Provide caveats, closed issues, and new feature and functionality information.

Document Conventions
This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.
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About this Guide
Obtaining Optical Networking Information
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that 
pertains to all of Cisco, refer to the Obtaining Documentation, Obtaining Support, and Security 
Guidelines section.

[ ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. To see translations of the warnings that appear in 
this publication, refer to the translated safety warnings that accompanied this device.

Note: SAVE THESE INSTRUCTIONS

Note: This documentation is to be used in conjunction with the specific product installation guide 
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other 
enclosed additional documentation for further details.

Convention Application
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About this Guide
Obtaining Documentation, Obtaining Support, and Security Guidelines
Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15454 system. It also 
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.htm
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Overview

Note Cisco MetroPlanner has been renamed as Cisco TransportPlanner starting with release 8.5. 

Cisco TransportPlanner Software R8.5 provides a way to model and test wavelength division 
multiplexing (WDM) optical networks in a graphical environment. The primary purpose of Cisco 
TransportPlanner is to help sales engineers (SEs) design and validate networks of Cisco Optical 
Networking System (ONS) 15454 Multi-Service Transport Platforms (MSTP). Using 
Cisco TransportPlanner Software R8.5, an SE can create multiple instances of a network to modify 
different parameters in each instance for comparison. Cisco TransportPlanner generates a shelf view of 
all the sites deployed in the optical network and provides a complete bill of materials (BOM) for the 
network and the differences between instances of a network. 

This chapter describes how you use Cisco TransportPlanner to design, analyze, and optimize new or 
existing Cisco optical networks and contains the following sections:

• 1.1 Cisco TransportPlanner Features, page 1-1

• 1.2 Network Design Process, page 1-2

• 1.3 Cisco TransportPlanner Process Flow, page 1-5

• 1.4 Planning Traffic in Cisco TransportPlanner, page 1-7

• 1.5 Cisco TransportPlanner Traffic in the Project Explorer Pane, page 1-8

• 1.6 Auto, Forced, and Locked Parameters, page 1-11

1.1 Cisco TransportPlanner Features
Cisco TransportPlanner Software R8.5 provides a simple tool set for designing optical networks with 
Cisco ONS 15454 MSTP products. You can enter all of the network parameters or minimal information, 
such as site distance, and Cisco TransportPlanner will model the network you need to build and generate 
a detailed BOM with ordering information. Designing optical networks requires the verification of 
multiple constraints such as optical budget limitations and platform architectural restrictions. One 
Cisco TransportPlanner project can contain multiple copies of a network. This allows you to change 
parameters in one network copy, then analyze and compare to another network copy to determine the 
differences. In addition to this capability, Cisco TransportPlanner Software R8.5 provides the following 
new features: 

• Network upgrade to implement forecasted channels

• Slot preprovisioning (by importing the NE Update file into the Cisco Transport Controller [CTC])
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• User-defined equipment lists in the parts database

• Fiber separation allowing a user to manage certain parameters (such as loss) for each strand in a fiber 
pair 

• Forced equipment settings (user-defined parameters instead of Cisco TransportPlanner automatic 
settings)

• Power consumption calculation

• L-band design 

• C-band enhanced booster 

• C-band plus L-band/50-GHz scalable design

• Multishelf management 

• New DWDM client interfaces

• Meshed reconfigurable optical add/drop multiplexing (ROADM) 

• Capability to select the type of maintenance contract desired to appear in the BOM

• Support for OPT-AMP-C amplifier

• Support for GE and 10GE Xponder

• Support for 10G ADM blade

1.2 Network Design Process
To generate a network design, the SE enters the following parameters:

• The topology of the network—ring, linear, or meshed

• The type of equipment used at each site

• The distance separating the sites

• The type of fiber connecting the sites

• Service demands, including the service type, the protection type, and the number of channels 
between nodes

• The number of network sites

When the network parameters are entered, Cisco TransportPlanner finds the best routing, defines the 
required add/drop filters, and places optical amplifiers and dispersion compensation units (DCUs) to fit 
the user traffic demands at the minimum cost. Optimization is performed to meet the boundary 
conditions. The optimization includes attenuation and amplification.

Finally, Cisco TransportPlanner generates a BOM, which includes the product codes, the quantities, and 
pricing information. In addition, it creates other reports, such as a shelf-level view of the configuration, 
which can be printed. This helps the SE understand how the shelf is built and helps to avoid confusion 
and errors during the actual deployment. Within the BOM is the total network cost, which allows a quick 
comparison of various design options. The total network cost is the cost of the equipment for all of the 
sites in the designed network.
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1.2.1 Network Design Constraints
Cisco TransportPlanner searches for the best solution to a designed network using an optimization 
algorithm.

A network design must meet the optical budget and receiver overload criteria to operate efficiently. An 
analysis of optical budget and receiver overload evaluates the strength of the signal traversing the ring. 
If a design solution satisfies the constraints, it is a valid design. The Cisco TransportPlanner Software 
R8.5 optimization algorithms generate multiple solutions and verifies the constraints against those 
solutions. If the constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected 
as the optimal solution.

If the network design solution fails to satisfy all the constraints, Cisco TransportPlanner Software R8.5 
makes adjustments to parameters such as signal attenuation and amplification. Amplification is achieved 
by using an erbium-doped fiber amplifier (EDFA). Attenuation is achieved by using variable optical 
attenuator (VOA) modules integrated into the platform. Cisco TransportPlanner Software R8.5 corrects 
the optical budget using an algorithm that includes automatic placement of EDFAs and VOA regulation.

For each internodal demand, Cisco TransportPlanner Software R8.5 performs an optical budget and 
receiver overload analysis and displays the results in various reports in the Graphical User Interface 
(GUI). If the network design algorithms are not able to provide a solution, then you can modify the input 
data (for example, by relaxing some user constraints) and run the analysis again. 

1.2.2 Platform Support
Cisco TransportPlanner Software R8.5 supports the Cisco ONS 15454 DWDM optical platform 
Software Releases 4.7, 5.0.x, 7.0.x, and 8.x.

1.2.3 Topology Support
Cisco TransportPlanner 8.5 supports the following network topologies:

• Bus (single span, point-to-point, and linear)

• Open (or hubbed) ring

• Closed (or meshed) ring

• Any-to-any ring (ROADM)

• Meshed network

Cisco TransportPlanner Software R8.5 allows you to design flexible networks with up to 100 site 
locations. A flexible network is a network that, using ROADM nodes, allows traffic 
modification/reconfiguration as traffic requirements change.

For Cisco TransportPlanner Software R8.5, the maximum number of locations where the optical service 
channel (OSC) is terminated is 40. The maximum number of add/drop locations is 40.
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1.2.4 Protection Scheme Support
Cisco TransportPlanner Software R8.5 designs support the following protection schemes:

• Y-cable protected—In Y-cable protection, one transponder card is designated as active and the other 
as standby. The standby transponder card has the client-side laser turned off to avoid corrupting the 
signal transmitted back to the client. The active transponder monitors the signal from the trunk side 
and in the event of loss or signal failure, the system switches to the standby path.

• Client-based 1+1—Two client signals are transmitted to separated line cards or transponder cards 
instead of using a Y-cable to split one client signal into two line cards or transponder cards. In client 
1+1 protection, the failure and switchover is controlled by the client system.

• Fiber-switched protection—The single client signal is injected into the client receive (Rx) port. It is 
then split into two separate signals on the two trunk transmit (Tx) ports. The two signals are 
transmitted over diverse paths. The far-end card chooses one of the two trunk Rx port signals and 
injects it into the Tx client port.

• Unprotected—Protection is not used.

• External card switch—Protection not used.

1.2.5 Service Support
Cisco TransportPlanner Software R8.5 can support any subset of the following services:

• Alien (third-party DWDM interface)

• Cisco ONS 15530 2.5 Gbps Aggregated

• ONS 15530 10 Gbps Aggregated

• ONS 15530 Multirate (MR) Transport

• ONS 15530 Data Multiplexer (MXP)

• 2R Any Rate

• Gigabit Ethernet

• 10GE—10 Gigabit Ethernet (LAN and WAN)

• D1 Video

• DVB-ASI—Digital Video Broadcast-Asynchronous Serial Interface

• DV-6000

• ESCON—Enterprise System Connection 

• Fast Ethernet

• Fibre Channel 1G

• Fibre Channel 2G

• Fibre Channel 4G

• Fibre Channel 10G

• FICON—Fiber Connection 1G

• FICON Express 2G

• FICON 4G
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• High Definition Television (HDTV)

• ISC-3 Peer (1G)

• ISC-3 Peer (2G)

• ISC-3 Peer (2R)

• ISC-Compat (ISC-3 Compatibility Mode)

• OC-3

• OC-12

• OC-48

• OC-192

• OC-768

• SDI—Serial Data Input 

• STM-1

• STM-4

• STM-16

• STM-64

• STM-256

• Sysplex CLO—control link oscillator 

• Sysplex ETR—external throughput rate 

Note The Sysplex CLO and Sysplex ETR services are supported only on the following topologies: 

• Single span—Two terminal sites with 32MUX-O and 32DMX-O cards, 40MUX-O and 40DMX-O 
cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed and no 
intermediate sites in between.

• Point-to-Point—Two terminal sites with 32MUX-O and 32DMX-O cards. 40MUX-O and 
40DMX-O cards, 40WSS and 40DMX, or 32WSS and 32DMX or 32DMX-O cards installed. Line 
amplifiers can be installed between the terminal sites, but intermediate (traffic terminating) sites 
cannot be installed.

• Two hubs—Two hub nodes in a ring with 32MUX-O, 32DMX-O, 32WSS, 40MUX-O, 40DMX, 
40DMX-O, 40WSS, and 32DMX cards or 32DMX-O cards installed. Line amplifiers can be 
installed between the hubs.

Refer to the Cisco ONS 15454 DWDM Reference Manual for more information about the supported 
topologies for the ETR and CLO services.

1.3 Cisco TransportPlanner Process Flow
The following stages are used to complete a network design. See Figure 1-1 for the process flow.

1. Create a project using the Project Creation wizard.

2. Create a network using the Create Network wizard. The Create Network wizards adds sites and 
places the fiber spans between the sites. A span represents a pair of fibers. 
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3. Create a point-to-point, AggregatedEthernet, TDM Aggregated, protected ring (P-ring), and/or 
ROADM service demand.

4. Analyze the network design.

5. If you would like to force automatic tool choices, adjust the design and repeat the analysis until you 
have reached the desired configuration.

6. Create an Install copy of the network and update the parameters with real data from the field.

7. Analyze the Install network.

8. Create an upgrade copy of the network, as needed, to add forecasted channels.

Figure 1-1 Cisco TransportPlanner Process Flow
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1.4 Planning Traffic in Cisco TransportPlanner
Traffic in Cisco TransportPlanner is defined as an optical path for each pair of nodes requiring a service 
demand. An optical path is the combined channels between the two nodes. The following list gives 
definitions for some basic traffic items:

• Circuit—A single channel between a pair of source and destination nodes. In addition to the source 
and destination nodes and all the attributes that are common to the service containing the circuit, a 
circuit has the following attributes:

– Present/forecast indication

– Routing direction for unprotected service

– ITU channel

– Optical bypass indication

• Demand—A set of circuits with common characteristics, such as:

– Service demand label

– Number of existing circuits

– Number of forecasted circuits

– Client service type

– Protection type

– Optical bypass (number of channels and/or sites)

– WDM interface type (TXT or ITU-LC)

– WDM card type

– Source client interface (SR, IR, or LR) 

– Destination client interface (SR, IR, or LR)

• Traffic demand—All traffic between the same set of nodes. Both L-band and C-band are supported. 
The following traffic demands are supported: P-ring, Fixed (point-to-point), and Any-to-any 
(ROADM). 

In P-ring traffic demands, all the demands are used to support traffic topologies similar to 
bidirectional line switched rings (BLSRs) or multiplex section-shared protection rings 
(MS-SPRings). Each P-ring demand is between a pair of added/dropped nodes where BLSR-like (or 
MS-SPRing-like) traffic must exist. The number of circuits is the same for each demand, and is 
user-specified (from 1 to 40).

In fixed (point-to-point) traffic demands, the set of nodes is restricted to two sites. The number of 
circuits is user-specified (from 1 to 40).

In any-to-any (ROADM) traffic demands, a minimum of two nodes and a maximum of 40 ROADM 
nodes are supported. An any-to-any traffic demand allows each node to establish one or more 
circuits with the other nodes, either as a hub or meshed configuration. In a meshed configuration, 
each node defined in the set is connected to each other node. This is the most common traffic type. 
In a hub configuration, the user-defined hub node is connected to each of the other nodes. ROADM 
circuits have the same protection types and services. The number of circuits is not user-specified and 
can vary from 0 to 40.

A ROADM demand can have multiple client service types and supports multiple DWDM card 
interfaces for each client service type. A ROADM demand supports the following routing strategies:

– Protected (Default)—Each node pair in the traffic demand is connected using two connections.
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– Unprotected optimum optical path—Each node pair is connected using one connection. The 
unprotected optimum optical path minimizes the number of required optical amplifiers, but also 
restricts the number of channels that can be deployed among the nodes of the traffic demand 
(maximum of 40 channels between each node pair) in the installed network.

– Unprotected minimum hop count—Each node pair in the traffic demand is connected by one 
connection. The unprotected minimum hop count maximizes the number of channels (for 
unprotected traffic types only) that can be deployed among the nodes of the traffic demand, but 
can requires a higher number of optical amplifiers on the unprotected optimum optical path 
(maximum of 40 channels between each node pair) in the installed network.

– Unprotected subnet—Each node pair in the traffic demand is connected using one connection. 
You can manually force connections on only one branch of the ring. For unprotected subnets, 
you must manually select one starting node of the branch and the direction the ring must be 
traversed to define the subnet, starting from the initial site. The branch direction is specified by 
defining the outgoing side first, referred to as the starting node. This routing strategy option 
allows you to exclude some critical paths and (with ROADM traffic demands containing two 
sites) to force each ROADM connection clockwise or counterclockwise.

1.5 Cisco TransportPlanner Traffic in the Project Explorer Pane
Cisco TransportPlanner Software R8.5 represents all of the user-defined traffic services as a tree view 
within the Project Explorer pane. The Project Explorer shows all of the open project information, 
including the networks, the network dependencies, sites, fibers, services, etc. (Figure 1-2). 

Figure 1-2 Project Explorer View

After you analyze a network design, the colors of tree view change according to the error/warning 
condition of the network design. The icons display as red if there are errors in the network design; orange 
if there are warnings but no errors; and green of there are no warnings or errors. The icon shows the color 
of the most severe condition. For more information about analyzing the network, see the “2.4 Analyzing 
the Network” section on page 2-62. 
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Right-clicking on certain items in the Project Explorer tree allows you to edit the parameters. Refer to 
Chapter 2, “Designing Networks with Cisco TransportPlanner” for more information about optical 
results, the traffic matrix, and editing.

1.5.1 Point-to-Point Traffic Demands
Point-to-point traffic demands appear in the Service Demands > PointToPoint folder in the Project 
Explorer pane. Each point-to-point traffic demand is categorized by its source and destination site 
names. All of the point-to-point services between the two sites appear under the designated demand 
name (Figure 1-3).

Figure 1-3 Point-to-Point Traffic Demand in the Project Explorer 

A point-to-point traffic demand includes the following information:

• Client service type

• Site# – Site# (source and destination site labels for this demand)

1.5.2 P-Ring Traffic Demands
Each protected ring (P-ring) traffic demand appears in the Project Explorer pane under the 
Service Demands > P-Rings folder. Figure 1-4 shows an example of a P-ring traffic demand in the 
Project Explorer.

Figure 1-4 P-Ring Traffic Demand in the Project Explorer 

All the P-ring channels between each site pair are listed under each P-ring traffic demand. Each demand 
is labeled with the following information:

• P-ring number

• Client service type

• Site# – Site# (source and destination site labels for this demand)

1.5.3 ROADM Traffic Demands
Each ROADM traffic demand appears in the Project Explorer under the Service Demands > ROADMs 
folder. The ROADM folder contains each defined ROADM demand. You can define more demands for 
the same ROADM for the same set of nodes. Figure 1-5 shows an example of a ROADM traffic demand.
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Figure 1-5 ROADM Traffic Demand in the Project Explorer 

In the Project Explorer, each ROADM includes the ROADM demand name and a list of DWDM card 
types that support the client service types. Protection types appear in parentheses. 

1.5.4 Aggregated Ethernet Demand
Each aggregated ethernet traffic demand appears in the Project Explorer under the Service Demands > 
Aggregated Ethernet folder. The Aggregated Ethernet folder contains each defined aggregated ethernet 
demand. Aggregated Ethernet demands are supported on ring and linear traffic subnets. Figure 1-6 
shows an example of a aggregated ethernet traffic demand.

Figure 1-6 Aggregated Ethernet Demand in Project Explorer

1.5.5 TDM Aggregated Demand
Each TDM aggregated demand appears in the Project Explorer pane under the Service Demands > 
Aggregated TDMs folder. Figure 1-7 shows an example of a TDM aggregated traffic demand in the 
Project Explorer.

Figure 1-7 TDM Aggregated Demand in Project Explorer

TDM aggregated demands are supported only on a ring traffic subnet. 
1-10
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 1      Overview
Auto, Forced, and Locked Parameters
1.6 Auto, Forced, and Locked Parameters
Parameters in Cisco TransportPlanner can be in one of three states:

• Auto— This allows the highest degree of flexibility to the Cisco TransportPlanner in designing a 
network. When a user selects Auto, Cisco TransportPlanner chooses the parameter value during 
network analysis.

• Forced—When a user sets a specific parameter value, other than Auto, Cisco TransportPlanner 
designs the network using these constraints. When a setting is forced, the item appears in blue italics 
in the Project Explorer pane.

• Locked—The state of a parameter after network analysis. The next time the analyzer is run, Cisco 
TransportPlanner cannot change the value when in the Locked state. A user can unlock an item using 
the Unlock command. For more information, see the “2.7.4 Unlocking Parameters in the Network 
Design” section on page 2-129. Figure 1-8 shows an example of sites in a locked state. 

Figure 1-8 Locked Sites in the Project Explorer View

Depending on the initial state, the network analyzer will:

• Move the parameter into the Locked state when the unit or parameter was set to Auto.

• Leave the parameter in the same state if the user forced a specific value for the unit or parameter.
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Designing Networks with 
Cisco TransportPlanner

Cisco TransportPlanner provides you with numerous tools for customizing the software, creating and 
analyzing networks, and creating a bill of materials (BoM). You can use Cisco TransportPlanner to 
perform the following tasks:

• 2.1 Launching Cisco TransportPlanner, page 2-14

• 2.2 Setting Cisco TransportPlanner Options, page 2-18

• 2.3 Creating a Project, page 2-36

• 2.4 Analyzing the Network, page 2-62

• 2.5 Viewing Network Reports, page 2-62

• 2.6 Editing a Project, page 2-90

• 2.7 Managing the Network Design, page 2-126

• 2.8 Generating a BoM, page 2-131

• 2.9 Managing the Price List, page 2-136

Note To run Cisco TransportPlanner, you must install Java Runtime Environment (JRE) 1.5.0. You can 
download it from the following URL:
http://java.sun.com/j2se/1.5.0/download.jsp
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Launching Cisco TransportPlanner
2.1 Launching Cisco TransportPlanner 
Before you start Cisco TransportPlanner, you need to save the user profiles provided to you by Cisco 
Systems to the profiles directory. Access to Cisco TransportPlanner features depends on the user profile 
you select when you start Cisco TransportPlanner. The default profile is Network Designer.

Note In Cisco TransportPlanner Software Release 8.5, the user does not need a user ID and password to log 
into Cisco TransportPlanner.

Use the following procedure to launch Cisco TransportPlanner:

Step 1 Copy the CTP-v850.zip file to your hard drive. 

Step 2 Extract the ZIP file using the Extract to Folder option.

Step 3 Copy the profiles provided to you to the profiles folder.

Step 4 Launch Cisco TransportPlanner by double-clicking the ctp.jar file. 

The Cisco TransportPlanner 8.5 Login dialog box appears (Figure 2-1).

Figure 2-1 Cisco TransportPlanner 8.5 Login Dialog Box

Step 5 Click Continue to open Cisco TransportPlanner. 

The login profile type appears in the lower right corner of the Cisco TransportPlanner window. 
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2.1.1 Opening a Project
Use the following procedure to open an existing Cisco TransportPlanner project. To create a new project, 
see the “2.3 Creating a Project” section on page 2-36.

Step 1 Click the project name under Open in the Tasks Pane (Figure 2-2). The project opens. If you do not see 
the project name listed, continue with Step 2.

Step 2 Click Open under Project in the Tasks Pane or in the File menu.

Figure 2-2 Opening a Project from the Tasks Pane

Step 3 In the Open Project dialog box, navigate to the desired directory and choose the project. Click Open. 
The Cisco TransportPlanner project appears.

2.1.2 Loading and Unloading Networks
Each network in a project requires memory. To save memory, when Cisco TransportPlanner opens a 
project, all networks are in the Unloaded state. An unloaded network appears in the Project Explorer with 
a “U” next to the network identifier (Figure 2-3). To load an unloaded network, double-click on the 
network folder in the Project Explorer, or right-click the network and choose Load from the shortcut 
menu. 
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Figure 2-3 Unloaded Network in the Project Explorer 

A loaded network appears in the Project Explorer with an “L” next to the network identifier (Figure 2-4). 
To unload a loaded network, right-click the network icon in the Project Explorer and choose Unload 
from the shortcut menu.

Figure 2-4 Loaded Network in the Project Explorer 

2.1.3 Saving a Project
Use the following procedure to save a project:

Step 1 Choose one of the following:

• To save an existing project with the same filename, choose File > Save. You have completed this 
procedure.

• To save a new project, choose File > Save and go to Step 2. 

• To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step 2 In the Save Project dialog box, navigate to the desired directory and type the filename. Click Save. 
Cisco TransportPlanner saves projects as zipped files with the MPZ extension.

2.1.4 Importing a Cisco TransportPlanner Release 2.5 Project
Use the following procedure to import a Cisco TransportPlanner Release 2.5 project:

Step 1 From the File menu, choose Import 2.5.x project. 

Step 2 In the Open Project dialog box, navigate to the desired directory and choose the project. 
Cisco TransportPlanner Release 2.5 projects have a file extension of CMZ. 

Step 3 Click Open. The Import R2.5-Project-Name dialog box appears (Figure 2-5).
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Figure 2-5 Import <R2.5 Project Name> Dialog Box

Step 4 Choose one of the following:

• Import only inputs—Choose this option to import all of the Cisco TransportPlanner 2.5x project 
input data. The Cisco TransportPlanner 7.0x will define service aggregation, routing of services, 
amplifiers, and dispersion compensation units (DCU) during network analysis. 

• Import outputs as forcings—Choose this option to import all of the Cisco TransportPlanner 2.5x 
input and output data with the exception of the optical results and installation parameters. When you 
run the network analyzer in Cisco TransportPlanner 7.0x, it does not change the imported output 
data parameters; the network analyzer treats these imported values as forced parameters. 

Step 5 In the Target System Release area, choose the desired release: Release 4.7, Release 5.0, Release 7.0.

Step 6 If you chose Import outputs as forcings, choose the desired outputs to import:

• Import OADM units

• Import Amplifier units and parameter

• Import traffic constraints

• Import client SFP modules

• Generate aggregation groups

Step 7 Click OK. The Cisco TransportPlanner Release 2.5 project appears.
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2.1.5 Closing a Project
Use the following procedure to close a Cisco TransportPlanner project:

Step 1 From the File menu, choose Close. 

Step 2 In the Save Project dialog box, click Yes to save or No to close without saving changes. 

Step 3 If you clicked Yes and have not previously save the project, the Save Project dialog box appear. Type the 
name of the project and click Save. The project closes. 

Step 4 To exit Cisco TransportPlanner, choose Exit from the File menu.

2.2 Setting Cisco TransportPlanner Options
Cisco TransportPlanner provides numerous options for customizing the tool and the design.

Note The following procedures for setting options using the Tools menu apply to new projects during project 
creation. To change an existing (open) project, click the desired item in the Project Explorer pane 
Subnets folder and edit the parameter in the Properties pane.

2.2.1 Setting the Graphical Display
Use the following procedure to set the Cisco TransportPlanner graphical display:

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-6), right-click the Graphic folder and choose Expand from 
the shortcut menu.
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Figure 2-6 Options Explorer Dialog Box 

Step 3 To change the color scheme for Cisco TransportPlanner, click Look & Feel and choose the desired 
scheme from the drop-down list. 

Step 4 To change the appearance of the Project Explorer tree, click Project Explorer and complete the 
following as needed:

• Overlapping—Check to reorder sites for a selected network.

• Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or 
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children. 

• Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the 
bottom right of each locked item in the Project Explorer. 

• Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top 
right of each alarmed item in the Project Explorer. The alarm icon will be green, yellow, orange, or 
red to indicate the alarm severity.

Step 5 To change the NtView Name tab appearance, click Network View and complete the following as needed:

• In the Site area, complete the following:

– Color, Selection Color, and Highlight Color—To change the site colors, click in the Color, 
Selection Color, and/or Highlight Color fields in the Site list. Click on the drop-down arrow to 
display a color swatch popup window. Click the desired color.

– Show Name—Check to display the site name on the NtView Name tab.

– Show Amplifiers—Check to display the amplifier icon for a site on the NtView Name tab.

• In the Fiber area, complete the following, as needed. Figure 2-7 shows an example of a duct with all 
of the following details shown.
2-19
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Setting Cisco TransportPlanner Options
– Color and Selection Color—To change the fiber color, click in the Color and/or Selection Color 
fields in the Fibre list and then click the drop-down arrow. 

– Show Spans—Check to display fiber spans on the NtView Name tab.

– Show Length—Check to display fiber length on the NtView Name tab.

– Show total SOL Loss—Check to display start of life (SOL) loss on the NtView Name tab.

– Show total EOL Loss—Check to display end of life (EOL) loss on the NtView Name tab.

– Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtView Name 
tab.

– Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtView Name 
tab.

• To change the color of the traffic demands on the NtView Name tab, in the Point To Point, P-Ring, 
and Any To Any areas click in the Color and Selection Color fields, and then click on the drop-down 
arrow to display a color swatch popup window. Click the desired color.

Figure 2-7 Duct Details Shown on the NtView Name Tab

Step 6 To change the Network Mgmt Tree tab appearance, complete the following as needed:

• In the Network area, click in the Color and Selection fields. Click the drop-down arrow to display a 
color swatch popup window. Click the desired color.

• In the Link area, complete the following:

– To change the link color, click the Color field in the Link list and then click the drop-down 
arrow. Choose the desired line width from the drop-down list.

– To change the link appearance, click the Stroke field in the Link list and then click the 
drop-down arrow. Choose the desired line appearance from the drop-down list.

Step 7 Click Ok.

2.2.2 Setting the Default Platform Values
Use the following procedure to establish the default traffic mapping, dense wavelength division 
multiplexing (DWDM) design, and default layout settings for a particular platform and system release. 
The default settings will appear during project creation. All the options that you specify can be changed 
after project creation on a per span basis.

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-6), right-click Platform and choose Expand from the 
shortcut menu.

Step 3 Click the desired System Release folder and complete the following as needed:
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Note Default changes apply only to the specified system release.

• For software R8.5, choose the desired settings in the General area:

– Shelf Management—The options available are Multi Shelf Integrated Switch, Multi Shelf 
External Switch, and Individual Shelf. These options allow you to specify the type of 
management to be used for the sites on the network. 
Select Multi Shelf Integrated Switch to configure all the Multi Service Transport Platform 
(MSTP) optical units (OADMs and amplifiers) in different shelves connected together through 
a LAN. The LAN is implemented with switches plugged into the MSTP shelves. 
Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and 
amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches external to the MSTP shelves. 
Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the 
same shelf.

– Node Protection—The options available are Same Shelf and Separated Shelves. 
Select Same Shelf to configure the optical units (amplifiers and OADM) facing the east side 
(CW direction) and west side (CCW direction) in the same shelf. 
Select Separated Shelves to configure the optical units (Amplifiers and OADM) facing the east 
side (CW direction) in one shelf and those facing the west side (CCW direction) in a second 
shelf. 

– C-band Rules—Select the options from the drop-down. The options appear in the following 
format: C 64Chs 50Ghz(+2dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and 
8; the reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 
dBm, 5 dBm, 7 dBm and 8 dBm; and the spacing options available are 100GHz or 50GHz.

– L-band Rules— Select the options from the drop-down. The options appear in the following format: 
32 Ch. 100Ghz +5dBm. The options available are: None, Expand, and channels available are 32; 
the reference per channel power options available are 2 dBm and 5 dBm; and the only spacing 
options available is 100GHz. 
Select Expand to indicate that the L-band rules as upgradable.

– Installation w/o M/P—Check this box to install network with default parameters. If this option 
is selected, Cisco TransportPlanner will design the network according to set of predefined 
conditions, so that the selected node can be installed without the Cisco TransportPlanner 
configuration files (thresholds and setpoints). 

– Dithering Lower limit—This value cannot be lower than 0 and the Dithering Upper Limit 
cannot be higher than 32.

• For Software R7.0, choose the following in the General area:

– C-Band or L-Band as the default band.

– Scalable C/L—(System Release 7.0 only) Check to set scalable C bands and L bands as the 
default setting during project creation. If checked, the design will be scalable to support both 
C-band and L-band on the same system.

– Scalable C/50GHz—(System Release 7.0 only) Check to set scalable C-band 50 GHz as the 
default setting during project creation. If checked, the design will be scalable to support 50-Ghz 
channel spacing in C-band.

– Shelf Management—The options available are Multi Shelf Integrated Switch, Multi Shelf 
External Switch, and Individual Shelf. These options allow you to specify the management to 
be used for the sites of the network. 
Select Multi Shelf Integrated Switch to configure all the MSTP optical units (OADMs and 
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amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches plugged into the MSTP shelves. 
Select Multi Shelf External Switch to configure all the MSTP optical units (OADMs and 
amplifiers) in different shelves connected together through a LAN. The LAN is implemented 
with switches external to the MSTP shelves. 
Select Individual Shelf to configure all the MSTP optical units (OADMs and amplifiers) in the 
same shelf.

– Node Protection—The options available are Same Shelf and Separated Shelves. 
Select Same Shelf to configure the optical units (Amplifiers and OADM) facing the east side 
(CW direction) and west side (CCW direction) in the same shelf. 
Select Separated Shelves to configure the optical units (Amplifiers and OADM) facing the East 
side (CW direction) in one shelf and those facing the west side (CCW direction) in a second 
shelf.

Step 4 Click the Restricted List folder. To restrict a card, check the check box in the Restricted column for that 
card. 

To change the setting back to unrestricted, uncheck the check box.To apply restricted list changes to an 
open project, complete the following:

a. Right-click the folder for the network that you want to update and choose Expand from the shortcut 
menu.

b. Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project 
Explorer and choose Edit List from the shortcut menu. The Restricted Equipment list for MSTP 454 
DWDM[Release Number] dialog box appears.

c. Click Update.

d. Click Ok to close the dialog box.

Step 5 Enter the Fiber Options details. 

• Span Label Tag—Enter the desired span label; the default label is Duct.

• Span Length—Enter the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• EOL Ageing loss [dB]—Enter the EOL aging loss value. The EOL loss-per-span value is added at 
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

• EOL Ageing Factor—Enter the number to use when factoring fiber aging. This factor is multiplied 
by the SOL total span loss without connectors. 

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a 
value in both fields.

• Connector loss [dB]—Enter the concentrated loss at the end of the span.

• Length Based Loss—If checked, the fiber loss is determined by multiplying the Span Length by the 
Loss Factor. If the check box is not checked, you must enter the total loss of the span.

• Tot SOL loss w/o conn [dB]—Enter the start of life link fiber loss for each span, without the 
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor 
multiplied by the length. In the Length Based model, this value is calculated automatically.

• DCN Extension (With Software R8.5 Only)—Click the check box to enable the default use of data 
connection network (DCN) extension on each span in the project. This implies that the OSC channel 
is not used to connect the two nodes. This default can be overridden on the network wizard pane. 
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Note Use one of the following formulas to calculate the fiber loss at SOL: 
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL: 
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss, or 
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

• Select the Fiber Type of each span of the network. You can specify a fiber type even if the fiber type 
is not supported for the design.

Step 6 Click the Traffic Mapping folder and complete the following as needed.

• In the Fixed traffic area, choose the unprotected routing strategy from the drop-down list: 

– Auto

– Unprotected optimum optical path—Each node pair is connected using one connection. The 
unprotected optimum optical path minimizes the number of required optical amplifiers.

– Unprotected minimum hop count—Each node pair in the traffic group is connected by one 
connection. The unprotected minimum hop count minimizes the number of channels (for 
unprotected traffic types only) that can be deployed among the nodes of the traffic group.

Step 7 Select the C-band and L-band rules.

• C-band Rules—Select the options from the drop-down. The options appear in the following format: 
C 64Chs 50Ghz(+2dBm/Ch). The channels available are 80, 72, 64, 40, 32, 20, 16, and 8; the 
reference per channel power options available are -1 dBm, -2 dBm, 1 dBm, 2 dBm, 4 dBm, 5 dBm, 
7 dBm and 8 dBm; and the spacing options available are: 100GHz or 50GHz.

• For L-band Rules— Select the options from the drop-down. The options appear in the following format: 
32 Ch. 100Ghz +5dBm. The options available are: None, Expand, and channels available are 32; the 
reference per channel power available are 2 dBm and 5 dBm; and the spacing options available is 
100GHz. 
Select Expand to indicate the L-band rules as upgradable.

Step 8 Click the DWDM Design Rules folder and complete the following as needed:

• No Tilt Design—Check to force Cisco TransportPlanner to operate the amplifiers inside the gain 
range where no tilt is generated and to determine the type and number of amplifiers in each site of 
the network accordingly. This option sets all the intermediary points of the network so that channels 
are always at the reference power level. Default value is Disabled.

Note Long spans (with insertion loss greater than 25 dB) might not be supportable.

• No In-line Bulk Attenuator Design—Check to design the network without using any inline bulk 
attenuators. In case the network cannot be designed without using external in-line attenuators, 
Cisco TransportPlanner displays the following error message: “Unfeasible Network design. Site X 
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attentuators.”

• No TXT/Line-Card Bulk Attenuator Design—Check to design the network without using any 
external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients require Rx 
bulk attenuators, then the related channel is shown with the working condition (flagged red, orange, 
or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical Channel 
Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.
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• Prevent Use of E-LEAF Dispersion—Check to prevent Cisco TransportPlanner from using E-LEAF 
dispersion compensation units (DCUs) on E-LEAF spans for the overall network. Leave unchecked 
if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

• OSNR Alarm For Regeneration—This option allows you to define the optical signal-to-noise ratio 
(OSNR) alarm severity. When this limit is reached, Cisco TransportPlanner suggests channel at an 
appropriate site on the network. After the network is designed and analyzed, in the Tasks pane 
(under Reports), click Optical Results to see if any site requires regeneration. The regeneration 
column will suggest the site where Regeneration is required. 

• Turbo Simplex—Check to achieve faster results by optimizing a subset of the total channels based 
on type and path rather than optimizing each and every channel. Deselecting can result in longer 
analysis times for large networks, especially with Any-to-Any ROADM traffic. 

• Max Sc Value—This option allows you to enter the maximum slope compensation value. 

Step 9 To define the shelf configuration parameters, click the Layout folder and complete the following:

• Osmine Compliant—Check to instruct Cisco TransportPlanner to ensure that all the sites placing 
Transponder and Line Cards are compliant with OSMINE. 

• Hybrid Node—Check to instruct Cisco TransportPlanner to ensure that cross-connect, SDH, and 
SONET cards not placed within the optical transport section (OTS) shelf. 

• Max Number of Shelves—This option allows you to specify the maximum number of shelves per 
rack. Default is Auto and the maximum number of shelves you can specify is 4. 

• AIC—Select Yes to instruct Cisco TransportPlanner to put the AIC card in Slot 9 of the first shelf 
in each site.

• FiberStorage—Select Yes to instruct Cisco TransportPlanner to put the fiber storage within the rack 
below the optical shelf.

• Y-Cable—The options available are Auto, 1RU FlexLayer Shelf Assembly, and 2RU Y-Cable Panel.

– Auto—Instructs Cisco TransportPlanner to set the default value for the Y-Cable option.

– 1RU FlexLayer Shelf Assembly—Instructs Cisco TransportPlanner to use the ONS 15216 
Splitter/Combiner Flex Layer modules to implement the required Y-cable protections.

– 2RU Y-Cable Panel—Instructs Cisco TransportPlanner to use the new ADC Splitter/Combiner 
modules to implement the required Y-cable protections. 

• FanTry—(Software R8.5 only) Instructs Cisco TransportPlanner to put the type of fan tray within 
each node. Options available are: FTA-3-T or FTA 4-T.

• DCC Shelves Management—Check to instruct Cisco TransportPlanner to reserve Slot 12 for 
equipping 15454-MR-L1 unit to implement data communication channel (DCC) Shelves 
Management.

Step 10 Click OK.

2.2.3 Setting the Default Project Values
Use the following procedure to set the default project settings and repair time. These defaults will appear 
during project creation.

Step 1 From the Tools menu, choose Options. 
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Step 2 In the Options Explorer dialog box (Figure 2-6 on page 2-19), click Project and complete the following 
to set the defaults that appear in the Project Creation wizard:

• Customer—Enter the default customer name (128 character maximum).

• Created by—Enter the default user name (128 character maximum).

• Units—Choose the desired default span length unit of measure from the drop-down list, either Km 
or Miles.

• Price List—Choose the desired default price list.

• Layout—Choose either ANSI (American National Standards Institute) or ETSI (European 
Telecommunications Standards Institute) from the drop-down list. 

Step 3 Click General and complete the following:

• MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply 
to every site in the network. If you change the MTTR value after creating sites, the new value will 
only apply to sites you create after the change.

• Restocking Time (days)—Enter the number of days required (including transportation time) to 
restock the units into the maintenance center.

• Confidence Level (%)—Choose the confidence level for finding the spare units in the maintenance 
center (50, 75, 95, or 99 percent).

Step 4 Click Ok.

2.2.4 Defining Third-Party DWDM Interfaces
Cisco TransportPlanner allows you to define a third-party DWDM interface to be used in project 
creation. After you define third-party DWDM interfaces, you can choose them when creating traffic 
demands. For more information on defining third-party interfaces, see Appendix D, “Third-Party 
DWDM Wavelength Interface Model”. 

Note If you create a network design with a third-party interface and need to share the design with other users, 
you must provide not only the saved network MPZ file but also the exported database file containing the 
third-party interface definition. To view this project, the other user first must import the database with 
the third-party interface values. 

Use the following procedure to define a third-party DWDM interface:

Step 1 Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.

Note You cannot open the DB Parts Manager if a project is open or if you are using the Base Network 
Designer profile.

Step 2 Right-click Platform Parts and choose Expand from the shortcut menu. 

Step 3 Right-click Group and choose New Group from the shortcut menu. The new group appears under Group 
and in each system release under parts DB. 

Step 4 In the Group Editor dialog box, complete the following:
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• Name of group—Enter the name of the new database.

• Note—(Optional) Enter a description of the group.

Step 5 In the parts DB for the desired system release, click the group that you created.

Step 6 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from 
the shortcut menu. A new row appears on the Parts tab for the client hardware. 

Step 7 Double-click the row to open the Alien dialog box (Figure 2-8). 

Figure 2-8 Alien Card Dialog Box
 

Step 8 In the General tab of the Alien dialog box, type the name of the card in the Name field and the enter the 
Label name. 

Step 9 Click the Istance tab and complete the following:

• Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible 
for this third-party interface with ANSI PID completed, the third-party interface is included in the 
BoM with the related product identifier.

• Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for 
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM 
with the related product identifier.

• TAG—(Display only) For internal use.

• SYS. NAME ANSI—Not applicable for third-party interfaces.

• SYS. NAME ETSI—Not applicable for third-party interfaces.

• WL START—Choose the wavelength starting range that the third-party interface supports from the 
drop-down list.

• WL END—Choose the wavelength ending range that the third-party interface supports from the 
drop-down list.
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Step 10 Click the Physical Ports tab and in the Label column, type a label for each port. 

The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.

Step 11 Click Ok.

Step 12 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien 
from the shortcut menu. A new row appears on the Parts tab for the client software. 

Step 13 Double-click the row to open the AlienSoft dialog box.

Step 14 In the General tab, complete the following:

• Name—Type the name in the Name field.

• Related Item—Choose the client card that you created in Step 7 to Step 11.

Step 15 Click the Default - OCh tab (Figure 2-9).

Figure 2-9 AlienSoft Dialog Box, Default-OCh Tab

Step 16 Complete the following (see Tables 2-1 through 2-3 for supported value combinations):

• In the Rules area, choose the C- or L-band design rule from the Design Rule drop-down list.

• In the Technology area, complete the following: 

– Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary. 

– Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser), or 
EML (Electro-absorption Modulated Laser).

– Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).

– Regeneration Type—Choose 3R or 2R regeneration mode.
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– FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).

– Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are 
12.5, 25, 50, or 100 pm.

• Bit Rate—Choose the desired bit rate from the drop-down list.

• In the TX Power Range area, complete the following:

– TX Max Power—Enter the maximum power output level (dBm).

– TX Min Power—Enter the minimum power output level (dBm).

• In the Back to Back Receiver Sensitivity area, complete the following as needed to define the 
working interface area for Back to Back. Back to Back is a configuration where the receiver is placed 
in front of the transmitter and no other equipment exists between the two. Back to Back is used to 
measure characteristics of the TX and RX pair. Figure 2-10 shows the interface operative area.

– Overload Power [ps/nm]—Enter the overload power level.

– OL_Power [dBm]—Enter the minimum power level in the OSNR-limited range.

– OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range 
(measured in 0.5 increments).

– PL_Power [dBm]—Enter the minimum power level in the power-limited range.

– PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNR-limited range 
(measured on 0.5 nm bandwidth).

• In the Chromatic Dispersion area, complete the following as needed:

– Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic 
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

– CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum 
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0dB, 1dB, 1.5dB, 2dB, 
or 3dB.

• Customize Penalties—Check to enable the Gaussian cross-talk Penalties, Single-Interfering 
Cross-Talk Penalties, and Scale Q factors fields as needed.

• If Customize Penalties is checked, enter the values to determine the Gaussian cross-talk Penalties in 
the A_GXt and B_GXt fields, as needed. Gaussian cross talk refers to random power that interferes 
with a signal. The A_GXt and B_GXt values are the coefficients for the exponential curves that 
estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and OSNR-penalty (OL) for 
Gaussion cross-talk levels in the OL and PL regions of the interface model with dispersion margins 
added (see Figure 2-10). The formula is Penalty (GXt) = A_GXt * exp(B_GXt *GXt). 

• If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk 
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to 
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the 
exponential curves that estimate P-penalty (PL), P-penalty (OL), OSNR-penalty (PL), and 
OSNR-penalty (OL) for single-interfering cross-talk in the OL and PL regions of the interface model 
with dispersion margins added (see Figure 2-10). The formula is Penalty (IXt) = A_SIXt* 
exp(B_SIXt* IXt).

• If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and 
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the 
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER 
increase could be recovered with an increase of OSNR, power, or both (depending in which 
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR 
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and one in power) for each working point OL and PL of the interface model (see Figure 2-10). The 
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER 
increase) into power and OSNR penalties. The formulas follow:

– P-penalty(PL) = Q-penalty * F-P(PL)

– P-penalty(OL) = Q-penalty * F-P(OL)

– OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)

– OSNR-penalty(OL) = Q-penalty * F-OSNR(OL) 

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL) 
are evaluated in the OL working region of the curve with the dispersion margins added. 

Figure 2-10 Interface Operative Area

Step 17 Click Ok. 

Table 2-1 lists the supported combinations for 40-Gbps third party interfaces.

Table 2-2 lists the supported combinations for 10-Gbps third party interfaces.
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Table 2-1 Supported Combination for 40-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR-
penalty (OL)

P-penalty 
(PL)

OSNR-
penalty (PL)

Duo Binary MZ Optimal E-FEC ± 12 0 1 0 1
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Table 2-3 lists the supported combinations for 2.5-Gbps third party interfaces.

2.2.5 Exporting a File
Use the following procedure to export user options, price lists, maintenance contracts, and the parts 
database files. The export command creates a ZIP file that includes all of the created files.

Step 1 From the Tools menu, choose Export. The Export dialog box appears (Figure 2-11).

Table 2-2 Supported Combinations for 10-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty
(OL)

OSNR-
penalty (OL) P-penalty(PL)

OSNR-
penalty (PL)

NRZ MZ Optimal E-FEC ± 25 0 2 1 0

NRZ MZ Optimal FEC ± 25 0 1.5 1 0

NRZ MZ Average no FEC ± 25 2 0 2 0

NRZ EML Average no FEC ± 100 0 3 3 0

Table 2-3 Supported Combinations for 2.5-Gbps Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR-
penalty (OL)

P-penalty 
(PL)

OSNR-
penalty (PL)

NRZ DML Average FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 3 0 3 0

NRZ DML Average no FEC ± 25 3 3 3 3

NRZ EML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 100 0 3 3 0
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Figure 2-11 Export Dialog Box

Step 2 In the Export dialog box, enter a file path and name in the file name field. To export to an existing file, 
click the ... button and navigate to the desired directory and file. Click Select to choose the file. 

Step 3 To select the items to export, complete the following as needed:

• User Option—Check to export the user options set using the Tools > Options command. 

• PartsDB—Check the desired platforms. 

• PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the 
individual price lists that you want to export.

Step 4 Click Ok. 

2.2.6 Importing a File
Use the following procedure to import user options, price lists, maintenance contracts, and the parts 
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

Step 1 From the Tools menu, choose Import. The Import dialog box appears (Figure 2-12).
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Figure 2-12 Import Dialog Box

Step 2 In the Import dialog box, click the ... button and navigate to the desired directory and file. Click Select 
to choose the file to import.

Step 3 Click load. 

Step 4 If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple 
exported options, complete the following as needed:

• User Option—Leave checked to import a file with the user options that were set with the Tools > 
Options command.

• PartsDB—Leave checked to import the parts database for the desired platform. 

• PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired 
individual price lists.

Step 5 Click OK. 

Step 6 In the confirmation dialog box, click OK. 

2.2.7 Resetting the Default Layout
Your graphical layout settings are saved when you exit Cisco TransportPlanner. The next time that you 
launch Cisco TransportPlanner, the layout appears as it did upon exiting. The default graphical layout 
includes items such as whether the panes are visible and/or docked.

To return to the Cisco TransportPlanner default layout, choose Default Layout from the View menu. To 
restore the user modified layout, choose My Default View from the View menu. 
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2.2.8 Adding Plug-ins
Use the following procedure to add plug-ins to Cisco TransportPlanner. Plug-ins are released separately 
from Cisco TransportPlanner by Cisco Systems. Using plug-ins, you can customize the released version 
of Cisco TransportPlanner. 

Step 1 Copy the plug-in file into the Documents and Settings\username\Desktop\CTP_8.5.0\plugins folder.

Step 2 From the File menu, choose Exit, then click Yes or No to save the existing project. 

Step 3 Launch Cisco TransportPlanner. For more information, see the “2.1 Launching 
Cisco TransportPlanner” section on page 2-14.

Step 4 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-13).

Figure 2-13 PlugIn Registry Dialog Box

Step 5 In the PlugIn Tree, right-click the new plug-in folder and choose Expand from the shortcut menu.

Step 6 Two categories of plug-in are defined in the tool:

• Plug-in that cannot be deactivated-These plug-ins have the parameter “Can be deactivated = 
FALSE”. They are loaded at Cisco TransportPlanner startup and no action is available.

• Plug-in that can be deactivated - These plug-ins have the parameter “Can be deactivated = TRUE.” 
These plug-ins support two additional parameters:

– Can be suspended—When set to TRUE, an additional action on the plug-in allows you suspend 
or resume the plug-in within the current Cisco TransportPlanner running session.

– Can be stopped—When set to TRUE, the user decides if the plug-in will or will not run the next 
time Cisco TransportPlanner is started.

Step 7 Click the plug-in and set the desired action—Deactive, suspended, or stopped. 
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Step 8 Close Cisco TransportPlanner and restart. The plug-in action set in the procedure to takes affect.

2.2.9 Managing Plug-ins
Use the following procedure to view and manage plug-ins. For information about adding plug-ins, see 
“2.2.8 Adding Plug-ins” section on page 2-33.

Step 1 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-13 
on page 2-33). 

Step 2 In the PlugIn Tree, right-click the plug-in folder and choose Expand from the shortcut menu. 

Step 3 Click a plug-in to view information about it. The right pane of the PlugIn Registry dialog box displays 
the plug-in information.

• The General area of the PlugIn Registry dialog box identifies the following information:

– Name—(Display only) Displays the name of the plug-in.

– Path—(Display only) Displays the location of the plug-in.

– Version—(Display only) Displays the version of the plug-in.

– Provider—Displays the name of the supplier of the plug-in.

– Text—(Display only) Displays a brief description of the plug-in.

– Exclusion—(Display only) Displays the exclusion label. The exclusion attribute is a tag that 
defines an exclusion rule for a plugin. No more that one plugin with a given exclusion tag can 
be run at the same time.

• The State area of the PlugIn Registry dialog box identifies the plug-in current state and restrictions:

– Current State—(Display only) Identifies the state of the plug-in.

– Can be stopped—(Display only) If TRUE, you can disable the plug-in during the current session 
of Cisco TransportPlanner. The plug-in will disappear from the File menu. To restart a plug-in 
that has been stopped, you must exit and relaunch Cisco TransportPlanner. If FALSE, you 
cannot stop the plug-in during an active Cisco TransportPlanner session. 

– Can be suspend—(Display only) If TRUE, you can disable the plug-in during the current session 
of Cisco TransportPlanner. The plug-in will disappear from the File menu. To restart a plug-in 
that has been suspended, you can choose Resume in the PlugIn Registry dialog box. It is not 
necessary to exit and relaunch Cisco TransportPlanner. If FALSE, you cannot suspend and 
resume this plug-in during an active Cisco TransportPlanner session.

• The Run Information area of the PlugIn Registry dialog box displays the Can be deactivated state. 
If TRUE, you can deactivate a plug-in but must exit and relaunch Cisco TransportPlanner for the 
deactivation to take effect. When you relaunch Cisco TransportPlanner, the plug-in will not appear 
in the File menu. If FALSE, you cannot deactivate this plug-in. 

Step 4 To disable or suspend a plug-in, right-click the plug-in and choose one of the following from the shortcut 
menu:

• Do not run at start—Choose to disable the plug-in the next time Cisco TransportPlanner is launched. 

• Suspend/Resume—Choose Suspend if you want to disable the plug-in immediately without 
restarting Cisco TransportPlanner. Choose Resume to enable a suspended plug-in.

Step 5 Click Ok.
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Step 6 In the confirmation dialog box, click Ok. 

Step 7 If you chose Do not run at start, exit and relaunch Cisco TransportPlanner for the plug-in to be disabled.

2.2.10 Adding User Profiles
A user profile is a set of privileges used for running Cisco TransportPlanner. Each profile offers different 
capabilities. Cisco TransportPlanner is packaged with the Network Designer profile, but you can add 
other user profile types provided by Cisco. All the procedures in the Cisco TransportPlanner DWDM 
Operations Guide are written for users with Network Designer access.

Use the following procedure to add a user profile to Cisco TransportPlanner:

Step 1 Close all open instances of Cisco TransportPlanner.

Step 2 Identify the directory where Cisco TransportPlanner is installed on your computer, see the 
“2.1 Launching Cisco TransportPlanner” section on page 2-14. 

Step 3 Create a profile folder; if profile folder already exists, go to Step 4. 

Step 4 Copy the profile JAR file provided by Cisco Systems into the profile folder. 

Step 5 Launch Cisco TransportPlanner. For more information, see the “2.1 Launching 
Cisco TransportPlanner” section on page 2-14. The new profile will appear in the Current Selected 
Profile drop-down list.

2.2.11 Running a Script
Use the following procedure to run a script. A script is a sequence of commands in a BSH file format 
that is used to provide additional Cisco TransportPlanner capabilities. Cisco provides valid scripts to 
help you customize your Cisco TransportPlanner software. 

Note You must have received a valid script from Cisco Systems before you can perform this procedure.

Step 1 From the Script menu, choose Run Script.

Step 2 In the Choose the script to run dialog box, click the desired script and click Open. The script runs.

Step 3 To run a script again, choose Run Again > script-name.

2.2.12 Refreshing the Script Menu
Common scripts, located in the Cisco TransportPlanner scripts directory, displayed in the Script > 
Common menu and can be run by any user. User scripts, located in the C:/Documents and 
Settings/user-home/CTP_version/scripts, are displayed in the Script> User menu. 
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Any time you add or remove a script from one of these directories, you must choose Refresh Dirs so 
that the changes appear on the Script menu. The Remove Dirs command removes script names from the 
Script > Run Again menu and updates the Script > Common and User menus. 

2.2.13 Understanding Sides Labeling
In Cisco TransportPlanner Software R8.5, the label for each supported site structure is different from the 
labels that have been used in the previous releases. Table 2-4 summarizes the labeling format of the sites 
in the previous releases and in Cisco Transport Planner Software R8.5.

2.3 Creating a Project
A project consists of a single network or multiple networks that you analyze and compare. In a project, 
you can have multiple copies of a single network with the same customer input data, but use different 
options in each to investigate multiple solutions. 

Use the following procedure to create a single network in a project. A new network is in the Design state. 
For more information about the different network states, see the “2.7 Managing the Network Design” 
section on page 2-126.

Note All options set by the Project Creation Wizard can be changed as needed, except Measurement Units and 
ANSI/ETSI, which can be changed.

Step 1 From the File menu, choose New. The Project Creation Wizard appears (Figure 2-14).

Table 2-4 Sides Labeling in Cisco Transport Planner Software R8.5 and in previous releases

Sites Labeling in Previous Releases
Labeling in Cisco Transport 
Planner Software R8.5

Terminal/Terminal+ Only one side is created and labeled, 
T.

Only A can be used for the 
existing side.

Line/Line+ Two sides are created and are 
labeled, West and East.

Only A and B can be used for the 
existing sides.

Multi-Degree with 
PP-MESH-4

— Only A, B, C, and D can be used 
for the existing sides.

Multi-Degree with 
PP-MESH-8

— Only label A, B, C, D, E, F, G, 
and H can be used for the 
existing sides.
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Figure 2-14 Project Creation Wizard 

Step 2 On the Project page, complete the following:

• Created By—Displays the user login name. You can edit this field (128 character maximum).

• Customer Name—Type the name of the customer (128 character maximum) requiring this network 
design. 

• Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international 
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you 
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI) 
service demands. 

• Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit 
of measure used for span length.

• Price List—Choose the price list from the drop-down list. 

Step 3 Click Next.

Step 4 On the Platform page, check the desired platform and click Next.

Step 5 On the Release page, check the desired software release for the network design and click Next. The 
default is the latest release. This attribute defines the list of hardware parts that can be used in the design 
because they are supported in this release.

Step 6 On the Subnet page, complete the following (Figure 2-15):

• Traffic Mapping Algorithm Release 8.5—Check to select the ONS 15454 Software R8.5 version of 
the interface and the wavelength routing optimization algorithm to be used in the network design. 
Software R8.5 is backward compatible and can manage Software Releases 4.7, 5.0, 7.0, and 8.5.

• Design Design Rules Release 8.5—Check to select DWDM Design Rules Release 8.5.
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• Layout Release 8.5—Check to define the ONS 15454 Software R8.5 version of the algorithm used 
to generate the layout of each site within the subnetwork. Software R8.5 is backward compatible and 
can manage Software Releases 4.7, 5.0, 7.0, and 8.5.

Figure 2-15 Project Creation Wizard Subnet Page

Step 7 Click Next.

Step 8 Complete one of the following:

• To run the Network Creation wizard, check the Run the Network Wizard Now check box and click 
Finish. Continue with Step 9.

• To create an empty project to add sites and fibers manually, uncheck the Run the Network Wizard 
Now check box and click Finish. Project Creation wizard creates the project and an empty network 
and subnetwork under which you can manually add sites and fibers. Skip the remaining steps in this 
procedure. To add sites manually, see the “2.3.1 Adding Sites” section on page 2-45.

Step 9 In the Topology page of the Network Creation wizard (Figure 2-16), choose Ring or Linear from the 
Network-Topology drop-down list.

Step 10 To instruct Cisco TransportPlanner to automatically create a traffic subnet associated with the created 
network, check the Create Traffic Subnet check box. Cisco TransportPlanner creates (in addition to the 
Traffic_ALL), an additional traffic subnet (Traffic_Ring or Traffic_Linear), depending on the topology value 
you specify in the Network Creation wizard. 
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Figure 2-16 Network Creation Wizard Topology Page 

Step 11 Click Next. On the Configuration page, enter the number of sites in the Site Number field and click 
Next. The maximum number of sites per network design is 100 sites and the default is 3. The maximum 
number of locations where the optical service channel (OSC) can be terminated in a network is 40. The 
maximum number of Add/Drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or 
OADM cards traversed by an optical circuit is limited to 40.

Step 12 On the Sites Data page, select the topology for each site in the network Figure 2-17. Allowed values are:

Note The values allowed depend on the network topology selected in Step 9. The default site value for Ring 
Topology is Line. The default site value for Linear topology is Line, except for the two end sites which will 
be Terminal. Terminal and Terminal+ are not allowed for ring network topology or for linear network 
topology intermediate sites.

• Terminal—Site with one side facing one fiber span.

• Terminal +—Site with one side facing one fiber span that can provide multi-degree expansion 
capability through an MMU unit. 

• Line—Site with two sides facing two fiber span.

• Multi-degree—Nodes have more than two sides and face more than two fibre spans.

• Line + —Site with two sides facing two fiber spans that can provide multi-degree expansion 
capability through an MMU unit. 
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Figure 2-17 Network Creation Wizard- Site Data Page

Step 13 The Options page allows you to define C band and L band rules for the network design Figure 2-18.

• C-band rules—The C-band options appear in the following format: 80Ch. 50Ghz +1dBm. The 
channels available are 80, 72, 64, 40, 32, 20, 16, or 8; the reference per channel power options 
available are -1 dBm, +1 dBm, 2 dBm, -2dBm, +4dBm, 5 dBm, 7dBm and 8 dBm; and the spacing 
options available are 100GHz or 50GHz.

• L-band Rules— The L-band options appear in the following format: 32 Ch. 100Ghz +5dBm. The 
options available are: None, Expand, and channels available are 32; the reference per channel power 
available are 2 dBm and 5 dBm; and, the spacing options available is 100GHz.

Note If you use a Line+ or Multi-Degree site, you must select design rules based on 100 GHz channel spacing, 
and in the case of Line+, you must also select 32-channel rules. If these conditions are not met, 
Cisco TransportPlanner will provide an error message when you attempt to analyze the network. See 
Table 2-24 for additional details on site design rules.
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Figure 2-18 Network Creation Wizard Options Page

Step 14 On the Site page, complete the following (Figure 2-19):

• Shelf Management—Choose the shelf management configuration:

– Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards 
(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected 
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this 
option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf 
configuration.

– Multi Shelf External Switch—All the MSTP optical cards (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches external to the 
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units are 
used to support the multishelf configuration.

– Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf. 
For this option, multishelf management is not supported; every shelf is managed as an 
independent shelf.

• Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves 
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a 
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves 
places OADM/ROADM units (west-facing and east-facing) in separate shelves in the node and it is 
selectable only if Multishelf management is selected. You can also set node protection for a 
multi-degree node. 

• Hybrid Site Config—Check to create all the nodes configured as hybrid MSTP/Multi Service 
Provisioning Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf 
as the Shelf Management type.
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• OSMINE Compliant—Check this option to place the DWDM units in the shelves according to 
Operations Systems Modifications of Intelligent Network Elements (OSMINE) placement rules.

• DCC Chain—Check to put a TXP(P)_MR_2.5G card in Slot 12 on each shelf of each site to use 
DCC. 

• Max Shelves per Rack—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves 
(equipping optical cards or TXP/MXP cards) that can be placed in each rack in the site when 
generating the layout of the site. 

• Installation w/o M/P—Check this box to design a network that does not require the setup of 
configuration files (thresholds and setpoints). Installation without Cisco TransportPlanner is also 
known automatic node turn up. When this feature is enabled, the software in the node will configure 
itself with parameters; XML configuration files are not required to configure the node. When this 
option is selected at the end of EDFA and DCU placement, Cisco TransportPlanner will analyze the 
resulting network and verify that in each node, where the option “installation w/o Cisco 
TransportPlanner” is enabled, has:

– A preamplifier in each direction.

– All amplifiers working in gain control mode

– A flat node output spectrum; that is, the resulting channel tilt at the exit of the node is 0

– A feasible setpoint forced during simulation.

Figure 2-19 Network Creation Wizard Sites Page

Step 15 Click Next.
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Step 16 On the Span page, complete the following (Figure 2-20):

• Span Label Tag—Enter the desired span label.

• Span Fibre Type—Choose the fiber type for each span in the network.

• Span Length—Enter the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied 
by the SOL total span loss without connectors. 

• EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at 
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a 
value in both fields. Use one of the following formulas to calculate the fiber loss at SOL: 
SOL = km * dB/km + (2 * connector loss)
SOL = user entered loss + (2 * connector loss)
Use one of the following formulas to calculate the fiber loss at EOL:
EOL = km * dB/km * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss
EOL = user entered loss * EOL Aging Factor + (2 * connector loss) + EOL Aging Loss

• Connector loss [dB]—Type the concentrated loss at the end of the span.

• CD factor [ps/mn/km]—Type the fiber chromatic dispersion (CD) factor. The default value is 
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic 
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm; L-band 
is defined at 1590.4 nm.

• PMD factor [ps/sqrt(km)]—Type the polarization mode dispersion (PMD) factor. The default value 
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. PMD is always entered per kilometers. 

• Length Based Loss—If checked, the fiber loss is determined by Span Length * Loss Factor. If the 
check box is not checked, you must enter the total loss of the span.

• Loss factor [dB/km]—Type the value of the SOL fiber loss per kilometer that is used to calculate 
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

• Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the 
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor 
multiplied by the length. In the Length Based model, this value is calculated automatically.

• DCN extension—Click the check box to use DCN extensions on each of the spans in the network. 
This implies that the OSC channel is not used to connect the two nodes. All nodes facing a span with 
the DCN Extension option enabled require a ITU-T G.709 generic communications channel (GCC) 
access that must be provided by the customer.
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Figure 2-20 Network Creation Wizard Span Page 

Step 17 Click Finish. Cisco TransportPlanner checks the validity of the fiber factor values. If the fiber factor 
values are within the valid range (Table 2-5), Cisco TransportPlanner creates a visual representation of 
the network. If the values are out of range, Cisco TransportPlanner issues a warning, asking you to 
confirm the input values.

Note All options set by the Network Creation Wizard can be changed as needed per site and per span. 

Table 2-5 Valid Ranges for Fiber Factor Values

Fiber Type Parameter

Min. 
Error 
Value

Min. 
Warning 
Value

Default 
Value

Max. 
Warning 
Value

Max. 
Error 
Value Unit

ITU-T 
G.652-SMF

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm 
(C-band)

0 16.2 16.7 17.1 30 ps/nm/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 18.53 19.03 19.43 30 ps/nm/km

PMD factor 0 0.0 0.1 0.5 10
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2.3.1 Adding Sites 
Use the following procedure to add new sites to an existing network. A site is a customer premise 
location where any equipment can be co-located in a rack within a building. Cisco TransportPlanner 
supports up to 100 sites in a network. The number of racks and nodes in a site is independent of number 
of number of sites in the network. The maximum number of locations where the OSC can be terminated 
in a network is 40. When the number of locations where the OSC is terminated exceeds the maximum 
supported value, the tool completes the design, but in the summary report there will be an alarm to indicate 
this situation. The maximum number of add/drop locations in a network is 40. The maximum number of 
Add/Drop locations (equipped with WSS, WXC, multiplexer/demultiplexer, or OADM) traversed by an 
optical circuit is limited to 40.

Note Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with Same 
Shelf protection. To change this, you can edit the site properties after adding it to the network design. 
See the “2.6.3 Editing Site Parameters” section on page 2-92.

Step 1 Right-click the network folder in the Project Explorer and choose Expand from the shortcut menu.

Step 2 Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard 
appears (Figure 2-21). As an alternative, if sites already exist in the network design and you have the 
NtView Name tab open, click the Create a new site icon in the toolbar. For more information about the 
Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 3 Choose the interface type:

• Line—Two pairs of fibers are terminated at the node.

ITU-T 
G.655-E-LEAF

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.4 3.80 4.2 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.655-True 
Wave

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.8 4.19 4.6 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.652-DS 
(Dispersion 
shifted)

Loss factor 0 0.2 — 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 2.43 2.83 3.23 30 ps/nm/km

PMD factor 0 0 0.1 0.5 10

Table 2-5 Valid Ranges for Fiber Factor Values (continued)

Fiber Type Parameter

Min. 
Error 
Value

Min. 
Warning 
Value

Default 
Value

Max. 
Warning 
Value

Max. 
Error 
Value Unit
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• Terminal—A single pair of fibers is terminated at the node.

• Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An 
MMU card (topology upgrade) must be installed.

• Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased. An MMU card (topology upgrade) must be installed.

• Multi-degree—Nodes have more than two sides and face more than two fibre spans.

Step 4 Click Finish.

Figure 2-21 Site Creation Wizard

2.3.2 Adding Fiber Spans
Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair 
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the 
NetViewName tab. Within a fiber duct, more than one fiber pair can exist.

Note The number of fiber spans that each site can support is defined in the site properties. See the 
“2.3.1 Adding Sites” section on page 2-45 or the “2.6.3 Editing Site Parameters” section on page 2-92.

Step 1 In the NtView Name tab, click the Create a new duct icon in the toolbar. For more information about the 
Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”
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Step 2 Click one of the sites that you want to connect with a fiber span. This site will be the source site for later 
network analysis output. 

Step 3 Click the destination site. A fiber span appears between the two sites. This site will be the destination 
site for later network analysis output. 

For the first span, the source site is set as A and the destination site is set as B. Cisco TransportPlanner 
automatically adjusts East and West for additional spans.

2.3.3 Creating Traffic Subnet

Step 1 In the Project Explorer tab, scroll down to Traffic Subnets. Right-click Traffic Subnets, and select 
Create.

The Traffic Subnet Creation wizard appears. See Figure 2-22.

Figure 2-22 Traffic Subnet Creation Wizard

Step 2 Select the Topology for the subnet from the drop-down list (Ring, Linear, and Mesh), then click Next.

Note If Ring or Linear topology is selected for the subnet, the spans in the subnet must be adjacent and also 
ordered. 

Step 3 Click Press to build new subnet. The Traffic Subnet Builder Wizard appears (Figure 2-23).

Step 4 Select the ducts that should be a part of the subnet from the list displayed on the left handside, and click 
OK. This takes you back to the Traffic Subnet Creation Wizard.
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Step 5 Click Finish to complete the creation of the traffic subnet. The created subnet appears in Project 
Explorer under Traffic Subnets.

Figure 2-23 Traffic Subnet Builder Wizard

2.3.4 Creating a Point-to-Point Demand
Use the following procedure to add a point-to-point traffic demand:

Step 1 In the NtView Name tab, click the Create a new P2P demand icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 2 Click the source site of the demand. 

Step 3 Click the destination site of the demand. The Point to Point Demand Creation Wizard appears 
(Figure 2-24).

Step 4 From the drop-down list, select Traffic Subnet ALL or any of the previously created traffic subnets to 
which this service demand should be part of, and proceed to Step 5. If you wish to create a new traffic 
subnet see “2.3.3 Creating Traffic Subnet” section on page 2-47.

Step 5 Click Next.
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Figure 2-24 Point to Point Demand Creation Wizard 

Step 6 On the General Parameters page, complete the following:

• Label—Type the name of the demand.

• Source—(Display only) Displays the source site name.

• Destination—(Display only) Displays the destination site name.

• Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.5 Service Support” section on page 1-4.

• Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

• Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 7 Click Next.

Step 8 On the Platform Parameters page, complete the following:

• Protection—Choose the protection type from the drop-down list: Y-Cable Protected, Client 1+1, 
Fiber Switched, or Unprotected. For more information on protection types, see the 
“1.2.4 Protection Scheme Support” section on page 1-4.

• Path—(Unprotected only) Choose the routing type from the drop-down list:

– Auto—Allows the highest degree of flexibility in routing the channels. Cisco TransportPlanner 
routes the channels with the lowest possible cost, given the other constraints.

– A—Select this for a Terminal or a Terminal+ site. 

– A or B—Select either of these for a Line or a Line+ site.
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– A, B, C, or D—Select either of these for a Multi-Degree site if four ducts are connected.

– A, B, C, D, E, F, G, or H—Select either of these for a Multi-Degree site if eight ducts are 
connected.

• Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will 
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on 
the other side of the same node to allow the future use of that node as an add/drop location. 

Step 9 Complete the following fields in the Interface Parameters area. The options available are based on the 
service type selected in Step 6.

• Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Alien Card—Appears only if you created a third-party interface as described in the “2.2.4 Defining 
Third-Party DWDM Interfaces” section on page 2-25. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

• Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

Step 10 In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available for transponder and 
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and 
card type. 

Step 11 Click Finish. The Edit Point to Point Demand dialog box appears listing the present and forecast 
channels. 

The demand appears in the NtView Name tab and in the Project Explorer tree in the 
Service Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when 
not selected. The line has a number above it that indicates the number of channels that are present. 
Figure 2-25 shows a selected point-to-point demand with five channels between Sites 1 and 2. 

Note To make changes to the demand parameters, see the “2.6.6 Editing a Point-to-Point Demand” section 
on page 2-100, or click Cancel to close the Edit Point to Point Demand dialog box. 

Figure 2-25 Point-to-Point Demand Between Two Sites 

Note For each network, Cisco TransportPlanner automatically creates a default subnet that exactly matches 
the overall network topology. This cannot be deleted. 

2.3.5 Creating a Protected Ring Demand
Use the following procedure to create a P-ring traffic demand.
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Step 1 Create a ring network using either the procedures in the “2.3 Creating a Project” section on page 2-36 
or by manually placing sites into a ring configuration.

Step 2 In the Native Net# tab, click the Create a new P-Ring demand icon in the toolbar. The P-Ring Creation 
Wizard appears (Figure 2-26). For more information about the Cisco TransportPlanner icons, see 
Appendix A, “GUI Information and Shortcuts.”

Figure 2-26 P-Ring Creation Wizard 

Step 3 For each network, the tool automatically creates, a default subnet that exactly matches the overall 
network topology. This cannot be deleted. From the drop-down list, select any previously created traffic 
subnet with a ring topology that this circuit should be part of and proceed to Step 4. If you wish to create 
a new traffic subnet see 2.3.3 Creating Traffic Subnet, page 2-47.

Step 4 On the General Parameters page, complete the following:

• Label—Enter the name of the demand.

• Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.5 Service Support” section on page 1-4.

• Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

• Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 5 Click Next.
2-51
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Creating a Project
Step 6 On the Sites Selection page, in the Protection Sites area, press Ctrl and click the sites that you want to 
add to the P-ring. A P-ring requires at least two sites. Click the right arrow button. To remove a site added 
to the list, click the site and click the left arrow button. 
In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the 
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Step 7 Click Next.

Step 8 On the WDM Client Selection page, complete the following interface parameters. The options available 
are based on the service type selected in Step 4.

• Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

• Alien Card—Appears only if you created a third-party interface as described in the “2.2.4 Defining 
Third-Party DWDM Interfaces” section on page 2-25. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

• Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available for transponder and 
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and 
card type. 

Step 9 Click Finish. The Edit P-Ring Demand dialog box appears.

The demand appears in the NtView Name tab and in the Project Explorer tree in the 
Service Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not 
selected. The line has a number above it that indicates the number of channels present. Figure 2-27 
shows a selected one-channel P-ring between Sites 1, 2, 3, and 5 with an optical bypass of Site 4. 

Note To make changes to the demand parameters, see the “2.6.7 Editing a P-Ring Demand” section on 
page 2-101, or click Cancel to close the Edit P-Ring Demand dialog box. 
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Figure 2-27 P-Ring Demand

2.3.6 Creating a ROADM Demand
Use the following procedure to create ROADM traffic groups and demands:

Step 1 In the Project Explorer, under Nets, right-click the ROADM folder and choose New ROADM Group. 
The ROADM Group Creation Wizard appears.

Step 2 Select the desired traffic subnet from the Traffic Subnet field. You can create a new traffic subnet if 
desired using the “2.3.3 Creating Traffic Subnet” section on page 2-47.

Step 3 Type the ROADM traffic group name in the Group Name field. 

Step 4 Check the desired sites.

Step 5 Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer.

Step 6 Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut 
menu. The Create ROADM Demand dialog box appears (Figure 2-28).
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Figure 2-28 Create ROADM Demand Dialog Box 

Step 7 Enter a name for the demand in the Demand Name field. 

Step 8 Select a traffic pattern type (Hub or Meshed) from the Traffic Type drop-down list. If you select Hub, 
the First Site drop-down list becomes available. If you selected Meshed, proceed to Step 10.

Step 9 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 10 Select a connectivity type from the Connectivity type drop-down list: Protected, Unprotected 
Minimum Hop, Unprotected Optimum Path, or Unprotected Subnet. Refer to the “1.5.3 ROADM 
Traffic Demands” section on page 1-9 for more information on the connectivity choices. If you chose 
Unprotected Subnet, continue with the next step; otherwise proceed to Step 12.

Step 11 If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed 
from the drop-down lists. 

Step 12 In the Service Types list, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the table to the right of the Service Types 
list.

Step 13 To further define the client interfaces, complete the following options for each client interface listed in 
the table. Check boxes in gray are not available for selection.

• Yes/No—Check to select this card to implement the service type.

• Client Interface—(Display only) Displays the card type for the selected service type.

• Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

• 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

• Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

• Supported Service—(Display only) Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco TransportPlanner checks the best client interface to support each service. 

Step 14 Click Ok to create the demand.
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2.3.7 Creating Ethernet Aggregated Demand
An Ethernet aggregated demand is a collection of low rate Gigabit Ethernet/10Gigabit Ethernet services 
that can be aggregated on a single 10-Gbps Wavelength Division Multiplexing (WDM) trunk. It is 
supported only by the GE_XP and 10GE_XP cards when configured as an L2-Switch. The Ethernet 
Aggregation Creation wizard allows you to create one WDM transport channel at a time over a 
predefined traffic subnet, specify the wavelength to be used for the channel, and define a list of locations 
with add/drop VLAN circuit capability. You can also create a set of desired VLAN circuits on this WDM 
transport channel. The check functionality generates a report showing for each section of the subnet 
where the WDM transport channel is over allocated and then perform when the corrective action is 
required. The clone functionality creates an identical copy of the current WDM transport channel with 
the same add/drop sites and WDM channel configuration parameters. You can then start filling this 
channel with the desired circuits. 

Use the following procedure to create Ethernet aggregated demands:

Step 1 In the NtView Name tab, click the Create new Ethernet Aggregated demand icon in the toolbar. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
The EthernetAggr Creation Wizard appears (Figure 2-29). 

Figure 2-29 Ethernet Aggregation Creation Wizard

Step 2 Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic 
subnet if desired using 2.3.3 Creating Traffic Subnet, page 2-47.

Step 3 Click Next.

Step 4 In the General Parameters page, complete the following:

• Label—Type the name of the demand. The default value is EthernetAggr1.
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• Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if 
this demand is needed now. This parameter will drive the list of pluggable port modules to be 
equipped on the card and will affect BoM reports.

Step 5 Click Next.

Step 6 On the site selection page, complete the following:

• In the Protection Sites area, press Ctrl and click the sites that you want to add to the ethernet 
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow 
button. To remove a site added to the list, click the site and click the left arrow button.

• In the Optical Bypass area, press Ctrl and click the sites that you want to add to Ethernet aggregated 
demand. Click the right arrow button. To remove a site added to the list, click the site and click the 
left arrow button. If the Present/Forecast check box is checked, then you cannot select Optical 
Bypass sites. A channel in optical bypass is dropped on one side of the node and added on the other 
side of the same node to allow the future use of that node as an add/drop location.

Step 7 On Node Configuration Selection page, complete the following:

• DWDM Trunk—Select the DWDM trunk type. You can specify the kind of WDM trunk interface 
for the card in each add/drop site allowed. Allowed values are: Auto, w/EFEC, w/FEC, and w/o 
FEC.

• Wavelength—This allows the user to force the current WDM transport channel wavelength. Allowed 
values are:

– Auto—This allows the tool to assign wavelength to the channel with the lowest possible cost, given 
the other set of constraints.

– Allowed wavelength bands—C band-32 ch.odd, L band- 32 ch.odd, C band- 40 ch, or C 
band- 80 ch. Wavelengths are listed based on the selected band. Choose a desired wavelength for 
the WDM transport channel. 

• In the New CFG field, select the desired card type for each site.

Step 8 Click Finish to complete the creation of WDM transport channel. This brings up a window that allows 
to add circuits to this WDM transport channel (see Figure 2-30). 

Step 9 Click Close. To add circuits to this channel, see the “2.6.9 Editing an Ethernet Aggregated Demand” 
section on page 2-103.

Step 10 If you wish to clone this demand, click the Clone button on the left corner of the screen. A new demand, 
which is a copy of this demand, will be created and will appear in the Project Explorer pane.
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Figure 2-30 EthernetAggr2 Demand Window, DWDM Channel Tab

2.3.8 Creating TDM Aggregated Demand
A TDM aggregated demand is a collection of low rate SONET and Gigabit Ethernet services that is 
aggregated on a single 10G WDM trunk. TDM aggregated demand is a specific service demand that is 
carried only by the ADM-10G card. It is possible to define Aggregated TDM Demand only for ANSI 
design and this demand is supported only on a ring traffic subnet. 

The TDM Aggr Creation wizard allows you to create one WDM transport channel at a time over a 
predefined traffic subnet, specify the wavelength to be used for the channel, and define a list of locations 
with add/drop STS circuit capability. You should create a set of STS circuits on this WDM transport 
channel to pass traffic. The check functionality will generate a report showing, for each section of the 
subnet, where the WDM transport channel is over allocated and then perform, when required, the 
corrective action. 

The total amount of bandwidth used by all the defined circuits in each section of the WDM transport 
channel cannot exceed the maximum channel capacity of STS-192c. Sections exceeding the maximum 
capacity are colored red in the report. Demands that fail the check will be flagged as invalid demands 
and the Analyzer will stop. 
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The clone functionality allows you to create an empty copy of the current WDM transport channel, with 
same add/drop sites and WDM channel configuration parameters. You can then start filling this channel 
with the desired circuits. 

Use the following procedure to create TDM aggregated demands:

Step 1 In the NtView Name tab, click the Create new TDM Aggregated demand icon in the toolbar. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
The TDMAggr  wizard appears (Figure 2-31).

Figure 2-31 TDM Aggr Creation Wizard

Step 2 Select the desired traffic subnet from the Traffic Subnet drop-down list. You can create a new traffic 
subnet if desired using 2.3.3 Creating Traffic Subnet, page 2-47.

Step 3 Click Next.

Step 4 In the General Parameters page, complete the following:

• Label—Type the name of the demand. The default value is TDMAggr1.

• Present/Forecast—Check this box if this demand will be needed in the future; uncheck this box if 
this demand is needed now. This parameter will drive the list of pluggable port modules to be 
equipped on the card and will affect BoM reports.

Step 5 Click Next.

Step 6 In site selection area complete the following

• In the Protection Sites area, press Ctrl and click the sites that you want to add to the ethernet 
aggregated demand. An Ethernet aggregated demand requires at least two sites. Click the right arrow 
button. To remove a site added to the list, click the site and click the left arrow button.
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• In the Optical Bypass area, press Ctrl and click the sites that you want to add to Ethernet aggregated 
demand. Click the right arrow button. To remove a site added to the list, click the site and click the 
left arrow button. If the Present/Forecast check box is checked, then you cannot select Optical 
Bypass sites. A channel in optical bypass is dropped on one side of the node and added on the other 
side of the same node to allow the future use of that node as an add/drop location.

Step 7 In Node Configuration selection, complete the following:

• DWDM Trunk—Select the DWDM trunk type to specify the kind of WDM trunk interface for the 
card in each allowed add/drop site. Allowed values are: Auto, w/EFEC, w/FEC, and w/o FEC.

• Wavelength—Allows you to force the current WDM transport channel wavelength. Allowed values 
are:

– Auto—Allows Cisco TransportPlanner to assign wavelength to the channel with the lowest possible 
cost, given the other set of constraints.

– Allowed wavelength bands——C band-32 ch.odd, L band- 32 ch.odd, C band- 40 ch, or C 
band- 80 ch. Wavelengths are listed based on the selected band. Choose a desired wavelength for 
the WDM transport channel.

Step 8 Click Finish to complete the creation of WDM transport channel. The WDM Transport Channel 
Management Wizard appears (see Figure 2-32) that allows you add circuits to this WDM transport 
channel. 

Step 9 Click Close. To add circuits to this channel, see “2.6.10 Editing a TDM Aggregated Demand” section 
on page 2-108. 

Step 10 If you wish to clone this demand, click the Clone button on the left corner of the screen. A new demand, 
which is a copy of this demand, will be created and will appear in the Project Explorer pane.

Figure 2-32 TDMAggr Demand
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2.3.9 Adding Notes to a Project
Use the following procedure to add a note to any item in the Project Explorer. Each network has a Notes 
folder in the Project Explorer. After you have created a note, it appears in the Notes folder for that 
particular network. 

Step 1 Right-click the desired item in the Project Explorer and choose Edit Note from the shortcut menu.

Step 2 In the Edit Note creation box, enter the desired text. 

Step 3 To close the Edit Note creation box and to save the note, click the X in the upper right corner of the 
window.

Step 4 To view notes, double-click the Notes folder. The Notes window appears. Table 2-6 lists the columns in 
the Notes window.

Step 5 To close the Notes window, click the X in the upper right corner of the window.

2.3.10 Creating an Optical Subnet
An optical subnet is a collection of spans with certain associated, defined, common properties. You can 
define distinct optical subnets on the same network and can also set a list of associated properties on 
each of them.

The following properties are supported in an optical subnet:

• C-band Rules—Allows you to define rules for the C-band channels, the maximum per channel 
power, and the channel spacing for the design. 

• L-band Rules—Allows you to define, for the L-band channels, the maximum per channel power, and 
the channel spacing for the design.

When you create a new project (see the “2.3 Creating a Project” section on page 2-36), Cisco 
TransportPlanner automatically creates an optical subnet associated to the network. At least one optical 
subnet (even if empty) must exist for each network in a project. 

You can create an optical subnet using the Project Options (default) Optical Subnet property (Design 
Rules) values. To do this:

Step 1 Select the Optical Subnet folder in Project Explorer. The Optical Subnet Pane appears in the Task Pane 
on the right side of the screen (Figure 2-33).

Table 2-6 Notes Window

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header 
to expand the text.

Action Click Go to open the item in the Project Explorer where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2.W.
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Figure 2-33 Creating Optical Subnet 

Step 2 Click Create. The Create Optical Subnet dialog box appears (Figure 2-34). The default name, which 
is a combination of the user-created C-band and L-band rules, and the wizard-created default C-band and 
L-band rules are displayed.

Figure 2-34 Create Optical Subnet Dialog Box

Step 3 Select C-band and L-band design rules from the C Design Rule and L Design Rule drop-down lists for 
the new optical subnet that you want to create. 

Step 4 Click OK. A new optical subnet with the design properties you selected is created and placed in project 
explorer under the Optical Subnets folder. 

Note You cannot create more then one optical subnet with the same properties values and each span must be 
part of only one optical subnet.

Cisco TransportPlanner allows you to modify, edit, define an optical subnet as current, and to delete an 
optical network. To do these, select the optical subnet you want to change in Project Explorer and choose 
the appropriate Modify, Edit, Set as Current, or Delete options under Optical Subnets in the Tasks Pane.
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Note When you delete an optical subnet, all the spans contained in the deleted optical subnet are placed within 
the current optical subnet. In case the current optical subnet is deleted, all their spans will be 
automatically placed within the optical subnet with the greatest number of spans. When the current 
optical subnet is removed, the tool automatically defines as current the optical subnet with the greatest 
number of contained spans.

2.4 Analyzing the Network
After you have created the desired sites, fiber spans, and service demands, you must analyze the network 
to determine network performance. The network must be in the Design, Install, or Upgrade state before 
you can analyze it. Cisco TransportPlanner automatically optimizes the design and summarizes the 
optical transmission performance. If there are problems with the design, Cisco TransportPlanner lists the 
problems and descriptions in the Analyzer Messages pane. 

Use the following procedure to analyze the network:

Step 1 Click the Networks Mgmt Tree tab, and click the network that you want to analyze.

Step 2 Click the Analyze Network icon in the toolbar. For more information about the Cisco TransportPlanner 
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks 
Pane. 

The Cisco TransportPlanner analysis status bar indicates when the network analysis is complete. 

Step 3 If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer 
Messages pane. The Summary report appears. See the “2.5.1 Viewing the Summary Report” section on 
page 2-63 for more information. Warning and error messages help you identify problems with your 
current design. For a list of all system messages, see Appendix C, “System Messages.”

Step 4 If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the 
network, you can analyze the network again. 

Note You can return a Design-Analyzed network to the design state to make further changes by clicking the 
network icon in the Networks Mgmt Tree and clicking Design in the Tasks Pane. 

2.5 Viewing Network Reports
Cisco TransportPlanner provides the reports listed in Table 2-7. Report availability depends on whether 
a network has been analyzed or whether it is in the Install or Upgrade state. Reports are also available 
by site. See Table 2-7 for report availability details.

Note Although the following procedures use the Tasks Pane to access reports, you can also access reports by 
clicking the desired report in the Project Explorer tree Reports folder.
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For more information on the Bill of Materials report, see the “2.8 Generating a BoM” section on 
page 2-131. In addition, you can compare the following reports using the Reports Diff tool: Bill of 
Material, Internal Connections, and Installation Parameters. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-15 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-15.

2.5.1 Viewing the Summary Report
The Summary report summarizes design information, optical results, design cost, and analyzer 
messages. You can view it before or after you analyze a network. It automatically appears when you 
analyze a network. Use the following procedure to view the report at another time:

Step 1 Complete one of the following:

• To view the Summary report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Summary report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Summary. The Summary tab appears (Figure 2-35).

Table 2-7 Report Availability

Report Network Availability Site Availability

NE Update Analyzed —

Installation Parameters Analyzed Analyzed 

Traffic Matrix Analyzed Analyzed

Layout Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Link Availability Analyzed Analyzed

Internal Connections Analyzed —

Optical Results Analyzed Analyzed

Wavelength Routing Analyzed —

Summary Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Bill of Material Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed
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Figure 2-35 Summary Tab

Table 2-8 lists the categories in the Summary tab and their descriptions. 
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2.5.2 Saving the NE Update File
After Cisco TransportPlanner completes network analysis, you can create a configuration file. If the 
Optical Networking System (ONS) is Software Release 7.0 or later, a single XML file is created 
including all of the parameters for all the sites in the network; if the ONS is Software R4.7 or R5.0, a 
single TXT file is created for each site in the network. This file can be directly imported to a site using 
the NE Update feature in Cisco Transport Controller (CTC). CTC uses this file to preprovision a node. 

Each file is named with the site name string by default. The list of reported installation parameters 
depend on the system release selected for the designed network. You generally save this file after you 
analyze an Install network.

Use the following procedure to save the NE Update file:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click NE Update. The Network Element Update File dialog box appears.

Table 2-8 Summary Tab Categories

Category Description

Design info Displays the following information:

• Version—Displays the Cisco TransportPlanner software release version.

• Customer name—Displays the name of the customer requiring this network 
design. 

• Created By—Displays the user login name. 

• Release—Displays the Cisco TransportPlanner software release number.

Optical results Indicates how many demands are included in the network, and identifies the number 
and severity of alarms for each demand. 

Design cost info Displays the following information:

• Price list—Displays the price list used.

• Currency—Displays the currency selected for the price list.

• BoM total discounted—Displays the total price of the products (excluding spare 
parts) in the network with the discount applied.

• Spare total discounted—Displays the total price of the spare parts in the 
network with the discount applied

• BoM + Spare total discounted—Displays the total price of the products 
(including spare parts) in the network with the discount applied.

Messages Displays any analyzer messages that occurred as a result of network analysis. 
Warning and error messages will help you identify problems with your current 
design. For a list of all system messages, see Appendix C, “System Messages.”
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Step 3 Check the Include wavelength parameters check box to include trunk wavelength preprovisioning in 
the NE Update XML file. Do not check this box if the network on which you import the NE Update file 
is using ONS Software R7.0.0. If this option is checked, trunk wavelength is preprovisioned in CTC for 
all the TXP and MXP units required to support present traffic demands. 

Note During project creation, selecting MSTP- Release 7.0 allows you to create projects for system 
releases 7.0.0 and 7.0.x. However, when importing the NE Update file on a node using system 
release 7.0.0, the node cannot read the NE Update XML file if Include wavelength parameters 
is checked.

Step 4 To save the file in a different directory than the Destination Folder, click Change and navigate to the 
desired directory. Click Save. 

Step 5 Click Finish.

Step 6 Click Cancel to close the window without saving a configuration setup file.

2.5.3 Viewing the Installation Parameters 
The Installation Parameters reports shows the values to be set (provisioned) at installation time on each 
site in the network. These parameters are exported when you save the NE Update file and are used to 
automatically provision a node using CTC. 

Use the following procedure to view the installation parameters after a network has been analyzed:

Step 1 Complete one of the following:

• To view the Installation Parameters report for a network, click the Networks Mgmt Tree tab and 
click the network.

• To view the Installation Parameters report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Installation Parameters. The Installation Parameters tab appears (Figure 2-36). 
The ANS view subtab appears by default. This tab displays the Automatic Node Setup information.
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Figure 2-36 ANS View Subtab in the Installation Parameters Tab 

Table 2-9 describes the columns on the ANS view tab of the Installation Parameters report. 

Step 3 Click the ANP view tab to view the Automatic Node Provisioning information. Table 2-10 describes the 
columns on the ANP view tab of the Installation Parameters report. 

Table 2-9 Installation Parameters Report ANS View Tab Columns

Column Description

Name Displays the name of the site. 

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface. This column only applies to alarms. It does not apply to threshold crossing 
alerts (TCAs).
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Step 4 Click the PP view tab to view the Provisioning Parameters information. Table 2-11 describes the 
columns on the PP view tab of the Installation Parameters report. 

Step 5 To close the Installation Parameters report, click the X on the top right of the Installation Parameters tab.

2.5.4 Viewing Internal Connections
Use the following procedure to view the network internal connections after a network has been analyzed.

You can also use this procedure to view the patchcord connections between transponders and the Y-Cable 
Protection modules. The Y-Cable Protection position is defined using the rack and shelf number. The 
slots are numbered from left to right on each of the four modules that can be placed in a shelf.

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Internal Connections. The Internal Connections tab appears (Figure 2-37).

Table 2-10 Installation Parameters Report ANP View Tab

Category Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Rack number Displays the rack number.

Rack position Identifies the rack position in the shelf.

Slot position Identifies the slot position in the shelf for the card.

Equipment type Displays the card type.

Table 2-11 Installation Parameters Report PP View Tab

Column Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Slot position Displays the slot number for the card with the PPM.

Port position Displays the port number.

Ppm position Displays the PPM location on the card.

Pp name Displays the name of the PPM. 

value Displays the installation parameter value.
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Figure 2-37 Internal Connections Tab 

Table 2-12 lists the columns in the Internal Connections tab and their descriptions. Click a columns to 
sort the table information by that column.

• Click the Patchcord installation view subtab to view all the patchcord connections that the installer 
has to mechanically cable within the site between the different ports of the cards. 

• Click the SW Provisioning view subtab to view the patchcord representation on the local Cisco 
Transport Controller interface. This subtab contains all the connections to be manually set or 
removed with respect to the default connections that are automatically generated by the software 
running on the node. 

Table 2-12 Internal Connections Tab Columns

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

Position-1 Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit-1 Displays the name of the card.
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Step 3 To export the information to an external file, click Export. In the Internal connections export dialog box, 
type the name of the file and navigate to the desired folder. Click Save.

Step 4 To close he Internal Connections tab, click the X in the upper right corner of the tab.

2.5.5 Viewing the Traffic Matrix Report
The Traffic Matrix report displays the point-to-point, P-ring, and ROADM channel data. Use the 
following procedure to view the traffic matrix report:

Step 1 Complete one of the following:

• To view the Traffic Matrix report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Traffic Matrix report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane under Reports, click Traffic Matrix. The Traffic Matrix tab appears. A default query 
opens.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-1 (SW provisioning view subtab only) Displays the port ID.

Port label-1 Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position-2 Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit-2 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-2 (SW provisioning view subtab only) Displays the port ID.

Port Label-2 Displays the name of the port.

P/F Displays whether the connection relates to a present or forecast circuit.

Table 2-12 Internal Connections Tab Columns (continued)

Column Name Description
2-70
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Viewing Network Reports
Figure 2-38 Traffic Matrix Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns. The Traffic Matrix report displays separate rows for the TX and RX direction of the optical 
channels.

Note To add a column to the report, right-click a column and choose the column name from the 
shortcut menu. The column names with checks in the shortcut menu appear on the report. To 
remove a column, right-click and choose the column (checked) from the shortcut menu. 

Table 2-13 Traffic Matrix Tab Columns

Column Label Description

Service Demand Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Service Circuit Displays the optical channel label; for example, Site1-Site2.

OCH CC Source Displays the site name for the optical channel source.

OCH CC Source 
Position

Displays the rack, shelf, and slot identifiers for the source of the optical channel. 
The format of the field is Rack.Shelf.Slot.

OCH CC Source 
Unit

Displays the unit name for the optical channel source.

OCH CC Source 
Port

Displays the port for the source of the optical channel; for example, Client RX.

OCH CC Dst Displays the site name for the optical channel destination.

OCH CC Dst 
Position

Displays the rack, shelf, and slot identifiers for the destination of the optical 
channel. The format of the field is Rack.Shelf.Slot.

OCH CC Dst Unit Displays the product ID for the optical channel destination.
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Step 3 To create a new query, click New Query to open the Query Dialog (Figure 2-39). The Query Dialog 
allows you to filter the optical results using a variety of parameters and templates.

OCH CC Dst Port Displays the port for the destination of the optical channel; for example, Client 
TX.

A/D Source Displays the site name for the add/drop channel source.

A/D Source 
Position

Displays the rack, shelf, and slot identifiers for the source of the add/drop 
channel. The format of the field is Rack.Shelf.Slot.

A/D Source Unit Displays the unit name for the add/drop channel source.

A/D Source Port Displays the port for the source of the add/drop channel; for example, Client RX.

A/D Dst Displays the site name for the add/drop channel destination.

A/D Dst Position Displays the rack, shelf, and slot identifiers for the destination of the add/drop 
channel. The format of the field is Rack.Shelf.Slot.

A/DDst Unit Displays the product ID for the add/drop channel destination.

A/D Dst Port Displays the port for the destination of the add/drop channel; for example, Client 
TX.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Wavelength Displays the wavelength of the optical channel.

Opt Bypass Identifies where the optical channel is dropped and reinserted when it is not 
terminated on a TXP or MXP card (optical bypass). If “none” appears in the Op 
Bypass column, no optical bypass is defined for the optical channel.

DWDM Interface 
Type

Identifies the DWDM interface type that is used for the optical channel:

• Transponder indicates that an MSTP transponder, an MSTP muxponder, or a 
DWDM pluggable port module is used for the optical channel.

• Line Card indicates that an ITU line card is used for the optical channel.

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Table 2-13 Traffic Matrix Tab Columns (continued)

Column Label Description
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Figure 2-39 Query Dialog 

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-14 describes the fields in the Query Dialog.

Table 2-14 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.
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Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Traffic Matrix tab 
(Figure 2-38). The parameters of the query appear in the horizontal area just below the button bar.

• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Traffic Matrix report, click the X in the upper right corner of the tab.

2.5.6 Displaying the Layout 
Use the following procedure to view a graphical representation of each site in an analyzed network: 

Step 1 Click the NtView Name tab and click the desired site.

Step 2 In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-40). To change sites, choose the 
desired site from the drop-down list.

Figure 2-40 Layout Report (Rack View)
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Step 3 From the Site drop-down list, choose the site in the network to display in the layout report.

Step 4 In the tree view on the left of the tab, right-click a rack and choose Expand to view a list of all shelves 
and cards in the rack. 

Step 5 Click the desired rack or shelf to view it in the layout graphic. Figure 2-41 displays the shelf view.

Figure 2-41 Layout Report (Shelf View)

Step 6 To view details about a card, double-click the card. The Details dialog box opens with client information:

• Label—Displays the name of the card.

• Product ID—Displays the product ID of the card.

• Service Category—Future use.

• Description—Provides a brief description of the card functionality.

• Price—Lists the price for the card based on the price list selected during project creation.

• ITU Channel—Identifies the ITU channel wavelength for the card.

For transponder and muxponder cards, click the Modules subtab in the Details dialog box to view which 
pluggable port modules are to be used for each TXP/MXP unit:

• P/F—P refers to pluggable port modules that support the present client demand, while F refers to 
pluggable port modules that support the future client demand.

• Module PID—Displays the pluggable port module product ID.
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• Ch#—Displays the number of the port on the unit and identifies where the pluggable port module is 
to be installed. 

Click Close to close the Details dialog box.

Step 7 To filter the layout display, choose one of the following from the drop-down list:

• Any—Displays all cards for both the present and forecast traffic demand.

• Present—Displays cards for only the present traffic demand.

• Locked & Unlocked—Highlights the locked and unlocked cards in the layout.

• Alarmed—Highlights the alarmed cards in the layout.

Step 8 After network analysis, all items are in locked mode. To unlock cards so that Cisco TransportPlanner can 
rearrange the layout to optimize slot usage during network analysis, right-click locked card in the rack 
tree and choose Unlock. 

Note You can unlock only on Upgrade networks in the Design state.

Step 9 To export the graphical representation of the layout in JPEG format, click Export. In the Layout export 
dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 10 To zoom the layout graphic in or out, click the Zoom In and Zoom Out icons. For more information about 
the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 11 To close the Layout report, click the X in the upper right corner of the tab.

2.5.7 Viewing Power Consumption from the Layout Report
Use the following procedure to view the power consumption for each unit of equipment in a site. Power 
consumption is available in report form from the Layout report.

Step 1 Click the NtView Name tab and click the desired site.

Step 2 In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-40 on page 2-74). To change sites, 
choose the desired site from the drop-down list.

Step 3 Click the View layout as table icon in the report tool bar. The Layout Table report appears (Figure 2-42).
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Figure 2-42 Power Consumption 

Table 2-15 describes the information in the columns. 

Step 4 To export power consumption data, click Export. The Layout table export dialog box appears. Type the 
name of the file and navigate to the desired folder. Click Save.

Step 5 Click Close to close the Layout Table report.

2.5.8 Viewing the Link Availability Report 
Cisco TransportPlanner determines link availability based on unit failure rate and time to repair. Use the 
following procedure to view the Link Availability report:

Table 2-15 Layout Table (Power Consumption) Columns

Column Label Description

Name Lists the equipment at the site. 

Position Identifies the rack, shelf, or slot location for applicable units of equipment.

Description Describes each equipment type.

Max Power 
Consumption (W)

Displays the maximum power consumption for each unit of equipment. 

Note For transponder/muxponder cards with pluggable port modules, the 
maximum power consumption shown is for the board fully equipped with 
the maximum number of pluggable port modules.

Average Power 
Consumption (W)

Displays the average power consumption for applicable units of equipment.

Note For transponder/muxponder cards with pluggable port modules, the 
average power consumption shown is for the board fully equipped with 
the maximum number of pluggable port modules.
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Step 1 Complete one of the following:

• To view the Link Availability report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Link Availability report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Link Availability. The Link Availability tab appears (Figure 2-43).

Figure 2-43 Link Availability Report

Each row in the tab shows the performance of one optical path. Table 2-16 describes the information in 
the columns.

Step 3 Click New Query to open the Query Dialog (Figure 2-39 on page 2-73). The Query Dialog allows you 
to filter the link availability using a variety of parameters.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-17 describes the fields in the Query Dialog.

Table 2-16 Link Availability Tab Columns

Column Label Description

Group Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Serv. Circuit Displays the optical channel label; for example, Site1-Site2.

P/F Identifies whether the channel is present and forecast (P/F) or forecast (F).

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Source Displays the site name for the optical channel source.

Destination Displays the site name for the optical channel destination.

Link Availability 
(% Complete)

Displays the link availability percentage. Link availability is calculated based on 
the failure rate and time to repair. 
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Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Link Availability tab. The 
parameters of the query appear in the horizontal area just below the button bar.

• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Link Availability report, click the X in the upper right corner of the tab.

2.5.9 Viewing Optical Results
Use the following procedure to view the optical results of the network that you created and analyzed:

Step 1 Complete one of the following:

• To view the Optical Results report for a network, click the Networks Mgmt Tree tab and click the 
network.

• To view the Optical Results report for a site, click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Optical Results. The Optical Results tab appears (Figure 2-44).

Table 2-17 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.
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Figure 2-44 Optical Results Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns.

Table 2-18 Optical Results Tab Columns

Column Label Description

Name Displays the identification number automatically given to each path in the order 
that the channels were entered into the design.

Group Identifies the demand group for the optical channel.

Protect Displays the protection type of the channel. For a protected channel, both paths 
are shown. The path leaving the east side of the source is shown first.

SOL Displays the results summary of the analysis run with Start of Life fiber loss 
values. The indicator shows the optical performance for the each direction of the 
bidirectional OCH Trail. Green indicates success, yellow indicates success with 
a marginal failure risk (between 0 and 16 percent), orange indicates that the 
channel has a higher risk of failure (between 16 and 50 percent), and red indicates 
failure. 

EOL Displays the results summary of the analysis run with End of Life fiber loss 
values. The indicator shows the optical performance for the each direction of the 
bidirectional Optical Channel Trail (OCH Trail). The indicator shows the optical 
performance for the path at the end of the fiber’s life. Green indicates success, 
yellow indicates success with a marginal failure risk (between 0 and 16 percent), 
orange indicates that the channel has a higher risk of failure (between 16 and 50 
percent), and red indicates failure.
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SE Indicates a system-related error exists that may impact the analysis of the design.

If the indicator is red, review the messages reported at the end of the analysis or 
determine which units or sites are having a problem.

Regeneration Displays the status of the single channel nonlinear effect (NLE) alarm check. 
Green indicates check passed. Yellow indicates marginal NLE; orange indicates 
consistent NLE, and Red indicates failure. 

Multi-channel NLE 
Status

Displays the status of the multiple channel NLE alarm check. Green indicates 
check passed. Yellow indicates marginal NLE; orange indicates consistent NLE, 
and red indicates failure. 

Wavelength Displays the assigned wavelength of the optical path.

P/F Displays the present/forecast services indication.

Source Displays the name of the source site and side; for example, Site 1-E.

Destination Displays the name of the destination site and side; for example, Site 1-E.

Span (km) Displays the total span length (source -> destination) for this path in kilometers.

Tx Type Displays the type of DWDM unit or pluggable port module used for the specific 
OCH Trail.

BER target Displays the bit error rate (BER) target for this channel based on the capability 
of the channel’s optical interface. It is 1.0E-15 for the interfaces using forward 
error correction (FEC) and 1.0E-12 for interfaces without FEC.

SOL OSNR (dB) Displays the start of life average OSNR value at the receiver. OSNR refers to the 
selected resolution bandwidth (RBW) bandwidth.

EOL OSNR (dB) Displays the end of life average OSNR value at the receiver. OSNR refers to the 
selected RBW bandwidth.

SOL OSNR Margin 
(dB)

Displays the SOL OSNR margin calculation, which is the difference between the 
OSNR value at a certain power of the working point of the receiver client and the 
working area boundary.

EOL OSNR Margin 
(dB)

Displays the EOL OSNR margin calculation, which is the difference between the 
OSNR value at a certain power of the working point of the receiver client and the 
working area boundary.

SOL RX (dBm) Displays the SOL received average power at the destination site in dBm.

EOL RX (dBm) Displays the EOL received average power at the destination site in dBm.

SOL Power margin 
(dB)

Displays the SOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

EOL Power margin 
(dB)

Displays the EOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

SOL Overload (dB) Displays the SOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

EOL Overload (dB) Displays the EOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

RX atten Displays the attenuation at the input of the receiver.

Table 2-18 Optical Results Tab Columns (continued)

Column Label Description
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Step 3 Click New Query to open the Query Dialog (Figure 2-39 on page 2-73). The Query Dialog allows you 
to filter the optical results using a variety of parameters.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-19 describes the fields in the Query Dialog.

Step 5 Choose one of the following, as needed:

• Click Run Query. The window closes, and the query results appear in the Optical Results tab. The 
parameters of the query appear in the horizontal area just below the button bar.

PMD (ps) Displays the calculated total PMD for each circuit. This total includes all the 
PMD components for the OCH Trail, including fiber and DWDM units on the 
path. If the overall PMD for the link overcomes the maximum allowed, the PMD 
value is colored red. The maximum allowed value depends on the client interface. 
For these special cases, the network must be manually resolved by contacting a 
Cisco optical sales engineer.

Latency Displays the latency time for the current circuit. This value includes all the 
latency components for the OCH Trail, including fiber and DWDM units on the 
path.

Filtering Penalty Displays the value of the penalties caused by the different filter types (OADM, 
ROADM, and arrayed waveguide grating, [AWG]).

Table 2-19 Query Dialog Fields

Field Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.

Table 2-18 Optical Results Tab Columns (continued)

Column Label Description
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• Click Reset Query to clear your selections in the Query Dialog. 

• Click Close to close the window without running a query.

Step 6 To close the Optical Results report, click the X in the upper right corner of the tab.

2.5.10 Viewing Wavelength Routing
Use the following procedure to view the wavelength routing map for an analyzed network:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Wavelength Routing. The Wavelength Routing tab appears (Figure 2-45). Each 
wavelength supported by the platform is represented by a row. 

Note ROADM (Any-to-Any) demands are not shown in this report.

Figure 2-45 Wavelength Routing Tab 
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Step 3 Choose one of the following from the drop-down list: Any (to view both forecast and present routing), 
Present (to view only the present routing), or Forecast (to view only the forecast routing). When you 
select Any, forecast demands are shown with a grey background.

Table 2-20 describes the information in the columns.

Note Tool tips are available on this report. Move the cursor over a Site column for circuit information, 
card name, and product ID. Move the cursor over a Duct/Couple column for loss, length, and 
fiber type.

Step 4 To export the graphical representation of the layout in JPEG format, click Export. In the Wavelength 
Routing export dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 5 To close the Wavelength Routing report, click the X in the upper right corner of the window.

2.5.11 Viewing Report Differences
You can compare the BoM, Internal Connections, and Installation Parameters reports for two networks. 
This is useful to see the differences between a baseline network and an Install or Upgrade network. 

• The BoM Diff report lists the units that were added and/or removed from the BoM.

• The Internal Connection Diff report lists changed connections. If at least one of the two endpoints 
of an internal connection is different, Cisco TransportPlanner reports that the internal connection 
has changed. The report shows all internal connections that were present in the baseline network but 
are not present in the final network, and all internal connections not present in the baseline network 
but present in the final network.

• The Installation Parameters Diff report lists changed parameters between the baseline network and 
the final network.

Table 2-20 Wavelength Routing Tab Columns

Column Label Description

wl Lists the wavelengths supported by the platform. 

Site # Represents a site in the network. The colors in the Site columns indicate for each 
side of the site the SOL/EOL channel status. Green indicates success, yellow 
indicates success with a marginal failure risk (between 0 and 16 percent), orange 
indicates that the channel has a higher risk of failure (between 16 and 50 
percent), and red indicates failure.

Duct # Represents a duct in the network.

A Represents a Terminal or a Terminal+ site.

A and B Represents a Line or Line+ site.

A, B, C, and D Represents a Multi-Degree site with PP-MESH-4.

A, B, C, D, E, F, G, 
and H

Represents a Multi-Degree site with PP-MESH-8.

Couple Represents a pair of fibers at a site.
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Use the following procedure to compare networks:

Step 1 Click the Reports Diff icon. For more information about Cisco TransportPlanner icons, see Appendix A, 
“GUI Information and Shortcuts.” The Reports Diff dialog box appears. Figure 2-46 shows the Reports 
Diff dialog box as it appears when at least two analyzed networks exist in a project. 

Figure 2-46 Reports Diff Dialog Box

Step 2 In the Compare networks area, choose the baseline network from the drop-down list on the left. Choose 
the network to compare from the drop-down list on the right. 

Step 3 Click the report you would like to view. If you chose one non-analyzed network, you can view only the 
Bill of Material differences report.

• Bill of Material—(Figure 2-47 on page 2-86) For a description of the columns, see Table 2-21 on 
page 2-86.

• Installation Parameters—(Figure 2-48 on page 2-87) For a description of the columns, see 
Table 2-22 on page 2-88.

• Internal Connections—(Figure 2-49 on page 2-89) For a description of the columns, see Table 2-23 
on page 2-90.

Step 4 Click OK. 

Figure 2-47 shows the BoM Diff report. 
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Figure 2-47 BoM Diff Report 

The upper section of the BoM Diff Report tab displays the following information for each network:

• BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

• Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

• BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

• Price List—Displays the name of the price list database selected for the project.

• Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Table 2-21 describes the information in the BoM Diff report columns. Click a column to sort the table 
information by that column.

Table 2-21 BoM Diff Report Columns

Column Label Description

Name Displays the name of the site and equipment.

Difference Summary (not 
labeled)

Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two 
networks.

 (not equal sign)—Indicates that the item is present on both 
networks, but the number per network is different.

1—Indicates that this item is present in the first network but not in the 
second network.

2—Indicates that this item is present in the second network but not in 
the first network.
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Figure 2-48 shows the Installation Parameters Diff report.

Figure 2-48 Installation Parameters Diff Report 

Table 2-22 describes the columns in the Installation Parameters Diff report. Click a column to sort the 
table information by that column.

Differences between networks appear in red and in the following format: 
baseline-network-value/final-network-value.

PID Displays the ID string of the product. To view a PID, click on the 
plus (+) sign by the equipment name to expand it. 

Quantity Displays the number of specific products in the BoM. If the networks 
have a different quantity, Cisco TransportPlanner displays both 
numbers in red in the following format: 
first-network-quantity/second-network-quantity.

Unit Price Displays the price for each unit. To view a unit price, click on the 
plus (+) sign by the equipment name to expand it. 

Total Price Displays the total price of the products before applying the discount. 
If the networks have a different quantity, Cisco TransportPlanner 
displays both numbers in red in the following format: 
first-network-total price/second-network-total-price.

Discounted Total Price Displays the total price of the products after applying the discount. If 
the networks have a different quantity, Cisco TransportPlanner 
displays both numbers in red in the following format: 
first-network-discounted-total-price/second-network-discounted-
total-price.

Table 2-21 BoM Diff Report Columns (continued)

Column Label Description
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Figure 2-37 shows the Internal Connections Diff report.

Table 2-22 Installation Parameters Diff Report Columns

Category Description

Name Displays the name of the site. 

(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (crossed-out equal sign)—Indicates that the item is present on both networks, 
but the number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface.
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Figure 2-49 Internal Connections Diff Report

Table 2-23 lists the columns in the Internal Connections Diff report and their descriptions. Click a 
column to sort the table information by that column. 

Differences between networks appear in red and in the following format: baseline network value/final 
network value.
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2.6 Editing a Project
Cisco TransportPlanner allows you to edit the a project either before or after network analysis. Error 
messages that occur during network analysis often cannot be resolved until you edit one or more network 
components.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-15 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-15.

Table 2-23 Internal Connections Tab Columns

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

Difference 
Summary (not 
labeled)

Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (not equal sign)—Indicates that the item is present on both networks, but the 
number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port label Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit Displays the name of the card.

Port Label Displays the name of the port.

P/F Displays whether the connection relates to a present (P/F) or forecast (F) circuit.
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2.6.1 Editing Project Parameters
Use the following procedure to edit project parameters:

Step 1 Click Project in the Project Explorer.

Step 2 In the Properties pane, complete the following as needed:

• Customer—Type the name of the customer (128 character maximum) requiring this network design. 

• Created by—Type the user name (128 character maximum).

• Units—Displays the span measurement unit: Km (kilometers) or Miles.

• Price List—Choose the price database from the drop-down list.

• Layout—Displays ANSI (the North American standard) or ETSI (the international standard) to 
indicate the platform type. ANSI networks will not allow you to define SDH (ETSI) service 
demands. ETSI networks will not allow you to define SONET (ANSI) service demands. 

2.6.2 Editing Network Parameters
Use the following procedure to edit network parameters:

Step 1 Click a network in the Project Explorer or Networks Mgmt Tree.

Step 2 In the Properties pane, complete the following as needed:

• Name—Type the network name (128 character maximum).

• Position—Type the object location in pixels. 

• Created by—Type the user name (128 character maximum).

• Status—Displays the state of the network (Design, Design-Analyzed, Install, etc.).

• Use MSM Bundles—Check to use the Multishelf Management Integrated Kit bundle when 
generating the BoM instead of the single items.

• Use Spare Parts—Check to determine the spare parts required by the network. If the network is in 
the Upgrade state, the parts required to support the implemented services and the newly added 
present services are included. To generate a spare parts report, you must associate the sites in a 
network with a maintenance center before network analysis. 

• Use Global Discount—Check to use the global discount for the entire network. The global discount 
is applied to all components in the BoM.

• Global Discount—Enter a new global discount in the form of a percentage.

• Service Level—Choose the service level (contract) identifier from the drop-down list.

• Service Length—Choose the maintenance service level length (in years) from the drop-down list.

• Include SW Licenses—Check to include software licenses in the BoM.

• Include Paper Documentation—Check to include paper documentation in the BoM.

• Include CD Documentation—Check to include CD documentation in the BoM.

• Hide Bom/price discount—Check to hide the global discount in the Unit Price column of the BoM.
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• Dimension—Type the network size in pixels.

• Background color—Click to choose a color for the network background.

• Background image—Displays the JPEG or GIF filename used as a background, if any. To choose a 
JPEG or GIF file as a background graphic for the network, click the down arrow and navigate to the 
desired directory. 

2.6.3 Editing Site Parameters
Editing the site parameters allows you to make changes to the current site configuration. A site folder in 
the Project Explorer displays the interface node information. Figure 2-50 shows a site in the Project 
Explorer before network analysis. Figure 2-51 shows a site in the Project Explorer after network 
analysis. 

Figure 2-50 Site in the Project Explorer
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Figure 2-51 Analyzed Site in the Project Explorer

A site folder for an analyzed network design also contains the following items, many of which you can 
edit:

• E, W, T—For a Line or Line+ site, two interface nodes appear in the Project Explorer under the Site 
folder, labeled W (West) and E (East). For a Terminal or Terminal+ site, only one interface node (T) 
appears. 

• C-Band or L-Band—Displays the supported band for the side (E, W, or T interface). 

• Amplifiers—Lists the amplifiers and all related cards for each band and for each side (E, W, or T 
interface). 

• Add/Drop—Displays all of the add/drop and related cards for the band and side (E, W, or T 
interface).

• Site Type Parameters—When selected, shows the site functionality and type in the Properties pane.

• Band Parameters—When selected, shows the output power in the Properties pane.

• Client—Lists the client cards. 

Use the following procedure to edit site parameters. To delete a site, see the “2.6.14 Deleting Sites” 
section on page 2-113.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu. 

Step 2 Click the desired Site folder. The site parameters appear in the Properties pane.
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Step 3 Complete the following to modify the site parameters in the Properties pane, as needed:

• Name—Enter the desired site name.

• Position—Enter the desired site pixel position; for example, an entry of 0,0 positions the Site icon 
in the upper left corner of the NtView Name tab. 

• Structure—Choose the structure type from the drop-down list: 

– Line—Two pairs of fibers are terminated at the node.

– Terminal—A single pair of fibers is terminated at the node.

– Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased 
when an MMU card (topology upgrade) is installed. This node is ready to scale to become a 
multi-degree node once MMUs are installed in this node.

– Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased in if an MMU card (topology upgrade) is installed. This node is ready to scale to 
become a multi-degree node once MMUs are installed in this node.

– Multi-degree—Nodes have more than two sides and faces more than two fibre spans.

The following structure edits are allowed:

– Line to Line+

– Line+ to Line

– Terminal to Terminal+

– Terminal+ to Terminal

To make any other structure change (such as changing from Line to Terminal), you must delete and 
reinsert the site.

• MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply 
to every site in the network. If you change the MTTR value after creating sites, the new value will 
only apply to sites you create after the change.

• Maintenance Center—Choose the name of the maintenance center from the drop-down list. To 
create a maintenance center, see the “2.6.5 Creating a Maintenance Center” section on page 2-99.

• IP Address—Type the IP address of the node.

• Shelf Config—Choose the shelf configuration type from the drop-down list: 

– Multi Shelf Integrated Switch—All the MSTP optical cards (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches connected to the 
MSTP shelves. For this option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to 
support the multishelf configuration.

– Multi Shelf External Switch—All the MSTP optical card (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches external to the 
MSTP shelves. For this option, two external Ethernet switch units are used to support the 
multishelf configuration.

– Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf. 
For this option, multishelf management is not supported; every shelf is managed as an 
independent shelf.

• Node Protection—Choose the node protection type from the drop-down list: Same Shelf or 
Separated Shelves. 

• DCC Shelves Management—When checked, indicates that a TXP(P)_MR_2.5G card is in Slot 12 
on each shelf at each site. 
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• TXP/MXP OSMINE placement—When checked, indicates that the transponder/muxponder cards 
are placed in the shelves according to OSMINE placement rules.

• Hybrid MSTP/MSPP Node—When checked, indicates that all the nodes are configured as hybrid 
MSTP/MSPP nodes.

• Max Number of Shelves/Bay—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves 
(that equip optical cards or transponder/muxponder cards) that can be placed in each rack in the site 
when generating the site layout. 

• Functionality—Choose the site functionality from the drop-down list. Table 2-24 summarizes the 
site design rules. The site icon changes depending on the functionality. For a description of the site 
icons, see Appendix A, “GUI Information and Shortcuts.”

– Auto—Allows the highest degree of flexibility in creating the network. Cisco TransportPlanner 
generates a design for the site with the lowest possible cost given the other constraints.

– Pass Through—Indicates that no equipment will be located at this site.

– Line amplifier—Prevents any add/drop traffic at this site.

– OSC site—Indicates that site is designated for network communication, providing the 
possibility to access the OSC for management of the MSTP network. By default, no amplifiers 
are included in this site. However, if Cisco TransportPlanner determines that an amplifier is 
required in the network, it can automatically place it at this location. Cisco TransportPlanner 
allows you to set (force) preamplifier and booster amplifiers for each direction on a OSC site 
node.

– Add/Drop—Indicates that this site has add/drop capability. Only point-to-point and P-ring 
circuits can be added/dropped at this site.

– Hub—Indicates that this site is equipped with filters for adding and dropping all the channels 
(on both West and East sides). All express paths are open in hub configurations.

– Gain equalizer—Indicates that this site uses WSS cards to control the generated tilt and extend 
unregenerated distances. The site is realized as an ROADM site without demultiplexer cards.

– R-OADM—Indicates that this site supports Any-to-Any and also Fixed (point-to-point and 
P-ring) traffic types.

– OXC—Indicates that this site uses OXC (optical cross connect) cards to control the generated 
tilt and extend unregenerated distances. This site is realized as an ROADM site without 
demultiplexer cards. 

– OIC—Indicates that this site uses OIC (optical inter connect) cards to control the generated tilt 
and extend unregenerated distances. This site is realized as an ROADM site without 
demultiplexer cards.

Note This functionality is available only for multi-degree sites. Also, if you choose the structure 
of a site as multi-degree and functionality as OXC, the Shelf Management option that you 
select should either be Integrated or External. Otherwise, the application displays an error 
message when analyzed. 

• Type—Choose the site type from the drop-down list (see Table 2-24):

– Auto—Allows the highest degree of flexibility in creating the network. Cisco TransportPlanner 
generates a design for the site with the lowest possible cost given the other set of constraints.

– Glass Through—Indicates a low-priority amplification site.

– Line—Indicates a high-priority amplification site.
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– OADM—Indicates that it is a site with add/drop channels using discrete channel filters (1, 2, 
4-ch 1, 4-band).

– 32-WSS—Indicates that it is a site equipped with 32DMX or 32DMX-O. This option allows you 
to force the use of specific ROADM units. 

Note 32-WSS is available as choice in system release 7.0.x and above.

– Mux/Demux—Indicates that this is a full multiplexer/demultiplexer (FMD) site that adds and 
drops all channels on both sides using the 32MUX-O and 32DMX-O cards. Optical bypass is 
allowed.

– 40-WXC w/PP-MESH-4—(Multi-degree OXC sites only) Indicates the mesh type that is 
provided for sites equipped with 40-WXC cards. If this type is selected, the site will be equipped 
to support up to 4 degrees independently of the number of fibers connected to the site. 

– 40-WXC w/PP-MESH-8—(Multi-degree OXC sites only) Indicates the mesh type that is 
provided for sites equipping 40-WXC cards units. If this type is selected, the site will be 
equipped support up to 8 degrees independently of the number of fibers connected to the site.

– WSS/DMX—Multi-degree OIC sites only.

• Anti ASE—Choose Yes to configure the site so that all the express channels on the site are optically 
dropped and reinserted. In addition, all the patch cords between the West and East sections are 
removed. Choose Auto to allow Cisco TransportPlanner to decide if the site should be configured 
as anti-amplified spontaneous emissions (anti-ASE). See Table 2-24 for a summary of the site 
design rules.

Table 2-24 Site Design Rules

Structure Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz

Line Pass Through — — Yes Yes Yes Yes

Line amplifier Line amplifier — Yes Yes Yes Yes

Glass Through — Yes Yes Yes Yes

OSC Site — — Yes Yes Yes Yes

Add/Drop OADM
(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

Hub Mux/Demux — Yes Yes No No

WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Gain equalizer WSS 32DMX Yes No Yes Yes

ROADM WSS 32DMX-O Yes No Yes No

32DMX Yes No Yes Yes
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Step 4 To modify the band parameters, click C-Band or L-Band in the Project Explorer for the desired site 
interface. In the Properties pane, enter the desired Output power.

Step 5 To modify amplifier parameters, click C-Band Amplifiers or L-Band Amplifiers in the Project 
Explorer for the desired site interface. Choosing a value other than Auto will force a setting on the unit. 
For more information, see the “1.6 Auto, Forced, and Locked Parameters” section on page 1-11.

a. In the Properties pane From Fibre area, complete the following as needed:

• PRE—Choose the desired preamplifier from the drop-down list (None, Auto, 
OPT-PRE [C-band], OPT-AMP-C [C-band], or OPT-AMP-L [L-band]).

Line+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Hub WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Terminal Add/Drop OADM

(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

ROADM WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Terminal+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Multi- 
Degree

OXC PP MESH-4 Add: 32-WSS

Drop: 32-DMX Yes No No No

Add: 40-MUX-C

Drop: 40-MUX-C Yes No No No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No No No

PP MESH-8 Add: 32-WSS

Drop: 32-DMX Yes No No No

Add: 40-MUX-C

Drop: 40-MUX-C Yes No No No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No No No

OIC — Add: 32-WSS

Drop: 32-DMX Yes No Yes No

Add: 40-WSS-C

Drop: 40-DMX-C Yes No Yes No

Table 2-24 Site Design Rules (continued)

Structure Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz
2-97
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Editing a Project
• DCU 1/2—Choose the desired DCU from the drop-down lists.

• Attenuator—Choose the desired attenuator from the drop-down list.

• Output power—Enter the desired output power.

• Tilt—Enter the desired tilt value.

• Attenuator—Choose the attenuator from the drop-down list.

b. In the Properties pane To Fibre area, complete the following as needed:

• BST—Choose the desired booster from the drop-down list (None, Auto, OPT-BST [C-band], 
OPT-BST-E [C-band], OPT-AMP-L [L-band], or OPT-BST-L [L-band]).

• DCU 1/2—Choose the desired DCU from the drop-down lists.

• Output power—Enter the desired output power.

• Tilt—Enter the desired tilt value.

c. In the Properties pane General area, choose the OSC from the drop-down list (OSC-CSM or 
OSCM).

Step 6 To modify OADM parameters, click Add/Drop in the Project Explorer for the desired site interface. In 
the Properties pane, complete the following as needed:

• In the Line/OADM area, choose the desired attenuator from the drop-down list.

• In the Mux/Demux WSS area, complete the following as needed:

– Patch Panel—Choose the patch panel from the drop-down list.

– Demux—Choose the demultiplexer from the drop-down list (Auto, 32DMX-O, or 32-DMX).

2.6.4 Editing Service Demand Association and Traffic Subnet
Use this procedure to change the association of a service demand from one traffic subnet to another. You 
can change the association if the destination subnetwork satisfies all of the add/drop requirements of the 
service demand.

You can edit a traffic subnet only in the Design mode; in Install and Upgrade mode, this feature is not 
supported. 

Step 1 In the Project Explorer Pane, right-click Traffic Subnets and choose View Demand Relationship from 
the shortcut menu. The Select Subnet dialog box appears (see Figure 2-52).

Step 2 Expand the Traffic Subnet folder to view the service demands associated with it. 

Step 3 Click the Move to Subnet row to see the list of destination traffic subnets where this service demand 
can be moved to. The list will only contain those Traffic Subnets that can satisfy the add/drop needs of 
this service demand.

Note Cisco TransportPlanner will check to see if each user-forced demand can be met at the destination traffic 
subnet. In case the check fails, a message shall be displayed asking the user to confirm if this operation 
should be continued. Click Yes to continue. All the unfeasible properties within each demands will be 
reset to the default value.

Step 4 Select the desired destination traffic subnet and click Ok.
2-98
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Editing a Project
Step 5 To edit a defined traffic subnet, right-click Traffic Subnets in the Project Explorer pane and choose 
Edit. The Traffic Subnet Builder dialog box shown in Figure 2-52 appears. 

Step 6 From the Selected Ducts area, click the ducts you want to include the new the new traffic subnet and 
click OK. The selected ducts are added in the Choose Ducts area.

Step 7 Click OK. The properties of the original traffic subnet are updated with the selected options.

Note Later, when analyzing the network, if the tool discovers that the order of the add/drop sites in the 
destination traffic subnet has been modified, the analyzer will mark these traffic demands as invalid and 
will not proceed with the analysis. 

Figure 2-52 Select Subnet Dialog Box

2.6.5 Creating a Maintenance Center
Use the following procedure to add maintenance centers that will supply your network with spare parts 
in the event of a failure. This feature helps your customer determine the quantity of spares that should 
be purchased, depending on the number of maintenance centers and their availability. Maintenance 
centers appear in the Maintenance Center folder under a site in the Project Explorer.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Scroll down the Project Explorer, right-click the Maintenance Center folder, and choose New 
Maintenance Center from the shortcut menu. 

Step 3 Highlight the new maintenance center in the Project Explorer.

Step 4 In the Properties pane, complete the following as needed:

• Confidence Level—Choose the percentage that represents the required confidence level for finding 
needed spare parts in the maintenance center: 50, 75, 95, or 99 percent. 

• Restocking time (days)—Enter the time (including transportation) required to restock the part in the 
maintenance center.
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Step 5 To associate a maintenance center with a site, see the “2.6.3 Editing Site Parameters” section on 
page 2-92.

2.6.6 Editing a Point-to-Point Demand
Use the following procedure to edit a point-to-point demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the point-to-point demand and choose Edit from the shortcut menu. 
The Edit Point to Point Demand dialog box appears (Figure 2-53). 

Figure 2-53 Edit Point to Point Demand Dialog Box

Step 3 To modify the information for each channel, complete the following as needed:

• Forecast—Check to change a present channel to a forecast channels. 

• Srv. Type—Choose the desired service type from the drop-down list. Changing the service type for 
one channel automatically changes the service type for all channels.

• Protection—Choose the desired protection type from the drop-down list. Changing the protection 
type for one channel automatically changes the protection for all channels.

• Path—Choose W (west-to-east) or E (east-to-west) from the drop-down list.

• Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco TransportPlanner assigns wavelength to the channels with the lowest possible cost given the 
other constraints.

• Optical Bypass—Choose the site for optical bypass from the drop-down list.

• WDM Intf. Type—Choose the desired card interface type from the drop-down list. 

• WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the card interface type that is selected. Changing the card type for one channel 
automatically changes the card type for all channels.

• Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type that is selected.

• Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type that is selected.

Step 4 To add a new channel, click the Create a new circuit icon on the right of the Edit Point to Point Demand 
dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for the new channel.
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Step 5 To delete an existing channel, select the row and click the Remove the selected circuit icon on the right 
of the Edit Point to Point Demand dialog box.

Step 6 Click Ok to save the changes to the channels and close the Edit Point to Point Demand dialog box, or Cancel 
to close the dialog box without saving the changes. 

2.6.7 Editing a P-Ring Demand
Use the following procedure to change the distribution of services in a P-ring service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the P-ring demand and choose Edit from the shortcut menu. The Edit 
P-Ring Demand dialog box appears (Figure 2-54). 

Figure 2-54 Edit P-Ring Demand Dialog Box

Step 3 Complete the following as needed in the Edit P-Ring Demand dialog box to modify the P-ring:

• Service Type—Choose the desired service type from the drop-down list. 

• WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the service type selected. 

• WDM Interface—Choose the desired card interface type from the drop-down list. The available 
options depend on the card type selected.

In the Circuits area of the Edit P-Ring Demand dialog box, complete the following as needed:

• Ring—(Display only) Displays the name of the P-ring.

• Forecast—Check to change the present channels to forecast channels. 

• Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco TransportPlanner assigns wavelengths to the channels with the lowest possible cost given the 
other constraints.

In the Sections area of the Edit P-Ring Demand dialog box, complete the following as needed:
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• Src—(Display only) Displays the source site name for a section.

• Dst—(Display only) Displays the destination site name for a section.

• Opt. Bypass—Choose the sites from the drop-down list where the channels for the current demand 
will be optically dropped. Only the sites between the source and destination sites along the path of 
this section are available as options. 

• Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type selected.

• Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type selected.

Step 4 To add a new P-ring channel, click the Create a new P-Ring circuit icon on the left of the Edit Point to 
Point Demand dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for 
the new P-Ring.

Step 5 To delete an existing channel from the P-ring, select the row and click the Remove the selected P-Ring 
circuit icon on the left of the Edit P-Ring Demand dialog box.

Step 6 Click Ok to save the changes to the channels and close the Edit P-Ring Demand dialog box, or Cancel to 
close the dialog box without saving the changes.

2.6.8 Editing a ROADM Demand
Use the following procedure to change the distribution of services in a ROADM service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Right-click the ROADM traffic group and choose Edit from the shortcut menu. The Edit ROADM 
Demand dialog box appears (Figure 2-55).

Figure 2-55 Edit ROADM Demand Dialog Box

Step 3 Select a traffic pattern type (Hub or Meshed) from the drop-down list. If you select Hub, the First Site 
drop-down button becomes available. If you selected Meshed, go to Step 5.
2-102
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Editing a Project
Step 4 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 5 Select a connectivity type from the Connectivity type drop-down list. The choices are Protected, 
Unprotected Minimum Hop, Unprotected Optimum Path, and Unprotected Subnet. Refer to the 
“1.5.3 ROADM Traffic Demands” section on page 1-9 for more information about the connectivity type 
choices. 

Step 6 In the Service types pane, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the right pane.

Step 7 To further refine the client interfaces, complete the following options for each row in the right pane. 
Check boxes in gray are not available for the client interface selection.

• Yes/No—Check to select this card to implement the service type.

• Client Interface—Displays the card type for the selected service type.

• Y-Cable—Check to select Y-cable protection if the connectivity type is Protected.

• 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

• Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

• Supported Service—Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco TransportPlanner checks the best client interface to support each service. 

Step 8 Click Ok to save the changes to the demand.

2.6.9 Editing an Ethernet Aggregated Demand
Use the following procedure to edit Ethernet aggregated demand.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the Ethernet aggregated demand and choose Edit demand from the 
shortcut menu. The Ethernet Aggregated Demand dialog box appears (Figure 2-56).
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Figure 2-56 Ethernet Aggregated Demand Dialog Box

Step 3 Click Create a New Circuit icon on the toolbar to add a new circuit to the existing WDM transport 
channel. The New Request dialog box appears (see Figure 2-57).

Step 4 If a circuit already exists, to make a copy of it, right-click the circuit and click Copy Circuit. A new 
circuit will appear as a WDM traffic channel with the same parameters as the original circuit.

Step 5 To delete a circuit, right click the circuit and click Delete Circuit.
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Figure 2-57 Adding Circuit to a WDM Transport Channel

Step 6 To modify the parameters of an existing circuit, double click the circuit. The Edit Request dialog box 
appears (see Figure 2-58).

Figure 2-58 Edit Request Dialog Box for an Ethernet WDM Transport Channel 

Step 7 Change the following as needed in the Edit Request dialog box:

• The label for the circuit
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• P/F flag as desired

• Path Forcing—Allows you to force the circuit routing on the traffic subnet associated with this 
demand. The following values are supported:

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path. 

– Side <x> where Side <x> —Represents the label of side on the Src Site where the circuit is 
routed.

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Circuit rate—Displays the allowed circuit rates.

• Src Site—Allowed values include the list of sites added in the WDM traffic channel. You can set it 
to Auto for the tool to select an appropriate value.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.

• Card Type—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select a 
appropriate card type based on other constraints

• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Portp Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select 
an appropriate value.

• Dest Site—Allowed values include the list of sites added in the WDM Traffic channel. You can set 
it to Auto for the tool to select an appropriate value.

• Card type—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an 
appropriate card type based on other constraints.

• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate Port 
number based on other constraints.

• SFP Lambda—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select 
an appropriate value.

Step 8 Click Ok to complete and to return to the New Request dialog box.

Step 9 Enter the number of circuits to be created in Quantity area.

Step 10 In the General area, enter the following:

• Label—Enter the label for the circuit. By default, VLAN_Circuit_x will be used.

• P/F flag—Check this box if this demand will be needed in the future; uncheck this box if this 
demand is needed now. This parameter will drive the list of pluggable port modules to be equipped 
on the card and will affect BoM reports.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Circuit rate—Displays the allowed circuit rates.

• Path Forcing—This option allows you to force the circuit routing on the traffic subnet associated 
with this demand. The following values are supported:

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path. 

– Side <x> where Side <x> —Represents the label of side on the Src Site where the circuit is 
routed.

Step 11 In the Src area, complete the following:
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• Site—Select the source site. Allowed values include the list of sites added in the WDM traffic 
channel.

• Card—Select the Card. Allowed values are Auto, 10GE-XP or GE-XP. Auto allows the tool to select 
an appropriate card type based on other constraints.

• Port Num—Select the port number. Allowed values Auto, 1, and 2. Auto allows the tool to select an 
appropriate port number based on other constraints.

• Port CIR—Select the CIR, with 1 being the max and 0.1 being the lowest.

• Port Rate-Reach—Select the desired PPM for this port, or set it to Auto to allow the tool to select 
an appropriate value.

Step 12 Under Dest area complete the following:

• Dest Site—Select the destination site. Allowed values include the list of sites added in the WDM 
traffic channel. 

• Port Num—Allowed values Auto are 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Card—Allowed values, Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an appropriate 
card type based on other constraints.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.

• Port Rate-Reach—Select the desired SFP/XFP for this port, or set it to Auto to allow the tool to 
select an appropriate value.

Step 13 Click Ok to complete the creation of the circuit.

Step 14 Click the Check tab on the left corner of the window to generate a report showing the circuit path in the 
WDM traffic channel and to check any over-allocation of bandwidth (see Figure 2-59). The report shows, 
in a row, each of the site on the subnet, and each span in between.

Figure 2-59 Circuit Path View in a Ethernet Aggregated Demand
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Step 15 You can add as many circuits as the available bandwidth of the WDM Transport channel allows. When 
you are finished, click Close.

2.6.10 Editing a TDM Aggregated Demand
Use the following steps to edit a TDM aggregated demand.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the TDM aggregated demand and choose Edit demand from the 
shortcut menu. The TDM Aggregated Demand dialog box appears (Figure 2-32).

Step 3 On the Traffic tab, click the create a new circuit icon. The New Request dialog box appears (see 
Figure 2-61).

Step 4 If a circuit already exists, make a copy of it by right-clicking the circuit and clicking Copy Circuit. A 
new circuit will appear under WDM Traffic channel with the same parameters as the original circuit.

Step 5 To delete a circuit, right-click the circuit and click Delete Circuit.

Step 6 To modify the parameters of an existing circuit, double-click the circuit. The Edit request dialog box 
appears (see Figure 2-60).

Figure 2-60 Edit Request in a TDM WDM Transport Channel

Step 7 Change the following as needed in the Edit Request dialog box:

• The label for the circuit
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• P/F flag as desired

• Path Forcing—This option forces the circuit routing on the traffic subnet associated to the 
aggregated demand. The following values are supported:

• Trunk Protection—Allowed values are Unprotected, UPSR.

• Client Protection—Allowed values are Unprotected, 1+1 APS.

• Circuit rate—Allowed values are STS1, STS3c, STS6c, STS9c, STS12c, STS18c, STS24c, STS36c, 
STS48c, and GE-STS24.

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path.

– Side <x> —Where Side <x> represents the label of side on the source site where the circuit is 
routed.

• Site—Allowed values include the list of sites added in the WDM Traffic channel. You can set it to 
Auto for the tool to select an appropriate value.

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card—Allowed values are Auto, 10GE-XP, or GE-XP. Auto allows the tool to select an appropriate 
card type based on other constraints.

• Port Num—Allowed values are Auto, 1, and 2. Auto allows the tool to select an appropriate port 
number based on other constraints.

• Port CIR—This is the committed information rate, with 1 being the max and 0.1 being the lowest.

• Dest Site—Allowed values include the list of sites added in the WDM traffic channel. You can set 
it to Auto for the tool to select an appropriate value.

• Port Rate-Reach—Select the desired SFP/XFP for this port or set it to Auto to allow the tool to select 
an appropriate value.

• Card—Allowed values are Auto and ADM. Auto allows the tool to select an appropriate card type 
based on other constraints.

• Port Num—Allowed values are Auto, 1, and 2and. Auto allows the tool to select an appropriate port 
number based on other constraints.

Step 8 Click Ok to complete the creation of the circuit and return to the New request dialog box.

Step 9 Enter the number of circuits to be created in the Quantity area.
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Figure 2-61 TDM Point to point Circuit Creation in a WDM transport channel 

Step 10 In the General area, complete the following:

• Select the label for the circuit. By default, VLAN_Circuit1 will be used.

• P/F flag—Check this box if this demand will be needed in the future; uncheck this box if this 
demand is needed now. This parameter will drive the list of pluggable port modules to be equipped 
on the card and will affect BoM reports.

• Client Protection—Allowed values are Unprotected and 1+1 APS.

• Trunk Protection—Allowed values are Unprotected and UPSR.

• Circuit rate—Allowed values are STS1, STS3c, STS6c, STS9c, STS12c, STS18c, STS24c, STS36c, 
STS48c, and GE-STS24.

• Path Forcing—This option forces the circuit routing on the traffic subnet associated to this 
aggregated demand. The following values are supported: 

– Auto—This is the default value. When set to this, the tool automatically defines the trunk path.

– Side <x>—Where Side <x> represents the label of side on the source site where the circuit is 
routed.

Step 11 In the Src area, complete the following:

• Site—Select the source site. Allowed values include the list of sites added in the WDM traffic 
channel.

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card—Select the card. Allowed values are Auto and ADM. Auto allows the tool to select an 
appropriate card type based on other constraints.
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• Port Num—Select the port number. Allowed values are Auto, 1, and 2. Auto allows the tool to select 
an appropriate port number based on other constraints.

Step 12 In the Dest area, complete the following:

• Site—Select the destination site. Allowed values include the list of sites added in the WDM traffic 
channel. 

• Port Rate-Reach—Select the desired PPM for this port or set it to Auto to allow the tool to select an 
appropriate value.

• Card type—Allowed values are Auto and ADM. Auto allows the tool to select an appropriate card 
type based on other constraints.

• Port Num—Allowed values Auto and 1 through 16. Auto allows the tool to select an appropriate port 
number based on other constraints.

Step 13 Click OK to complete the creation of Circuit. On the Traffic tab, you can see the created circuit 
(Figure 2-62). 

Figure 2-62 TDM Circuit in a TDM Aggr Demand

Step 14 Click the Check tab on the left corner of the window to generate a report showing the circuit path in the 
WDM traffic channel and to check any over-allocation of bandwidth (see Figure 2-63). The report shows, 
in a row, each of the site on the subnet, and each span in between.

Step 15 You can add as many TDM circuits as the bandwidth of the WDM transport channel allows. After you 
complete adding circuits, Close.
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Figure 2-63 TDM Aggr Demand Window, Report Tab

2.6.11 Deleting a Fiber Span
Use the following procedure to delete a fiber span from the network design:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the duct that you want to delete and choose Delete from the shortcut 
menu. As an alternative, you can click Delete in the Tasks Pane.

Step 3 Click Yes to confirm the fiber deletion.

2.6.12 Deleting a Network
To delete a network from a project, in the Network Mgmt Tree tab click the network and choose Delete 
from the Tasks Pane. You cannot delete a network if it is the only network in a project.

2.6.13 Deleting Notes
Use the following procedure to delete a note from any item in the Project Explorer:

Step 1 Double-click the Notes folder.
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Step 2 In the Notes window, click Go in the Action column for the note that you want to delete. The item is 
highlighted in the Project Explorer. 

Step 3 Right-click the item in the Project Explorer and choose Delete Note from the shortcut menu.

2.6.14 Deleting Sites 
Use the following procedure to delete sites from a network. You can delete a site if the site is in the 
Unlocked state and does not have a traffic demand set up on it. You can delete sites from a network in 
the Design state only.

Step 1 Verify that the site is in the Unlocked state in the Project Explorer pane. For more information, see the 
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-129.

Step 2 Delete any traffic demands. For more information, see the “2.6.15 Deleting a Traffic Demand” section 
on page 2-113.

Step 3 On the NtView Name tab, click the Site icon and choose Delete from the Tasks Pane. For more 
information about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” 
As an alternative, you can click Delete in the Tasks Pane. A confirmation message appears, asking you 
to confirm the deletion of the site.

Step 4 Click Yes to delete the site. 

2.6.15 Deleting a Traffic Demand
A traffic demand must be in the Unlocked state before you can delete it. Use the following procedure to 
delete a traffic demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Verify that the demand is in the Unlocked state. For more information, see the “2.7.4 Unlocking 
Parameters in the Network Design” section on page 2-129.

Step 3 Right-click the demand that you want to delete in the Project Explorer and choose Delete from the 
shortcut menu. As an alternative, you can click Delete in the Tasks Pane.

2.6.16 Deleting a Traffic Subnet
Use the following procedure to delete a created traffic subnet. The Traffic Subnet ALL cannot be deleted. 

Step 1 In the Project Explorer, click the Net > Traffic Subnets folder to expand it. 

Step 2 Right-click the traffic subnet to be deleted and select Delete to delete the subnet. 
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Step 3 If the traffic subnet being deleted is associated with demands, a dialog box will appear listing all the 
demands associated with this subnet. These associations will be removed and the demands will be moved 
to the Traffic Subnet ALL demand. Upon confirmation, the traffic subnet will be deleted. 

Note Demands moved under Traffic Subnet All will be marked invalid and the network will not be analyzed, 
until the user associates the demands with either a Ring or Linear subnet. 

2.6.17 Editing Fiber Span, Pair, and Fiber Parameters
Using the Properties pane, you can manage a fiber span, a fiber pair, and individual fibers. A fiber pair 
consists of two different fibers (clockwise and counter-clockwise). Table 2-25 lists the properties that 
you can modify for a fiber span, pair, or fiber.

Use the following procedure to edit fiber span, pair, and fiber parameters:

Step 1 In the Project Explorer, right-click the Fibers folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer tree, click one of the following. The options available for editing in the Properties 
pane change depending on your selection.

• To edit a fiber span, click the duct identifier. 

• To edit a fiber pair, click the fiber pair identifier. 

• To edit an individual fiber, click the fiber identifier. 

Step 3 In the Properties pane, edit the following parameters, as necessary. See Table 2-25 for the properties that 
you can change for a fiber span, fiber pair, or individual fiber.

• Name—Type the desired name for the fiber span, pair, or fiber.

• Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of 
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you 
set the ageing factor, you do not need to set the ageing loss.

Table 2-25 Editable Fiber Properties

Property Fiber Span Fiber Pair Fiber 

Name Yes Yes No

Ageing loss Yes No No

Ageing factor Yes No No

Fiber type Yes Yes No

Fiber length Yes Yes Yes

Length-based loss Yes Yes Yes

Connector loss (per site) Yes Yes Yes

Absolute loss without connectors Yes Yes No

CD factor Yes Yes No

PMD factor Yes Yes No

Loss Yes Yes Yes
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• Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total 
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

• Type—Choose the type of fiber for each span in the network.

• Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave 
unchecked if fiber loss is derived from the span length.

• Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.

• Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

• Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector 
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the 
length. In the Length Based model, this value is calculated automatically.

• CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in 
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is 
defined at 1545.3 nm; L band is defined at 1590.4 nm.

• PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km. 

• Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in 
the network. The fiber loss factor is always entered in dB/km.

Step 4 As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties pane:

• Loss BOL—(Display only) Displays the total loss beginning of life (BOL) calculation. 

Note BOL is also referred to as SOL.

• Loss EOL—(Display only) Displays the total loss EOL calculation.

• CD—(Display only) Displays the total chromatic dispersion.

• PMD—(Display only) Displays the total polarization mode dispersion.

2.6.18 Editing Fiber Spans, Pairs, and Fibers Using the Fibres Dialog Box
The Fibres Dialog lists all fiber spans, pairs, and fibers in the network. Use the following procedure to 
view and edit fiber parameters from the Fibres Dialog box.

Step 1 In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres 
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-64).
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Figure 2-64 Fibres Dialog

Table 2-26 describes the columns on the Fibres Dialog.

Step 2 To edit a fiber span, pair, or fiber, click the desired item in the Fibres Dialog. The Properties pane in the 
right area of the Fibres Dialog displays the properties for the selected item.

Table 2-26 Fibres Dialog Columns

Column Description

Name Displays the name of the fiber span (Duct), pair (Couple), or fiber. Click the plus (+) 
sign by a Duct name to expand the list and show the Couple names. Click the plus 
(+) sign by a Couple name to expand the list and show the individual fiber names.

Src. Displays the name of the source site or interface for the fiber span, pair, or fiber.

Dst. Displays the name of the destination site or interface for the fiber span, pair, or fiber.

Type Displays the type of fiber for each span in the network.

Length Displays the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

Loss SOL Displays the total loss SOL calculation.

Loss EOL Displays the total loss EOL calculation.

CD C-Band Displays the total chromatic dispersion for the C-band.

CD L-Band Displays the total chromatic dispersion for the L-band.

PMD Displays the total polarization mode dispersion (PMD).

QD C-Band Displays the secondary order dispersion for C-band.

QD L-Band Displays the secondary order dispersion for L-band.

RD Displays the random dispersion value.
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Step 3 In the Properties pane, edit the following parameters, as necessary. See Table 2-25 for the properties that 
you can change for a fiber span, fiber pair, or individual fiber.

• Name—Type the desired name for the fiber span, pair, or fiber.

• Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of 
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you 
set the ageing factor, you do not need to set the ageing loss.

• Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total 
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

• Type—Choose the type of fiber for each span in the network.

• Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

• Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave 
unchecked if fiber loss is derived from the span length.

• Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.

• Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

• Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector 
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the 
length. In the Length Based model, this value is calculated automatically.

• CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in 
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is 
defined at 1545.3 nm; L band is defined at 1590.4 nm.

• PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km. 

• Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in 
the network. The fiber loss factor is always entered in dB/km.

Cisco TransportPlanner updates the Fibres Dialog box with the new value.

Step 4 As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties pane:

• Loss BOL—(Display only) Displays the total loss BOL calculation. 

Note BOL is also referred to as SOL.

• Loss EOL—(Display only) Displays the total loss EOL calculation.

• CD—(Display only) Displays the total chromatic dispersion.

• PMD—(Display only) Displays the total polarization mode dispersion.

Step 5 Click OK.
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2.6.19 Modifying Site Structure, Functionality, and Type
You can edit a site after you have created it using the Network Creation Wizard. To create a site, see the 
“2.3 Creating a Project” section on page 2-36. The following properties of a site can be modified:

• Site Structure

• Functionality

• Type 

To edit the properties of a site:

Step 1 In the Project Explorer tree, click the Sites folder. The list of sites included in the network appears 
(Figure 2-65).

Figure 2-65 Sites List

Step 2 Right-click the site you want to have the properties modified and select Edit. The Edit dialog box 
appears (Figure 2-66).

Figure 2-66 Sites Edit Dialog
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Step 3 Select the new Structure, C-Band rules, and L-Band rules from General, C-Band Odd, and L-Band Odd 
groups respectively. For details on site design rules, see Table 2-24 on page 2-96. 

Step 4 Select the lock/unlock rules on the right side of the Edit dialog. For details on site modification unlock 
instances/parameters, see Table 2-28 on page 2-119. 

Step 5 Click Apply. The selected changes are applied to the site. 

Step 6 Click OK to save the changes and exit the Edit dialog box.

Note When you modify a site, Cisco TransportPlanner does not allow you to decrease the number of node 
sites. For example, it would not be possible to change a Multi-degree site (created using the Network 
Creation Wizard) to a Line+ site; but, a Line site can be changed to a Multi-Degree. 

Table 2-27 shows the structure modifications that you can make using Cisco TransportPlanner.

When you modify the properties of a site, Cisco TransportPlanner checks the compatibility between the 
original site properties and the new configurations that you make on each site. It also checks for 
consistency in the add/drop section and/or in the amplifier/DCU section and displays a warning message 
in case of inconsistency. Cisco TransportPlanner then unlocks the related unit instances and/or 
parameters for you to make modifications. If the units were forced, Cisco TransportPlanner removes the 
forcing to perform the required modifications.

If the starting instances/parameters are consistent, even if not optimal for the ending configuration, Cisco 
TransportPlanner will warn the user about possible sub-optimization, but the related unit/parameter will 
be kept Locked (with its Layout property).

Site modifications that require unlocking of some instances/parameters are provided in Table 2-28.

Table 2-27 Permitted Structure Modifications

Starting Structure Ending Structure

Terminal or Terminal+ Line, Line+, Multi-Degree

Line or Line+ Multi-Degree

Table 2-28 Site Modification Unlock Instances/Parameters

Starting Configuration Ending Configuration Mandatory Unlock Suggested Unlock

Line, PT Line, OLA All amplifiers/DCU 
section

-

Line, OSC-site Line, OLA All amplifiers cards. -

Line, OLA Line, A/D None. All amplifier cards

Line, OLA Line, ROADM None. All amplifier cards

Line, A/D, OADM-xc Line, ROADM All OADM-xc cards. All amplifier cards

Line, HUB, WSS Line, ROADM None. All amplifier cards

Term, ROADM, WSS Line, ROADM, WSS None. All amplifier cards

Term, ROADM, WSS Multi-degree, WSS 32-DMX-O (if present) All amplifier cards
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2.6.20 Adjusting Site Layout
In the Layout View of a design, Cisco TransportPlanner allows you to move a selected card from its 
starting position to another destination slot position. Site layout adjustments can only be done on a 
network that has been analyzed and is any administrative state (Design, Upgrade, or Installation). You 
can move both present and forecast cards. 

Use the following procedure to move a card to a new position:

Step 1 Right-click on the site for which you want to move the cards in the rack and choose Layout. (See 
Figure 2-67). The Details dialog box appears (See Figure 2-68).

Figure 2-67 Selecting the Layout View

Line, ROADM, WSS Multi-degree, WXC, 
PP-MESH-4

32-DMX-O (if present) WSS cards, 40-MUX-C 
is the default; all 
amplifier cards

Line, ROADM, WSS Multi-degree, WXC, 
PP-MESH-8 

32-DMX-O (if present), 
AMP-17 cards (if 
present) 

WSS units (40-MUX-C 
is the default), all 
amplifier cards

Table 2-28 Site Modification Unlock Instances/Parameters

Starting Configuration Ending Configuration Mandatory Unlock Suggested Unlock
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Figure 2-68 Details Dialog Box

Step 2 Choose Draw Mode and then click the card and move it to the desired slot in the shelf. 

Step 3 Click Confirm All to confirm the changes made. When you confirm all site adjustments, 
Cisco TransportPlanner automatically unlocks both the source and destination slot positions.

Note The destination slot position must be within an existing shelf on the existing rack. A destination slot can be 
any empty slot or any other slot containing a client/OTS card. It cannot be a slot the user has already defined 
as destination for another position change (in the current layout adjustment session). 

Table 2-29 lists the allowed site layout adjustments.

Table 2-29 Allowed Site Layout Movements

From/To OTS

Unprotected
Fiber 
Switched 
TXP-MXP

Unprotected 
LC

1+1
TXP-MXP

1+1
LC

Y cable 
TXP-MXP

OTS Yes1 No No Yes No No

Unpr./Fiber 
Switched 
TXP-MXP

Yes No No Yes No No

Unprotected 
LC

No No Yes No No for 
different 
shelves; Yes 
for same 
shelf

No
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2.6.21 Exporting the Fiber Spans, Pairs, and Fibers in a Network
Use the following procedure to export all spans, pairs, and single fibers in a network in XLS format:

Step 1 In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres 
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-64).

Step 2 Click Export. The Fibres Export dialog box appears.

Step 3 Navigate to the desired directory, type the XLS filename, and click Save.

2.6.22 Arranging Sites
Sites can be arranged into four different configurations. Use the following procedure to arrange the sites 
into a configuration or to move all of the sites so that they appear in the Cisco TransportPlanner window:

Step 1 Click the NtView Name tab.

Step 2 Click the Arrange Sites drop-down list, and choose one of the following:

1+1 
TXP-MXP

Yes No No Yes No No

1+1 LC No No Yes No Yes No

Y cable 
TXP-MXP

Yes No No Yes No Yes

1. For all site movements marked as ‘Yes,’ Cisco TransportPlanner will create a reverse link. For example, when a Y cable TXP 
is moved to an OTS card, a reverse link, that is, a link between the OTS card and the Y cable TXP will be created 
automatically. 

You need to ensure that the following conditions are met when doing layout adjustments: 

• A pair of TXP/MXP cards that are a part of a Y-cable protection group must stay within the same 
shelf.

• A pair of ADM-10G cards that are a part of the same ADM peer group must stay within the same 
shelf.

• A pair of line cards that are a part of a protection group must stay within the same shelf.

• A pair of line cards in a site that are a part of a P-ring circuit must stay within the same shelf.

Note For any other kind of forced position, Cisco TransportPlanner will not prevent you from forcing 
any destination position even if they do not match some layout recommended constraints (for 
example, OSMINE or TXP/MXP 1+1 Client protection). 

Table 2-29 Allowed Site Layout Movements

From/To OTS

Unprotected
Fiber 
Switched 
TXP-MXP

Unprotected 
LC

1+1
TXP-MXP

1+1
LC

Y cable 
TXP-MXP
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Note All shapes are approximations.

• Fit to visible rectangle view—Zooms to display all sites in the NtView Name tab.

• Arrange to an ellipse—Rearranges all sites in an ellipse form (Figure 2-69).

Figure 2-69 Ellipse Shape

• Arrange to a square—Rearranges all sites in a square form so that the sites appear clockwise around 
the square (Figure 2-70). To complete a full square, this arrangement requires at least four sites.
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Figure 2-70 Square Shape

• Arrange to a snake—Rearranges all sites so that they cross the NtView Name tab from right to left 
and then left to right in a serpentine, linear format (Figure 2-71).

Figure 2-71 Snake Shape
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• Arrange to a double ring—Rearranges the sites into a dual ring format (Figure 2-72).

Figure 2-72 Double Ring Shape

• Arrange to Fit to Maximum Rectangle View—Arranges sites in proportion, using all network map 
area (Figure 2-73). 
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Figure 2-73 Fit to Maximum Rectangle View Shape

2.7 Managing the Network Design
After creating and analyzing a network design, you must prepare the design for installation at a customer 
site. After a network has been installed, you can reanalyze to correct any problems.

Network designs have several possible states:

• Design—The initial state for any new network design. You can add, delete, or change any aspect of 
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back 
into the Design state to modify it by choosing Design in the Tasks Pane.

• Design-Analyzed—The state of the network design after you run the network analyzer. All reports 
are available and updated. You cannot change any aspect of the network design. You can modify the 
BoM, such as changing global discounts and spare parts. You can return to the Design state after 
analyzing the network by choosing Design in the Tasks Pane.

• Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for 
testing different design options. You can copy a network before or after analyzing it. A copied 
network inherits the set of project options defined in the original network. For more information, 
see the “2.7.1 Creating a Copy of the Network” section on page 2-127.

• Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.). 
When a network is installed in the field, you can move the network into the Install state so that you 
can enter and check the real fiber parameter values. You can create an Install network from a network 
in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits the set of 
project options defined in the analyzed network. All sites in an Install network are locked. You 
cannot modify any aspect of the network design except the span parameters and (on unlocked sites) 
amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be changed 
while in this state. For more information, see the “2.7.2 Creating a Network in the Install State” 
section on page 2-127.
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• Install-Analyzed—The state of the Install network design after you run the network analyzer. All 
reports are available and updated. Cisco TransportPlanner locks all sites, spans, demands, and 
equipment when a network is in the Install-Analyzed state. 

• Upgrade—During network design, you define a number of the channels to be implemented at the 
present time and a number of channels to be implemented in the future (forecast). After installing 
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade 
network and then select the forecast or traffic demand services that you want to implement. You can 
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You 
can unlock specified parameters to alter the design to include forecasted channels and traffic 
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed 
network. For more information, see the “2.7.3 Creating an Upgrade Network” section on 
page 2-128.

• Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer. 
All reports are available and updated. Cisco TransportPlanner locks all sites, spans, demands, and 
equipment when a network is in the Upgrade state. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-15 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-15.

2.7.1 Creating a Copy of the Network
To create a copy of a network in any state, right-click the network and choose Copy from the shortcut 
menu. A new copy appears in the Network Mgmt Tree tab.

2.7.2 Creating a Network in the Install State
Use the following procedure to create a network in the Install state:

Step 1 If the network is not analyzed, complete the “2.4 Analyzing the Network” section on page 2-62.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the network and choose Install from the shortcut menu. A new network appears in the 
Networks Mgmt Tree in the Install state. All results from the analyzed network are imported into the 
Install network and are placed in the Locked mode.

Step 4 Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber 
loss value, fiber CD, fiber PMD, and fiber length. See the “2.6.17 Editing Fiber Span, Pair, and Fiber 
Parameters” section on page 2-114. Cisco TransportPlanner also allows you to unlock site parameters 
for modification. To change site parameters, see the “2.6.3 Editing Site Parameters” section on 
page 2-92.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
TransportPlanner Analyzer status window appears to indicate the progress. As an alternative, click 
Analyze in the Tasks Pane. The Cisco TransportPlanner analysis status bar indicates when the network 
analysis is complete. The network now appears in the Install-Analyzed state.
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Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem. Warning and error messages help you identify problems with your current design. For 
a list of all system messages, see Appendix C, “System Messages.”

Step 6 When you have analyzed the network and are satisfied with the results, import the new generated 
installation parameters to each site of the network. For more information, see the “2.5.2 Saving the NE 
Update File” section on page 2-65. 

2.7.3 Creating an Upgrade Network
In an Upgrade network, you can perform the following tasks:

• Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and 
aging).

• Add or delete traffic.

• Convert forecasted traffic to present traffic.

• Convert ROADM traffic to present traffic.

• Modify the type of a node.

• Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules, 
OADM cards, and DCU modules).

In an Upgrade network, you can force certain installation parameters:

• Amplifier per-channel output power setpoint

• Amplifier output tilt setpoint

• OADM card aggregate output power setpoint

• Full multiplexer/demultiplexer or ROADM output power setpoint

You cannot change the following parameters when in Upgrade state:

• Node input channel fail threshold

• Node OSC channel fail threshold

• Preamplifier input power threshold

• OADM card aggregate input power setpoint

• Full muxponder/demuxponder or ROADM input power setpoint

• Channels drop power

When upgrading a network that has a point-to-point demand, you can:

• Move Future circuits to become Present. This can be done without unlocking the circuit.

• Open a optical-bypass channel. This can be done without unlocking the circuit.

• Add new, present, or future point-to-point services to the existing demand.

• Delete any present or future channel originally defined in the baseline network.
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• Change any unlocked point-to-point circuit or unlocked point-to-point service demand parameter.

When upgrading a network that has a any-to-any demand, you can:

• Move any of the Any-to-Any (future) services to the Present. This can be done without unlocking 
the circuit.

• Create a new Any-to-Any demand on an already existing Any-to-Any group.

• Create a new Any-to-Any group.

• Delete an existing Any-to-Any demand from an Any-to-Any group.

• Delete an Any-to-Any Group with all its Any-to-Any demand.

Note Any-to-Any services that have been moved to Present will be represented as Point-to-Point services.

Use the following procedure to put a network in the Upgrade state:

Step 1 If the network is not analyzed, complete the “2.4 Analyzing the Network” section on page 2-62.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network 
appears in the Networks Mgmt Tree tab. All results from the analyzed network are imported into the 
Upgrade network. 

Step 4 Make the necessary changes to the Upgrade network. For more information, see the “2.6.17 Editing 
Fiber Span, Pair, and Fiber Parameters” section on page 2-114 and the “2.6.3 Editing Site Parameters” 
section on page 2-92.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco TransportPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
TransportPlanner Analyzer status window appears to indicate the progress. As an alternative, click 
Analyze in the Tasks Pane in any view. The Cisco TransportPlanner analysis status bar indicates when 
the network analysis is complete. The network now appears in the Upgrade-Analyzed state.

Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem. Warning and error messages help you identify problems with your current design. For 
a list of all system messages, see Appendix C, “System Messages.”

2.7.4 Unlocking Parameters in the Network Design
The Locked state occurs when you did not set (force) any value for a parameter and instead chose Auto. 
During network analysis, Cisco TransportPlanner assigns a value for each parameter set with Auto and 
puts them in the Locked state. The Locked state indicates that the next time the network is analyzed, the 
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers, 
boosters, add/drop filters, and DCU cards required by the site/network as a result of running the analyzer 
previously. Locked elements are indicated by a closed padlock icon in the Project Explorer 
(Figure 2-74). For more information on the Auto, forced, and locked states, see the “1.6 Auto, Forced, 
and Locked Parameters” section on page 1-11.
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Figure 2-74 Locked Sites in the Project Explorer View

To unlock network components to edit parameters, right-click the desired element in the Project Explorer 
and choose Unlock from the shortcut menu.

2.7.5 Creating a JPEG of the Network Design
Use the following procedure to create a snapshot of your network design in JPEG format:

Step 1 Click the NtView Name tab.

Step 2 Complete the “2.6.22 Arranging Sites” section on page 2-122 as necessary so that the sites in the 
network appear in the tab in the desired arrangement.

Step 3 Click the Save network view image icon in the toolbar. 

Step 4 In the Save network view image dialog box, navigate to the desired directory.

Step 5 Enter the file name in the File Name field and click Save.

2.7.6 Upgrading a Release from 7.0 to 8.5
Use the following steps to upgrade a release saved as a Cisco TransportPlanner ONS Software R7.0 
project to release 8.5.

Step 1 From the File menu, click Open to load the saved Cisco TransportPlanner 7.0 project. 

Step 2 Right-click on the network loaded on the Project Explorer and select Release Upgrade. 
Cisco TransportPlanner automatically creates a copy of the initially loaded network and updates the 
system release to ONS Software Release 8.5. The newly created network copy will be moved into the 
Upgrade administrative status. 

Note The tool allows you to manually enter the details of a deployed network even if the 
Cisco TransportPlanner design file is not available. You can perform a release upgrade only on a network 
that has been analyzed. Also, a release upgrade can be performed only on a loaded network that has been 
designed and saved with the current Cisco TransportPlanner release and with the ONS Software Release 
that is the last supported by Cisco TransportPlanner.
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2.8 Generating a BoM 
You can generate a BoM when a network is in the Install or Upgrade state, or after you have successfully 
analyzed your network design. The price database selected during project creation is used to generate 
the BoM.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1 Opening a Project” section on page 2-15 and the “2.1.2 Loading and Unloading Networks” 
section on page 2-15.

2.8.1 Viewing BoM Report Totals
Use the following procedure to view the BoM report totals:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. As an alternative, you can 
access this report by choosing Bill of Materials from the Reports folder in the Project Explorer tree.

The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following 
information:

• BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

• Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

• BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

• Price List—Displays the name of the price list database selected for the project.

• Price List last update—Displays the date that the selected price list was last updated.

• Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Step 3 To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single 
items, check Use MSM bundle. 

Step 4 Check Spare Part Report to include the spare parts in the report totals.

Note You can only check the Spare Part Report check box if the network is in Design mode.

Step 5 The Global discount percentage field shows the percentage from the Global Discount Percentage option 
in the Default Project Options window. To change the global discount for the entire network, check 
Use global discount and enter a new global discount in the form of a percentage in the Global discount 
percentage field. The global discount is applied to all components in the BoM and will overwrite any 
discount specified in the Global Price List.
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2.8.2 Generating a Network BoM
Use the following procedure to generate a BoM for the network:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab (Figure 2-75) appears. The Net View 
subtab is selected by default. Items that are not found appear in yellow in the BOM.

Figure 2-75 Bill of Material Tab, Net View Subtab

Table 2-30 describes the Net view subtab columns. See the “2.8.1 Viewing BoM Report Totals” section 
on page 2-131 for a description of the data, check boxes, and fields at the top of the window. 

Table 2-30 BoM Net View Columns

Column Label Description

Product ID Displays the ordering code used to order the BoM from Cisco.

Description Displays a description of the product.

Quantity Displays the number of specific products in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.3 Generating a Site BoM
A site BoM lists all of the hardware and software parts required for the system to work as designed at a 
given site. Use the following procedure to generate a BoM for a site:

Step 1 Click the NtView Name tab and click the site.

Step 2 In the Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-76). Items 
that do not appear in the price list appear in red.

Figure 2-76 Bill of Material Tab, Site View Subtab

Total price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.

Site # Displays the number of products to be assigned to a particular site. The number 
of Site columns is the same as the number of sites in the network.

Table 2-30 BoM Net View Columns (continued)

Column Label Description
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Table 2-31 describes the Site view subtab columns. See the “2.8.1 Viewing BoM Report Totals” section 
on page 2-131 for a description of the data, check boxes, and fields at the top of the window. 

Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.4 Generating a Spare Parts Report
After you generate the BoM, use the following procedure to determine the spare parts required by the 
network. If the network is in the Upgrade state, the report includes the parts required to support the 
implemented services and the new additional present services. To generate a spare parts report, you must 
associate a site with a maintenance center before network analysis. For more information, see the 
“2.6.3 Editing Site Parameters” section on page 2-92.

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-77). 

Table 2-31 BoM Site View Columns

Column Label Description

Name Displays the site name. Click the plus (+) sign to expand the site and display 
the categories. Click the plus (+) sign to expand each category to view the 
items in the BoM.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of that specific item in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.

Total Price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.
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Figure 2-77 Bill of Material Tab, Spare Subtab

Table 2-32 describes the Spare subtab columns. See the “2.8.1 Viewing BoM Report Totals” section on 
page 2-131 for a description of the data, check boxes, and fields at the top of the window. 

Table 2-32 BoM Spare Subtab Columns

Column Label Description

Name Displays the name of the item at the site. Right-click the maintenance center 
and choose Expand All from the shortcut menu to view all spare parts.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of specific items in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will 
display. This occurs when the price list reports “NaN” (Not a Number) for the 
item because the price list has never been updated. Invalid items appear in the 
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the field displays the default 
value from the Price List database.

Total Price Displays the total price of the parts before applying the discount.

Discounted Total 
Price

Displays the total price of the parts after applying the discount.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.5 Exporting a BoM
Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML, 
or text format:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. 

Step 3 Click Export. The BoM export dialog box appears.

Step 4 In the BoM export dialog box, type the name of the file, choose the file type (.xls and .html) from the 
drop-down list, and navigate to the desired folder. Click Save.

2.9 Managing the Price List
A price list is defined for each project and is used to generate a BoM. Cisco TransportPlanner can 
manage multiple price lists. You can even change a project price list after a project has been established. 
The Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco 
Connection Online (CCO).

Only the selected price value is saved with a project; the actual price database is not saved with the 
project. When opening a saved project (for example, a project received from another designer), the 
associated price database might not be available. If this is the case, Cisco TransportPlanner notifies you 
that the Master Price list will be used. 

To save memory, Cisco TransportPlanner automatically loads only the price list selected for the current 
project. 

2.9.1 Creating a New Price List
Use the following procedure to download a price list from CCO. You can download price lists from CCO 
if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-18.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78).
2-136
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Chapter 2      Designing Networks with Cisco TransportPlanner
Managing the Price List
Figure 2-78 Price Manager Dialog Box

Step 3 In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the 
shortcut menu.

Step 4 In the Create a New Price DB dialog box, enter the price list name. 

Step 5 From the drop-down list, choose the desired CCO price list. 

Step 6 Click OK.

Step 7 Click OK to update from CCO.

Step 8 In the CCO User Name/Password dialog box, type your user name and password, and click OK. 
Cisco TransportPlanner downloads the CCO price list. 

Step 9 When the update is complete, click OK to close the confirmation dialog box. The new price list appears 
in the PriceDBManager tree. 

Step 10 Click Close to close the Price Manager dialog box.

2.9.2 Viewing a Price List
Use the following procedure to view and filter a price list:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137). 
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The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco TransportPlanner 
automatically loads only the price list selected for the current project (unless the user requests 
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a 
price list is currently not loaded in memory and is not available. 

Step 2 To load or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Step 3 Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in 
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left 
corner of the Price Manager dialog box:

• Last update—Indicates the date of the last download from CCO for this price list. If Never appears, 
this indicates that the user created a price list without downloading from CCO.

• Updated by—Identifies the way in which the price list was updated.

The price list displays the following columns:

• Price List ID—For internal use.

• Major Parent ID—Lists the platform.

• Minor Parent ID—Lists the equipment type.

• Product ID—Identifies the ordering code for the specific unit.

• Description—Provides detail about the item.

• Service Category—For future use.

• List Price—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has 
not been updated.

• Major ID—For internal use.

• Minor ID— For internal use.

• Update Status—Identifies how the last update was made to an item:

– None—Indicates that the price list has never been updated.

– local_file—Indicates that the price list has been updated from a local file.

– cco—Indicates that the price list has been updated from CCO.

– user—Indicates that the price list has been manually updated by the user who directly edited the 
price list. The user can modify the Discount field.

• Discount—If a discount applies, identifies the discount percentage. To modify this field, enter the 
new percentage.

Step 4 To search for a specific item in a price list, type the desired item in the Search field at the top of the list. 
As you type, Cisco TransportPlanner filters the list items to match your search entry. To choose Search 
options, click the Search Tool icon to the left of the Search field and choose one of the following:

• Column name—Searches only the specified column for the search string. The All option searches 
all columns.

• Case sensitive—Matches the case of the search string.

• Case insensitive—Disregards the case of the search string.

• Match from start—Searches only for the search string if it appears at the beginning of column text.

• Match any where—Searches for the search string if it appears anywhere in the price list.

Step 5 To sort the items in the price list, click on a column to sort by that column. 
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Step 6 Click Close to close the Price Manager dialog box.

2.9.3 Loading and Unloading Price Lists
To save memory, Cisco TransportPlanner automatically loads only the price list selected for the current 
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a 
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following 
procedure to load or unload price lists in Cisco TransportPlanner:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137).

Step 2 Right-click the price list and choose Load or Unload from the shortcut menu.

2.9.4 Updating a Price List from CCO
Use the following procedure to update a specified price list from CCO or from a local file. You can also 
update all price lists, even the lists that are not currently loaded. You can update a price lists from CCO 
if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-18.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137).

Step 3 Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the 
shortcut menu.

Step 4 Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut 
menu.

Step 5 In the Update from CCO dialog box, choose Update single price list to download data for the specified 
list or Update all price lists to download the latest data for all price lists.

Step 6 In the CCO User Name/Password dialog box, type your user name and password and click OK. 
Cisco TransportPlanner downloads the price list.

Step 7 When the update is complete, click OK to close the confirmation dialog box. 

Step 8 Click Close to close the Price Manager dialog box.
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2.9.5 Copying a Price List
Use the following procedure to create a new price list by copying from an existing one. The new price 
list will have all of the attributes and values of the original price list (such as Updated By, Last Update, 
unit price, discounts, etc.). You can copy a price list if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-18.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137).

Step 3 Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Step 4 Type the name for the new price list and click Ok. The new price list appears in the PriceDBManager 
tree.

Step 5 Click Close to close the Price Manager dialog box.

2.9.6 Deleting a Price List
Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list 
that is in use by a project. You can delete a price list if no projects are currently open. 

Step 1 If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-18.

Step 2 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137).

Step 3 Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Step 4 Click Close to close the Price Manager dialog box.

2.9.7 Viewing Maintenance Contracts
Use the following procedure to view maintenance contracts:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-78 on 
page 2-137).

Step 2 Right-click Maintenance Contracts and choose Expand from the shortcut menu. 

Step 3 Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and 
software parts used by Cisco TransportPlanner. The Contract Category column describes the service 
programs. 

Step 4 Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the 
service contract identifier.

Step 5 Click Close to close the Price Manager dialog box.
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C H A P T E R 3

Modeled Network Examples

This chapter provides examples of typical optical networks you can model using 
Cisco TransportPlanner. 

This chapter contains the following sections:

3.1 Supported Cisco TransportPlanner Topologies, page 3-1

3.2 Bus Topologies, page 3-1

3.3 Hubbed Ring Topology, page 3-2

3.4 Meshed Topology, page 3-3

3.1 Supported Cisco TransportPlanner Topologies
Cisco TransportPlanner supports the following topologies:

• Bus (single span, point-to-point, and linear)

• Open (or hubbed) ring

• Closed (or meshed) ring

An example of each topology is given in this chapter.

3.2 Bus Topologies
Bus topologies comprise three types of topologies: single span, point-to-point, and linear.

3.2.1 Single-Span Topology
Figure 3-1 shows an example of a single-span topology. Single-span topologies are characterized by a 
single span link. The single-span configuration only supports two terminal sites (full terminal or flexible 
channel-count terminal) without any intermediate line amplifier or optical add/drop multiplexing 
(OADM) sites.
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Figure 3-1 Single-Span Topology Example

3.2.2 Point-to-Point Topology 
Figure 3-2 shows an example of a point-to-point topology. In a point-to-point topology, all the 
wavelengths are terminated at the same point in the chain. In the point-to-point configuration, no 
channels are added or dropped in intermediate sites.

Figure 3-2 Point-to-Point Topology Example

3.2.3 Linear Topology
Figure 3-3 shows an example of a linear topology. Linear configurations are characterized by the 
presence of two terminal sites (full terminal or flexible channel-count terminal). Between the two 
terminal sites, OADM or line amplifiers nodes can be inserted. In a linear configuration, specific 
wavelengths are terminated at different points in the chain and only unprotected traffic can be 
provisioned.

Figure 3-3 Linear Topology Example

3.3 Hubbed Ring Topology
Figure 3-4 shows an example of a hubbed ring topology. In this configuration, at least one of the sites 
must be a hub site, where all channels are terminated. 
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Figure 3-4 Hubbed Ring Topology Example

3.4 Meshed Topology
Figure 3-5 provides an example of a meshed ring topology. A meshed ring is characterized by the 
absence of a hub node.

Figure 3-5 Meshed Ring Topology Example
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A
 P P E N D I X A

GUI Information and Shortcuts

This appendix describes the Cisco TransportPlanner views, menus, tools, and shortcuts options. For 
more information about Cisco TransportPlanner, refer to Chapter 1, “Overview.”

Manage the Cisco TransportPlanner Window
The Cisco TransportPlanner window provides a menu bar, toolbar, a Project Explorer pane, a Properties 
pane, an Analyzer pane, and a Task Pane to allow you to manage a network design (Figure A-1). The 
Networks Mgmt Tree tab displays the networks that you have created for a project. The NtVw Net# tab 
displays the sites for a network (identified by the Net# on the tab).

Figure A-1 Cisco TransportPlanner Window with Network Tree
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Menu and Toolbar Options
The Cisco TransportPlanner window menu bar and toolbar provide primary Cisco TransportPlanner 
functions. Table A-1 shows the actions that are available from the menu and toolbar.

Table A-1 Menu and Toolbar Options

Menu Menu Option Toolbar Description

File New Creates a new Cisco TransportPlanner project. See the “2.3 Creating a Project” 
section on page 2-36.

Open Opens an existing Cisco TransportPlanner project. See the “2.1.1 Opening a 
Project” section on page 2-15.

Close Closes the current project without closing the Cisco TransportPlanner session. If 
you have not saved the current project, Cisco TransportPlanner will prompt you 
to save before closing. See the “2.1.5 Closing a Project” section on page 2-18.

Save Saves the current project. See the “2.1.3 Saving a Project” section on page 2-16.

Save As Allows you to save the current project with a new file name. See the 
“2.1.3 Saving a Project” section on page 2-16.

Import 2.5 
Project

— Allows you to import a Cisco TransportPlanner Release 2.5 project into 
Cisco TransportPlanner Release 7.0.1. See the “2.1.4 Importing a Cisco 
TransportPlanner Release 2.5 Project” section on page 2-16.

Clear History — Clears the file history from Cisco TransportPlanner. Cisco TransportPlanner 
maintains a list of the last ten open projects in the File menu. 

Exit — Exits the Cisco TransportPlanner software. 
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View My Default 
Layout

— Changes the Cisco TransportPlanner display to the user default layout. 
Cisco TransportPlanner allows you to define the default value for Platform 
Options, Project Options, and General Options. The defined value are used as 
default for each new created project. See the “2.2 Setting 
Cisco TransportPlanner Options” section on page 2-18.

Default Layout — Returns the Cisco TransportPlanner display to the system default layout.

Tasks Pane — Displays the commands available for the selected entity (network, site, duct, 
etc.). 

Project 
Explorer

— Displays the Project Explorer pane, which includes folders for project notes, 
networks, sites, fibers, traffic demand groups, subnets, maintenance centers, 
restricted equipment list, and reports. Clicking the plus (+) sign by each folder 
expands the folder. Clicking the minus (–) sign by each folder hides the folder. 
contents. You can also right-click a folder and choose Expand from the shortcut 
menu to show folder contents. The default location of the Project Explorer pane 
is the upper left section of the Cisco TransportPlanner window.

Properties — Displays the Properties pane, which shows parameter settings for the selected 
entity in the Project Explorer, Networks Mgmt Tree tab, or NtVw Net# tab. The 
default location of the Properties pane is the lower left section of the 
Cisco TransportPlanner window.

Analyzer 
Messages

— Displays the Analyzer Messages pane at the bottom of the 
Cisco TransportPlanner window. The Analyzer Messages pane displays any error 
messages that occur during network analysis.

Tools Options — Opens the Options Explorer dialog box, where you can change the user default 
settings. See the “2.2 Setting Cisco TransportPlanner Options” section on 
page 2-18.

DB Parts Mgmt — Opens the PartsTreePanel dialog box, where you can view the list of available 
parts for each release. See the “2.2.3 Setting the Default Project Values” section 
on page 2-24.

Price List Mgmt — Opens the Price Manager dialog box, where you can view maintenance contracts 
and add price databases. See the “2.9 Managing the Price List” section on 
page 2-136.

Plug In — Opens the PlugIn Registry dialog box, which allows you to customize 
Cisco TransportPlanner with plug-ins released by Cisco. See the “2.2.8 Adding 
Plug-ins” section on page 2-33 and the “2.2.9 Managing Plug-ins” section on 
page 2-34.

Export — Opens the Export dialog box, which allows you to export user options, price lists, 
maintenance contracts, and parts database files. See the “2.2.5 Exporting a File” 
section on page 2-30.

Import — Opens the Import dialog box, which allows you to import user options, price lists, 
maintenance contracts, and parts database files. See the “2.2.6 Importing a File” 
section on page 2-31.

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Script Run Script — Opens the Choose a script to run dialog box, which allows you to run a script that 
Cisco provides. See the “2.2.11 Running a Script” section on page 2-35.

Run Again — Runs the script that was last used.

Common — Displays any scripts in the scripts directory where Cisco TransportPlanner is 
installed.

User — Displays any scripts in the C:/Documents And 
Settings/<user-home>/MP_<version>/scripts directory.

Refresh Dirs — Refreshes the Script menu. This command removes script names from the Run 
Again menu, and updates the Script > Common and User menus. See the 
“2.2.12 Refreshing the Script Menu” section on page 2-35.

Help Manual — Opens the Cisco TransportPlanner online help.

Tips Of The 
Day

— Opens the Tip of the Day dialog box, which provides helpful hints about using 
Cisco TransportPlanner. Click the Next button to view the next tip and the Back 
button to view a previous tip. Check Show Tips on Startup to display the Tip of 
the Day dialog box when you launch Cisco TransportPlanner.

About — Displays Cisco TransportPlanner version information.

— Create a new 
site

Opens the Site Creation wizard when you click this icon and then click in the 
Cisco TransportPlanner window. See the “2.3.1 Adding Sites” section on 
page 2-45.

— Create a new 
duct

Allows you to create a new duct between sites. See the “2.3.2 Adding Fiber 
Spans” section on page 2-46.

— Create a new 
P2P demand

Opens the Point to Point Demand Creation Wizard when you click this icon and 
then click two sites. See the “2.3.4 Creating a Point-to-Point Demand” section 
on page 2-48.

— Create a new 
P-ring demand

Opens the P-Ring Creation Wizard. See the “2.3.5 Creating a Protected Ring 
Demand” section on page 2-50.

— Create a new 
TDM 
Aggregated 
demand

Opens a TDM creation wizard. See the 2.3.8 Creating TDM Aggregated 
Demand, page 2-57

— Create a new 
Ethernet 
Aggregated 
demand

Opens a Ethernet creation wizard. See the 2.3.7 Creating Ethernet Aggregated 
Demand, page 2-55

— Zoom in Zooms in on the NtVw Net# tab. 

— Zoom out Zoom out from the NtVw Net# tab.

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Cisco TransportPlanner Panes
Cisco TransportPlanner provides four panes that help you manage a network design: Project Explorer, 
Properties, Analysis, and Tasks Pane.

— Normal viewing Returns the NtVw Net# tab to normal viewing (1:1).

— Fit to window Resizes the view so that all sites fit inside the NtVw Net# tab window.

— Save network 
view image

Saves a JPEG of the network design. See the “2.7.5 Creating a JPEG of the 
Network Design” section on page 2-130.

— Analyze 
Network

Analyzes the selected network. See the “2.4 Analyzing the Network” section on 
page 2-62.

— Enter design 
mode

Puts the selected Design-Analyzed network back into the design mode for further 
changes. See the “2.4 Analyzing the Network” section on page 2-62.

— Put current 
network in 
upgrade mode

Creates a copy of the selected Design-Analyzed network in the Upgrade state. 
See the “2.7.3 Creating an Upgrade Network” section on page 2-128.

— Delete current 
network

Deletes the selected network. See the “2.6.12 Deleting a Network” section on 
page 2-112.

— Copy current 
network

Copies the selected network. See the “2.7.1 Creating a Copy of the Network” 
section on page 2-127.

— Put current 
network in 
install mode

Creates a copy of the selected Design-Analyzed network in the Install state. See 
the “2.7.2 Creating a Network in the Install State” section on page 2-127.

— Reports Diff Opens the Reports Diff dialog box, which allows you to create a report that shows 
the differences between networks. 

— Run the 
Garbage 
Collector

Deletes unloaded networks from memory. 

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Project Explorer Pane

The Project Explorer pane provides a management tree for the entire project. Each network appears as a 
folder that contains the sites, fibers, traffic groups, subnets, maintenance centers, restricted equipment 
lists, and reports for that network. If you have made changes to a network design, that network folder 
and the changed item folder appear in blue italics in the pane. 

By default, the Project Explorer pane is located in the upper left section of the Cisco TransportPlanner 
window. Table A-2 shows the actions that are available from the Project Explorer toolbar.

Properties Pane

The Properties pane shows all of the parameters set for a selected item (either in the Project Explorer, 
the Network Mgmt Tree tab, or the NtVw Net# tab). Many items are editable in the Properties pane. By 
default, the Properties pane is located in the lower left section of the Cisco TransportPlanner window.

Table A-2 Project Explorer Toolbar Options

Toolbar Description

Displays the Project Explorer as a single pane.

Displays the Project Explorer as split panes. The upper pane contains the main project tree; 
the lower pane shows only the folders for the network that is selected in the upper pane.

Auto scrolls to the selected object in the Project Explorer tree. For example, if you click 
on a site in the NtView Net# tab but it is not in view in the Project Explorer tree, 
Cisco TransportPlanner will automatically scroll the Project Explorer pane until the 
selected site is in view.

Moves backward through the list of previously selected items in the Project Explorer.

Moves forward through the list of previously selected items in the Project Explorer.

Moves (undocks) the Project Explorer pane from the default location in the upper left 
corner so that you can move it around your desktop area as an individual window. 

Moves the Project Explorer back to the default location.

Hides the Project Explorer. To view again, move the mouse over the Prop tab that appears 
in the upper left corner of the Cisco TransportPlanner window. 

When in hidden mode, reopens the Project Explorer in the default location.

Closes the Project Explorer pane. To reopen, choose Project Explorer from the View 
menu.
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Table A-3 shows the actions that are available from the Properties Pane toolbar.

Analyzer Pane

The Analyzer tab at the bottom of the Cisco TransportPlanner window appears after you have analyzed 
a network design. Clicking the Analyzer tab opens the Analyzer pane. Table A-5 shows the actions that 
are available from the Analyzer pane.

Table A-3 Properties Pane Toolbar Options

Toolbar Description

Categorizes the properties by type. 

Organizes the properties in alphabetical order. 

Shows or hides the description area at the bottom of the Properties pane.

Expands the property categories (if collapsed).

Collapses the property categories (if expanded).

Moves (undocks) the Properties pane from the default location in the lower left corner so 
that you can move it around your desktop area as an individual window. 

Moves the Properties pane back to the default location.

Hides the Property pane. To view again, move the mouse over the Prop tab that appears in 
the upper left corner of the Cisco TransportPlanner window. 

When in hidden mode, reopens the Properties pane so that it appears in the default location.

Closes the Properties Pane. To reopen, choose Properties from the View menu.
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Tasks Pane

The Tasks Pane lists the available commands and reports for a selected item. The commands change 
based on the selected item. For example, a selected site will have different commands available than a 
selected fiber span. By default, the Tasks Pane is located in the upper right section of the 
Cisco TransportPlanner window. Table A-5 shows the actions that are available from the Tasks Pane 
toolbar.

Table A-4 Analyzer Toolbar Options

Toolbar Description

Moves down through the Analyzer messages.

Moves up through the Analyzer messages.

Opens the Apply Filters dialog box, which allows you to filter the messages to show or hide 
Exceptions, Errors, Warnings, and/or Info.

Expands the Analyzer message categories (if collapsed).

Collapses the Analyzer message categories (if expanded).

Moves (undocks) the Analyzer pane from the default location in the lower left corner so 
that you can move it around your desktop area as an individual window. 

Moves the Analyzer pane back to the default location.

Hides the Analyzer pane. To view again, move the mouse over the Analyzer tab that appears 
in the bottom of the Cisco TransportPlanner window.

Opens the Analyzer pane so that it remains open in the bottom section of the 
Cisco TransportPlanner window.

Closes the Analyzer pane. To reopen, choose Analyzer messages from the View menu.

Table A-5 Tasks Pane Toolbar Options

Toolbar Description

Moves (undocks) the Tasks Pane from the default location in the lower left corner so that 
you can move it around your desktop area as an individual window. 

Moves the Tasks Pane back to the default location.
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Shortcuts
Cisco TransportPlanner provides the following mouse shortcuts:

• Double-clicking a network icon in the Network Mgmt Tree tab opens the NtVw Net# tab, which 
shows the sites for that network. 

• Right-clicking a report table column displays a shortcut menu that allows you to view or hide the 
columns in a report. 

• Right-clicking an item in the Network Mgmt Tree tab or NtVw Net# tabs opens a shortcut menu that 
allows you to choose actions to perform on the selected item. The shortcut menu options differ based 
on the item selected and the network state. (Many commands are not available until a network is 
analyzed.) Table A-6 lists the shortcut menu actions that are available for each item.

Hides the Tasks Pane. To view again, move the mouse over the Tasks tab that appears in 
the upper right corner of the Cisco TransportPlanner window. 

When in hidden mode, reopens the Tasks Pane so that it appears in the default location.

Closes the Tasks Pane. To reopen, choose Tasks Pane from the View menu.

Table A-5 Tasks Pane Toolbar Options (continued)

Toolbar Description
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Table A-6 Shortcut Menu Actions

Item Available Shortcut Actions

Networks in the 
following states: 
Design, Install, and 
Upgrade 

• Unload/Load—Unloads or loads the network. See the “2.1.2 Loading and 
Unloading Networks” section on page 2-15.

• Edit Note—Allows you to create a note for the network. See the 
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Delete—Removes the network from the project. See the “2.6.12 Deleting 
a Network” section on page 2-112.

• Copy—Creates a copy of the network. See the “2.7.1 Creating a Copy of 
the Network” section on page 2-127.

• Arrange Sites—Allows you to rearrange sites in the 
Cisco TransportPlanner window. See the “2.6.22 Arranging Sites” section 
on page 2-122.

Analyzed networks • Unload/Load—Unloads or loads the network. See the “2.1.2 Loading and 
Unloading Networks” section on page 2-15.

• Edit Note—Allows you to create a note for that item. See the 
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Install—Creates a copy of the network in the Install state. See the 
“2.7.2 Creating a Network in the Install State” section on page 2-127.

• Delete—Removes the network from the project. See the “2.6.12 Deleting 
a Network” section on page 2-112.

• Upgrade—Creates a copy of the network in the Upgrade state. See the 
“2.7.3 Creating an Upgrade Network” section on page 2-128.

• Copy—Creates a copy of the network. See the “2.7.1 Creating a Copy of 
the Network” section on page 2-127.

• Layout—Opens the Layout tab. See the “2.5.6 Displaying the Layout” 
section on page 2-74.

• Internal Connections—Opens the Internal Connections tab. See the 
“2.5.4 Viewing Internal Connections” section on page 2-68.

• Optical Results—Opens the Optical Results tab. See the “2.5.9 Viewing 
Optical Results” section on page 2-79.

• Wavelength Routing—Opens the Wavelength Routing tab. See the 
“2.5.10 Viewing Wavelength Routing” section on page 2-83.

• Bill of Material—Opens the Bill of Materials tab. See the 
“2.8.2 Generating a Network BoM” section on page 2-132.

• Installation—Opens a submenu with the following options: 

– NE Update—Creates a configuration file for each site in the network 
See the “2.5.2 Saving the NE Update File” section on page 2-65.

– Installation Parameters—Opens the Installation Parameters tab. See 
the “2.5.3 Viewing the Installation Parameters” section on page 2-66.

• Arrange Sites—Allows you to rearrange sites in the 
Cisco TransportPlanner window. See the “2.6.22 Arranging Sites” section 
on page 2-122.
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Site Icons
A site icon indicates the functionality of site. Table A-7 lists the site icons.

Sites • Edit Note—Allows you to create a note for that item. See the 
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Delete—Removes the site from the project. See the “2.6.14 Deleting 
Sites” section on page 2-113.

If the network is analyzed, the following actions are also available:

• Layout—Opens the Layout tab. See the “2.5.6 Displaying the Layout” 
section on page 2-74.

• Internal Connections—Opens the Internal Connections tab. See the 
“2.5.4 Viewing Internal Connections” section on page 2-68.

• Optical Results—Opens the Optical Results tab. See the “2.5.9 Viewing 
Optical Results” section on page 2-79.

• Wavelength Routing—Opens the Wavelength Routing tab. See the 
“2.5.10 Viewing Wavelength Routing” section on page 2-83.

• Bill of Material—Opens the Bill of Materials tab. See the 
“2.8.2 Generating a Network BoM” section on page 2-132.

• Installation—Opens a submenu with the following options: 

– NE Update—Creates a configuration file for each site in the network. 
See the “2.5.2 Saving the NE Update File” section on page 2-65.

– Installation Parameters—Opens the Installation Parameters tab. See 
the “2.5.3 Viewing the Installation Parameters” section on page 2-66.

• Unlock—Unlocks the site. See the “2.7.4 Unlocking Parameters in the 
Network Design” section on page 2-129.

Fiber spans • Edit Note—Allows you to create a note for that item. See the 
“2.3.9 Adding Notes to a Project” section on page 2-60.

If the network is analyzed, the Unlock command is also available. See the 
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-129.

Traffic demands • Edit Note—Allows you to create a note for that item. See the 
“2.3.9 Adding Notes to a Project” section on page 2-60.

• Edit—Allows you to edit the demand. See the “2.6.6 Editing a 
Point-to-Point Demand” section on page 2-100, “2.6.7 Editing a P-Ring 
Demand” section on page 2-101, or “2.6.8 Editing a ROADM Demand” 
section on page 2-102.

• Delete—Removes the demand from the project. See the “2.6.15 Deleting 
a Traffic Demand” section on page 2-113.

If the network is analyzed, the Unlock command is also available. See the 
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-129.

Table A-6 Shortcut Menu Actions (continued)

Item Available Shortcut Actions
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Table A-7 Site Icons

Site Name Site Icon Description

Add/Drop Indicates that this site has add/drop capability. Only 
point-to-point and P-ring circuits can be added/dropped at this 
site.

Gain equalizer Indicates that this site uses wavelength selective switch cards to 
control the generated tilt and extend unregenerated distances. 
The site is realized as an ROADM site without demultiplexer 
cards.

Hub Indicates that this site is equipped with filters for adding and 
dropping all the channels (on both West and East sides). All 
express paths are open in hub configurations.

Line amplifier Indicates that any add/drop traffic is prevented at this site.

OSC site Indicates that site is designated for network communication, 
providing the possibility to access the optical service channel 
(OSC) for management of the MultiService Transport platform 
(MSTP) network. By default, no amplifiers are included in this 
site. However, if Cisco TransportPlanner determines that an 
amplifier is required in the network, it can automatically place it 
at this location. Cisco TransportPlanner allows you to set (force) 
preamplifier and booster amplifiers for each direction on a OSC 
Site node.

Pass Through Indicates that no equipment will be located at this site.

R-OADM Indicates that this site supports Any-to-Any and also Fixed 
(point-to-point and P-ring) traffic types.
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Card Types

This appendix provides a list of interface and card types supported in Cisco TransportPlanner, as well as 
the corresponding Cisco product ID (Tables B-1 to B-29). 

Note The card names in this appendix designated with “_C” or “_L” appear in Cisco TransportPlanner with a 
“_y” designation before network analysis. The “_y” designation indicates that Cisco TransportPlanner 
will use either a C- or L-band card, depending on the band selected during project creation.

Table B-1 OC-192/STM-64 (9.953 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC1

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
FEC2

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Line Card OC-192 LR

STM-64 LR

Client 1+1 15454-192L-1-xx.y= (ANSI)

15454E-64L-xx.y= (ETSI)
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1. Enhanced forward error correction.

2. Forward error correction.

Table B-2 OC-48/STM-16  (2.488 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder MXP_2.5_10E_C and 
MXP_2.5_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10ME-L1-C= (C band)

15454-10ME-L1-L= (L band)

Transponder MXP_2.5_10E_C and 
MXP_2.5_10E_L with FEC

Client 1+1

Y-Cable

15454-10ME-L1-C= (C band)

15454-10ME-L1-L= (L band)

Transponder MXP_2.5_10E with EFEC Client 1+1

Y-Cable

15454-10ME-xx.y=

Transponder MXP_2.5_10ET with FEC Client 1+1

Y-Cable

15454-10ME-xx.y=

Transponder MXP_2.5_10G with FEC Client 1+1

Y-Cable

15454-10M-L1-xx.y=

Transponder MXP_2.5_10G without 
FEC

Client 1+1

Y-Cable

15454-10M-L1-xx.y=

Line Card OC48ELR / SMT-16ELR Client 1+1 15454-O48E-1-xx.y (ANSI)

15454E-EL16HSxxyy= (ETSI)

Transponder ADM-10G Client 1+1

Y-Cable

Fiber-Switched

15454-ADM-10G = (Unprot) 

15454-ADM-10G = (Prot)
B-2
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Appendix B      Card Types
Table B-3 OC-12/STM-4  (622 Mbps)  

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder ADM-10G Client 1+1

Y-Cable

Fiber-Switched

15454-ADM-10G = (Unprot) 

15454-ADM-10G = (Prot)

Table B-4 OC-3/STM-1  (155 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder ADM-10G Client 1+1

Y-Cable

Fiber-Switched

15454-ADM-10G = (Unprot) 

15454-ADM-10G = (Prot)

Table B-5 10 Gigabit Ethernet Wide Area Network ATM Physical Layer (10GE WAN PHY) (9.953 

Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)
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Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Table B-6 10 Gigabit Ethernet Local Area Network ATM Physical Layer (10GE LAN PHY)(10.3 

Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder 10GE_XP with 
point-to-point traffic 
demand

XFPs with Ethernet 
aggregated traffic demand

Client 1+1

Y-Cable

15454-10GE-XP = (Unprot) 

15454-10GE-XP = (Prot)

Table B-5 10 Gigabit Ethernet Wide Area Network ATM Physical Layer (10GE WAN PHY) (9.953 

Gbps) (continued)
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Table B-7 Gigabit Ethernet (1.25Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1

Y-Cable

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable 

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Pluggable GE DWDM GBIC Client 1+1 15454-GBIC-xx.y=

Transponder GE_XP with point-to-point 
traffic demand configured on 
CTC as 10GE MXP 

GE XP-O with point to point 
traffic demand and if 
configured on Cisco 
Transport Controller (CTC) as 
20GE MXP 

XFPs with Ethernet aggre-
gated traffic demand 

Client 1+1

Y-Cable

Fiber-Switched

15454-GE-XP = (Unprot) 

15454-GE-XP = (Prot)

Transponder ADM-10G Client 1+1

Y-Cable

Fiber-Switched

15454-ADM-10G = (Unprot) 

15454-ADM-10G = (Prot)

Table B-8 Fast Ethernet (100 Mbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
B-5
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Appendix B      Card Types
Table B-9 Fiber Channel 10G (10.5 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC 

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1 

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E

TXP_MR_10E_y

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Table B-10 Fiber Channel 4G (4.25 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-11 Fiber Channel 2G (2.125 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)
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Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-12 Fiber Channel 1G (1.062 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

 Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-13 2 Gbps Fiber Connectivity (2.125 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-11 Fiber Channel 2G (2.125 Gbps) (continued)
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Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-14 FICON-1G (1.062 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

 Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-15 Enterprise System Connection (ESCON) (200 Mbps)

Interface Type Card Type Protection Type Product ID

Table B-13 2 Gbps Fiber Connectivity (2.125 Gbps) (continued)
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Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

 Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-16 ISC-3 Compatibility Mode (1.062 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G without FEC Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-17 ISC-Peer 2R

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-18 ISC-3 Peer-1G  (1.062 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-15 Enterprise System Connection (ESCON) (200 Mbps) (continued)
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Table B-19 ISC-3 Peer-2G (2.125 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-20 Sysplex External Throughput Rate (8 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-21 Sysplex Control Link Oscillator (8 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-22 Serial Data Input

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-23 Digital Video Broadcast-Asynchronous Serial Interface

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
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Table B-24 D1-Video  (270 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-25 High Definition Television (HDTV) (1.48 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-26 DV-6000  (2.38 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-27 2R Any Rate

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-28 ONS 15530 2.5G ITU-T

Interface Type Card Type Protection Type Product ID

TXP MR MM TXP

MR SM TXP

MR MM TXP with splitter

MR SM TXP with splitter

Client 1+1

Fiber-Switched

15530-TSP1-xx21 (MM Unprot)

15530-TSP1-xx22 (SM Unprot)

15530-TSP1-xx11 (MM Prot)

15530-TSP1-xx12 (SM Prot)

LC 2.5-Gbps Aggregation

2.5-Gbps Aggregation with 
splitter

Client 1+1

Fiber-Switched

15530-ITU3-xx20 (Unprot)

15530-ITU3-xx10 (Prot)
B-11
Cisco TransportPlanner DWDM Operations Guide, Release 8.5

78-18129-01



 

Appendix B      Card Types
Table B-29 ONS 15530 10G ITU-T

Interface Type Card Type Protection Type Product ID

LC 10-Gbps Aggregation

10-Gbps Aggregation with 
splitter

Client 1+1

Fiber-Switched

15530-ITU2-xx20 (Unprot)

15530-ITU2-xx10 (Prot)

MXP Data Muxponder 

Data Muxponder with splitter

Client 1+1

Fiber-Switched

15530-MSMP-xx22 (Unprot)

15530-MSMP-xx12 (Prot)
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A
 P P E N D I X C

System Messages

This appendix lists Cisco TransportPlanner system messages (Table C-1).

Table C-1 Error Messages

Message Type Error Message

Traffic mapping Wavelength {0}1 may require additional ASE filtering.

Traffic mapping 50GHz scalability is supported only with {0} design rules.

Traffic mapping The network is broken: please connect all the sites together.

Traffic mapping The traffic model is empty: please add at least one service request.

Traffic mapping Number of Add/Drop nodes exceeded the maximum ({0}) allowed in 
the network.

Traffic mapping ONS15454 DWDM platform supports up to {0} non-pass-though 
sites.

Traffic mapping Line+ sites can’t support DMX-O units due to layout constraints.

Traffic mapping Line+ sites can’t support Individual Shelf with DCC chain option 
due to layout constraints.

Traffic mapping Client {0} is not available in the equipment list.

Traffic mapping Any to Any traffic is not supported by {0} rules.

Traffic mapping Any to Any traffic requires ROADM units but ROADM is not 
allowed by restricted equipment list.

Traffic mapping Can't place ROADM units in site {0} to support Any to Any traffic.

Traffic mapping ROADM configuration is not allowed by restricted equipment list.

Traffic mapping Mux Demux configuration is not allowed by restricted equipment 
list.

Traffic mapping Only ROADM configuration is allowed with selected design rules.

Traffic mapping ROADM is not allowed by the selected design rules.

Traffic mapping ROADM-O is not allowed with L band.

Traffic mapping Line+ or Terminal+ site topologies are not allowed by selected 
design rules.

Traffic mapping Line+ or Terminal+ site topologies require ROADM units but 
ROADM is not allowed by restricted equipment list.
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Traffic mapping OADM unit {0} defined in {1} is not allowed by restricted 
equipment list.

Traffic mapping Can’t find a valid aggregating client.

Traffic mapping Can’t find a valid client.

Traffic mapping Client {0} can’t be tuned on wavelength {1}.

Traffic mapping Forced wavelength {0} is outside selected band.

Traffic mapping Forced client {0} can't be tuned on selected band.

Traffic mapping Interface Type {0} is not supported by the selected Design Rules.

Traffic mapping Add/Drop not available in site {0}.

Traffic mapping Maximum wavelength re-usage reached for ITU channel {0}.

Traffic mapping All solutions exceed {0} wavelengths. See the “C.1.1 Wavelength 
Exceeded” section on page C-12.

Traffic mapping The anti ASE option is available only in sites with add/drop 
capability.

Traffic mapping More than one anti ASE site was selected.

Traffic mapping No specific anti-ASE node is required for this traffic matrix 
requirement.

Traffic mapping Protected services are not allowed with linear networks.

Traffic mapping In a network with hub nodes protected services are allowed only 
between hub sites.

Traffic mapping Invalid routing (out of network boundary). See the “C.1.2 Invalid 
Routing” section on page C-13.

Traffic mapping Can’t route service with optical bypass in {0}.

Traffic mapping Can’t find alternate route due to multiple HUB nodes along the path. 
See the “C.1.3 Cannot Find Alternate Route” section on page C-13.

Traffic mapping Can’t route service through HUB node {0}. See the “C.1.4 Cannot 
Route Service” section on page C-14.

Traffic mapping Overlapped services assigned to the same wavelength. See the 
“C.1.5 Overlapped Services Assigned to the Same Wavelength” 
section on page C-14.

Traffic mapping Protected services assigned to the same wavelength. See the 
“C.1.6 Protected Services Assigned to the Same Wavelength” 
section on page C-15.

Traffic mapping Can’t route service due to add drop equipment constraints. See the 
“C.1.7 Cannot Route Service Because of Add/Drop Constraints” 
section on page C-15.

Traffic mapping Design requires forcing a site as ROADM or Full Mux/Demux but no 
valid site was found.

Traffic mapping Design requires forcing site as ROADM or Full Mux/Demux: 
remove equipment constraints.

Table C-1 Error Messages (continued)

Message Type Error Message
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Traffic mapping Path constraints prevent routing of {0}

Traffic mapping Traffic subnet constraints prevent routing of {0} 

Traffic mapping In a linear network, terminal sites must have structure Terminal

Traffic mapping Wavelength {0} may require additional ASE filtering

Traffic mapping 50GHz scalability is supported only with {0} design rules 

Traffic mapping The Network is broken: please connect all the sites together

Traffic mapping The traffic model is empty: please add at least one service request

Traffic mapping Number of Add/Drop nodes exceeded the maximum ( {0} ) allowed 
in the network

Traffic mapping ONS15454 DWDM platform supports up to {0} non-pass-though 
sites

Traffic mapping Line+ sites can''t support DMX-O units due to layout constraints

Traffic mapping Line+ sites can''t support Individual Shelf with DCC chain option 
due to layout constraints

Traffic mapping Client {0} is not available in the equipment list

Traffic mapping Any to Any traffic is not supported by {0} rules

Traffic mapping Any to Any traffic requires ROADM units but ROADM is not 
allowed by restricted equipment list

Traffic mapping Can''t place ROADM units in site {0} to support Any to Any traffic 

Traffic mapping ROADM configuration is not allowed by restricted equipment list

Traffic mapping WXC configuration is not allowed by restricted equipment list

Traffic mapping Mux Demux configuration is not allowed by restricted equipment list

Traffic mapping Only ROADM configuration is allowed with selected design rules

Traffic mapping Multi-degree structure in site {0} is not allowed with selected design 
rules

Traffic mapping ROADM is not allowed by the selected design rules

Traffic mapping ROADM-O is not allowed with L band

Traffic mapping Line+ or Terminal+ site topologies are not allowed by selected 
design rules

Traffic mapping Line+ or Terminal+ site topologies require ROADM units but 
ROADM is not allowed by restricted equipment list

Traffic mapping OADM unit {0} defined in {1} is not allowed by restricted 
equipment list

Traffic mapping Can''t find a valid aggregating client

Traffic mapping Can''t find a valid client

Traffic mapping Can''t find a valid XFP

Traffic mapping Client {0} can''t be tuned on wavelength {1}

Traffic mapping Forced wavelength {0} is outside selected band
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Traffic mapping Forced client {0} can't be tuned on selected band

Traffic mapping Interface Type {0} is not supported by the selected Design Rules

Traffic mapping Add/Drop not available in site {0}

Traffic mapping Maximum wavelength re-usage reached for ITU channel {0}

Traffic mapping All solutions exceed {0} wavelengths

Traffic mapping The anti ASE option is available only in sites with add/drop 
capability

Traffic mapping More than one anti ASE site was selected

Traffic mapping No specific anti-ASE node is required for this traffic matrix 
requirement

Traffic mapping Protected services are not allowed with linear networks

Traffic mapping In a network with hub nodes protected services are allowed only 
between hub sites

Traffic mapping Invalid routing (out of network boundary)

Traffic mapping Can''t route service with optical bypass in {0}

Traffic mapping Can''t find alternate route due to HUB nodes along the path

Traffic mapping Can''t route service through HUB node {0}

Traffic mapping Overlapped services assigned to the same wavelength

Traffic mapping Protected services assigned to the same wavelength

Traffic mapping Can''t route service due to add drop equipment constraints

Traffic mapping Design requires forcing a site as ROADM or Full Mux/Demux but no 
valid site was found

Traffic mapping Design requires forcing site as ROADM or Full Mux/Demux: 
remove equipment constraints

Traffic mapping PP4 is not allowed in site {0} (fiber interfaces are limited to A,B,C 
and D)

Traffic mapping No valid path from {0} to {1}

Traffic mapping No valid path from {0} to {1}, bypass in {2}

Traffic mapping Wavelength forced ourside of selected band for {0}

Traffic mapping Client {0} can''t be tuned at {1} 

Traffic mapping Invalid functionality option for structure {0} in site {1}

Traffic mapping Invalid mux - demux configuration in site {0}

Traffic mapping Invalid mux - demux combination on two sides of site {0}

Traffic mapping Unit options are not compatible with design rule {0} in site {1}

Traffic mapping Unit {0} is not available in Restricted Equipment List

Traffic mapping Mesh topology not supported yet 

Traffic mapping Network Cluster {0} requires mesh algorithm

Traffic mapping Unconnected site {0}
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Traffic mapping Incompatible port {0} assignment in site {1}

Traffic mapping Only one GE-STS24 can be assigned to port {0} in site {1}

Traffic mapping Incompatible rate/reach options circuit {0}

Traffic mapping Incompatible rate/reach options for port {0} in site {1}

Traffic mapping Incompatible CIR settings for port {0} in site {1}

Traffic mapping Can''t find a valid SFP for port {0} in site {1}

Traffic mapping Port {0} in site {1} is not available

Traffic mapping Exceeded rate for port {0} in site {1}

Traffic mapping Can''t provision circuit {0}

Traffic mapping Maximum frame rate exceeded in section {0} - {1}

Traffic mapping Maximum frame rate exceeded in node {0}

Traffic mapping Protected circuits are not allowed in a linear traffic subnet

Traffic mapping Invalid routing {0}

Traffic mapping Client protection is not allowed if all nodes are single card 
configuration 

Traffic mapping Trunk protection with no client protection is not allowed if at least 
one node is double card configuration

Traffic mapping Client protection with no trunk protection is not allowed if at least 
one node is double card configuration

Traffic mapping Errors were found on {0}: please run the checker and fix all 
problems

Traffic mapping Client and trunk protections are not allowed at the same time on port 
{0} in site {1}

Traffic mapping 50GHz scalability is not supported with Ethernet or TDM aggregated 
demands

Traffic mapping Cards required for {0} demand are not available in the equipment list

Traffic mapping Impossible to find two independent paths for protected service

Traffic mapping Structure {0} is not supported for design rule {1}

Traffic mapping No available wavelegth found due to traffic constraints

Traffic mapping Too many Add/Drop nodes ({0} > {1}) in cluster {2}

Traffic mapping Too many nodes ({0} > {1}) in cluster {2}

Traffic mapping Too many ROADM nodes ({0} > {1}) in group {2}

Traffic mapping Demand {0} defined om traffic subnet {1} is in an invalid status

Traffic mapping Demand {0} is crossing different sites clusters

Traffic mapping PP4 forced on site {0} can handle at most 4 sides

Amplifier Placement In {0}, MMU mandatory requires OPT-AMP-L in booster and pre 
position. Please remove any other amplifier type forcing.
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Amplifier Placement In {0}, MMU mandatory requires OPT-PRE and OPT-BST-E. Please 
remove any other amplifier type forcing.

Amplifier Placement In {0}, cannot force a demux if it is not supported by site type.

Amplifier Placement In {0}, cannot force a mux if it is not supported by site type.

Amplifier Placement In {0}, cannot force an in-line attenuator if it is not supported by site 
type.

Amplifier Placement In {0}, cannot force an in-line attenuator because of presence of 
OADMs in the other side.

Amplifier Placement Invalid forcing in amplifier node of {0} because of Pass-through site 
forcing.

Amplifier Placement In {0}, cannot force unplaced OSC card in a non Pass-through site.

Amplifier Placement In {0}, cannot force OSCM without an amplifier forced.

Amplifier Placement Cannot force output power or tilt in {0} without the related amplifier 
forced.

Amplifier Placement Cannot force input attenuator in {0} without the related amplifier 
forced.

Amplifier Placement Cannot force DCUs in {0} without forcing an amplifier that supports 
them.

Amplifier Placement Incompatible types for DCU couple in {0}.

Amplifier Placement Incompatible dispersion modules in {0}

Amplifier Placement In {0}, output power is out of limits of amplifier selected.

Amplifier Placement In {0}, amplifier tilt is out of allowed range.

Amplifier Placement Couple between {1} and {2} has an invalid value in {0}

Amplifier Placement Couple between {0} and {1} is of invalid type

Amplifier Placement Fibre between {1} and {2} has an invalid value in {0}

Amplifier Placement Fibre between {0} and {1} has SOL total loss greater than EOL total 
loss.

Amplifier Placement Can't respect forcing on {0} attenuator (on channel {1}) in {2} {3} 
{4}. No A/D ports are available

Amplifier Placement A {0} attenuator (on channel {1}) in {2} {3} {4} was present, but 
A/D ports on this channel are longer available

Amplifier Placement Tilt forced on {0} in {1} {2} {3} when no-tilt design option is 
selected

Amplifier Placement DMX-O is suggested as drop unit in {0} instead of the forced DMX.

Amplifier Placement DMX might cause problems during channels provisioning and or in 
case of equipment failures.

Amplifier Placement Fail low channel threshold cannot be set in {0} {1} {2}; please allow 
placement of booster amplifier.

Amplifier Placement In {0}, {1} is working in an invalid mode (power control mode).
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Amplifier Placement In case of fibre cut or equipment failure, channels survivability might 
not be guaranteed.

Amplifier Placement In {0}, {1} is working with a gain of {2} dB: this value is below its 
minimum allowed gain.

Amplifier Placement In {0}, {1} in EOL condition will be working with a gain of {2} dB: 
this value is below its minimum allowed gain.

Amplifier Placement In {0}, {1} is working with a gain of {2} dB: this value exceeds its 
maximum allowed gain.

Amplifier Placement In {0}, {1} in EOL condition will be working with a gain of {2} dB: 
this value exceeds its maximum allowed gain. 

Amplifier Placement In {0}, {1} cannot respect user forcing.

Amplifier Placement Site {0} cannot be installed without Cisco TransportPlanner 
configuration file.

Amplifier Placement In {0}, {1} cannot respect user forcing due to {2}.

Amplifier Placement Unsupported configuration due to excessive number of amplifiers 
(max {0} per directions).

Amplifier Placement Unsupported configuration due to excessive number of OSC regen 
sites (max {0}).

Amplifier Placement In {0}, channel power is near the fail low threshold.

Amplifier Placement In {0}, channel power is below the fail low threshold.

Amplifier Placement In {0}, OSC channel power is near the fail low threshold.

Amplifier Placement In {0}, OSC channel power is below the fail low threshold.

Amplifier Placement Network cannot be installed as one or more OSC links are 
unfeasible.

Amplifier Placement If possible, try selecting DCN extension option on the longest spans.

Amplifier Placement Try to unfreeze amplifier or DCUs in site {0}, interface {1}, {2} 
position

Amplifier Placement Transmission error. Please contact custom design.

Amplifier Placement Transmission error on channel {0}. Please contact custom design.

Amplifier Placement Excessive ROADM crossTalk penalty on channel {0}. Try to lower 
the output power of the preamplifier in the Roadm site in which the 
failed channels are added

Amplifier Placement Excessive filtering penalty on channel {0}. Please contact custom 
design

Amplifier Placement Filtering problem on channel {0}. Please contact custom design

Amplifier Placement Excessive PMD on channel {0}. Please contact custom design.

Amplifier Placement Excessive SC on channel {0}. Please contact custom design.

Amplifier Placement In site {0} the Pass Through forcing and DCN Extension option are 
incompatible 
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Amplifier Placement In site {0} an external DCN access must be provided for DCN 
functionality

Amplifier Placement If Installation W/O MP is selected, the node mandatory requires 
preamplifier (PRE or AMP-L) otherwise it must be set as 
Pass-Through

Amplifier Placement If Installation W/O MP is selected in the site, amplifiers output 
power cannot be forced.

Amplifier Placement If Installation W/O MP is selected in the site, Fibre Switch protection 
scheme is not supported.

Amplifier Placement If Installation W/O MP is selected in the site, only "32 Chs +5 
dbm/Ch" and "40 Chs +4 dbm/Ch" power rules are supported. 

Amplifier Placement If Installation W/O MP is selected in the site, only "32 Chs +5 
dbm/Ch" power is are supported

Amplifier Placement If Installation W/O MP is selected in the site, C + L band 
upgradeability is not supported 

Amplifier Placement If Installation W/O MP is selected in the site, OADM output power 
must cannot be forced.

Amplifier Placement If Installation W/O MP is selected in the site, node cannot be set as 
OADM full mux/demux.

Dithering Generation Lower Dithering limit ({0}) cannot be less than {1}

Dithering Generation Upper Dithering limit ({0}) cannot ge greater than {1}

Dithering Generation Lower Dithering limit ({0}) cannot exceed Upper Limit ({1})

Dithering Generation Site {0} Dithering value cannot be less than Lower Dithering limit 
{1}

Dithering Generation Site {0} Dithering value cannot be greater than Upper Dithering 
limit {1}

Dithering Generation Sites {0} and {1} cannot have the same Dithering value

Dithering Generation Number of available Dithering values {0} cannot be less than 
number of MultiDegree sites {1}

Dithering Generation Cannot find available Dithering value for site {0}

Dithering Generation Cannot force Dithering value different from 0 in site {0}

Layout MSTP shelves number in site {0} exceeds maximum MultiShelf 
configuration (8)

Layout No linecards placed in Hybrid site {0} optical shelf

Layout Release 4.7/5.0 does not support MultiShelf

Layout No PRE/BST card present with OSCM in site {0}

Layout Layout not feasible for {0} Individual Shelf configuration - No room 
in the optical shelf to host all the OTS units

Layout No space for DCU: unlock Site {0} layout 

Layout Hybrid Layout in Site {0} is allowed with Individual Shelf only
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Layout Node protection is not allowed in Terminal Site {0}

Layout DCC Chain in Site {0} is allowed with Individual Shelf only

Layout Node protection in Site {0} is not allowed with Individual Shelf

Layout Cable DB part not identified in Site {0}

Layout Site {0} layout must be unlocked to allow Patch Panel/DCU 
insertion

Layout Layout in site {0} cannot be built due an internal error. Other reports 
for the same site may be wrong or incomplete. Please contact 
support.

Layout {0} site layout must be unlocked to apply modified properties

Layout A/D cards configuration in site {0} is not allowed: please select 
"Multi Shelf External Switch" or force 32-DMX card

Layout Units equipped in site {0} shelf {1} need FTA4. Please replace 
current fan tray before equipping the units into the shelf

Layout Only card Layout position can be changed (Site {0})

Layout Card in Rack {0} - Shelf {1} - Slot {2} cannot be moved to Rack {3} 
- Shelf {4} - Slot {5} (Site {6})

Layout Just one move is allowed for Card in Rack {0} - Shelf {1} - Slot {2} 
(Site {3})

Layout Cards in Rack {0} - Shelf {1} - Slot {2} and Rack {3} - Shelf {4} - 
Slot {5} (Site {6}) belong to a YCable Protection Group and must be 
moved to the same destination shelf

Layout Multidegree topology in site {0} is not supported with Individual 
Shelf configuration

Amplifier algorithm In {0}, can’t force a demux if it is not supported by site type.

Amplifier algorithm In {0}, can’t force an inline attenuator if it is not supported by site 
type.

Amplifier algorithm In {0}, can’t force an inline attenuator because of presence of 
OADMs in the other side.

Amplifier algorithm Invalid forcing in amplifier node of {0} because of Pass-through site 
forcing.

Amplifier algorithm In {0}, can’t force unplaced OSC card in a non Pass-through site.

Amplifier algorithm In {0}, can’t force OSCM without an amplifier forced.

Amplifier algorithm Can’t force power output or tilt in {0} without the related amplifier 
forced.

Amplifier algorithm Cannot force input attenuator in {1} without the related amplifier 
forced.

Amplifier algorithm Can’t force DCUs in {0} without forcing an amplifier that supports 
them. See the “C.2.1 Incompatible DCUs (C-Band)” section on 
page C-17.
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Amplifier algorithm Incompatible types for DCU couple in {0}. See the 
“C.2.1 Incompatible DCUs (C-Band)” section on page C-17.

Amplifier algorithm Incompatible dispersion modules in {0}. See the 
“C.2.1 Incompatible DCUs (C-Band)” section on page C-17.

Amplifier algorithm In {0}, MMU presence requires OPT-AMP-L forcing in bst and pre 
position. See the “C.2.2 MMU Does Not Have Correct Amplifier 
(L-Band)” section on page C-17.

Amplifier algorithm In {0}, MMU presence requires OPT-PRE and OPT-BST-E forcing. 
See the “C.2.3 MMU Does Not Have Correct Amplifier (C-Band)” 
section on page C-18.

Amplifier algorithm In {0}, output power is out of limits of amplifier selected. See the 
“C.2.4 Output Power or Tilt are Out of Range” section on 
page C-18.

Amplifier algorithm In {0}, amplifier tilt is out of limits. See the “C.2.4 Output Power or 
Tilt are Out of Range” section on page C-18.

Amplifier algorithm Couple between {1} and {2} has an invalid value in {0}. See the 
“C.2.5 Invalid Fiber Values, Types, and Loss Values” section on 
page C-19.

Amplifier algorithm Couple between {0} and {1} is of invalid type. See the 
“C.2.5 Invalid Fiber Values, Types, and Loss Values” section on 
page C-19.

Amplifier algorithm Fibre between {1} and {2} has an invalid value in {0}. See the 
“C.2.5 Invalid Fiber Values, Types, and Loss Values” section on 
page C-19.

Amplifier algorithm Fibre between {0} and {1} has SOL total loss greater than EOL total 
loss. See the “C.2.5 Invalid Fiber Values, Types, and Loss Values” 
section on page C-19.

Amplifier algorithm Can’t respect forcing on {0} attenuator (on channel {1}) in {2} {3} 
{4}. No A/D ports are available. See the “C.2.6 Attenuator Forcing 
Not Allowed” section on page C-19.

Amplifier algorithm A {0} attenuator (on channel {1}) in {2} {3} {4} was present, but 
A/D ports on this channel are no longer available. See the 
“C.2.7 Unavailable Add/Drop Channels” section on page C-20.

Amplifier algorithm Tilt forced on {0} in {1} {2} {3} when no-tilt design option is 
selected. See the “C.2.8 Tilt Forced When No Tilt Design is 
Selected” section on page C-20.

Amplifier algorithm Can’t change DMX with DMX-O as needed in {1} because user 
forcing. See the “C.2.9 Cannot Replace 32-DMX with 32DMX-O” 
section on page C-21.

Amplifier algorithm Low threshold on channels power in {0} {1} {2} because passive 
user forcing on OPT-BST position.

Amplifier algorithm In {0}, {1} is working in an invalid mode. See the 
“C.2.10 Preamplifier Working in Invalid Mode” section on 
page C-21.
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Amplifier algorithm In {0}, {1} is working with a gain of {2} dBm: this is too low. See 
the “C.2.11 Gain Too Low for an Amplifier” section on page C-22.

Amplifier algorithm  In {0}, {1} will be work (in EOL condition) with a gain of {2} dBm: 
this is too low. See the “C.2.11 Gain Too Low for an Amplifier” 
section on page C-22.

Amplifier algorithm In {0}, {1} is working with a gain of {2} dBm: this is too high. See 
the “C.2.12 Gain Too High for an Amplifier” section on page C-22.

Amplifier algorithm In {0}, {1} will be work (in EOL condition) with a gain of {2} dBm: 
this is too high. See the “C.2.12 Gain Too High for an Amplifier” 
section on page C-22.

Amplifier algorithm In {0}, {1} cannot respect user forcing. See the “C.2.13 User 
Forcing Overridden” section on page C-23.

Amplifier algorithm In {0}, {1} cannot respect user forcing due to {2}. See the 
“C.2.13 User Forcing Overridden” section on page C-23.

Amplifier algorithm Unsupported configuration due to excessive number of amplifiers 
(max {0} per directions). See the “C.2.14 Unsupported 
Configuration” section on page C-23.

Amplifier algorithm Unsupported configuration due to excessive number of OSC regen 
sites (max {0}). See the “C.2.14 Unsupported Configuration” 
section on page C-23.

Amplifier algorithm In {0}, channel power is near the fail threshold. See the 
“C.2.15 Channel Power Near the Fail Threshold” section on 
page C-24.

Amplifier algorithm In {0}, channel power is below the fail threshold. See the 
“C.2.16 Channel Power Below the Fail Threshold” section on 
page C-24.

Amplifier algorithm In {0}, OSC channel power is near the fail threshold. See the 
“C.2.15 Channel Power Near the Fail Threshold” section on 
page C-24.

Amplifier algorithm In {0}, OSC channel power is below the fail threshold. See the 
“C.2.17 OSC Channel Power Below the Fail Threshold” section on 
page C-25.

Amplifier algorithm Network unfeasible due to OSC channel. See the “C.2.17 OSC 
Channel Power Below the Fail Threshold” section on page C-25.

Amplifier algorithm Try to unfreeze amplifier or dcus in site {0}, interface {1}, {2} 
position

Amplifier algorithm Transmission error. Please contact custom design.

Amplifier algorithm Transmission error on channel {0}. Please contact custom design.

Amplifier algorithm Excessive ROADM crossTalk penalty on channel {0}. Try to lower 
the output power of the preamplifier in the Roadm site in which the 
failed channels are added.

Amplifier algorithm Excessive filtering penalty on channel {0}. Please contact custom 
design.
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C.1 Traffic Mapping Troubleshooting
The following procedures help you resolve traffic mapping problems with the network design.

C.1.1 Wavelength Exceeded

Symptom Cisco TransportPlanner warns you that all network analysis solutions exceed the wavelengths.

Table C-2 describes the potential causes of the symptom and the solution.

Amplifier algorithm Filtering problem on channel {0}. Please contact custom design.

Amplifier algorithm Excessive PMD on channel {0}. Please contact custom design.

Layout messages MSTP shelves number in site {0} exceeds maximum MultiShelf 
configuration (12).

Layout messages No linecards placed in Hybrid site {0} optical shelf.

Layout messages Release 4.7/5.0 does not support MultiShelf.

Layout messages No PRE/BST card present with OSCM in site {0}.

Layout messages Layout not feasible for {0} Individual Shelf configuration - No room 
in the optical shelf to host all the OTS units.

Layout messages No space for DCU: unlock Site {0} layout.

Layout messages Hybrid Layout in Site {0} is allowed with Individual Shelf only.

Layout messages Node protection is not allowed in Terminal Site {0}.

Layout messages DCC Chain in Site {0} is allowed with Individual Shelf only.

Layout messages Node protection in Site {0} is not allowed with Individual Shelf.

Layout messages Cable DB part not identified in Site {0}.

Layout messages Site {0} layout must be unlocked to allow Patch Panel/DCU 
insertion.

Layout messages Layout in site {0} cannot be built due an internal error. Other reports 
for the same site may be wrong or incomplete. Please contact 
support.

1. Cisco TransportPlanner will replace {n} with a specific unit name. 
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C.1.2 Invalid Routing

Symptom Cisco TransportPlanner warns you of invalid routing (out of network boundary).

Table C-3 describes the potential causes of the symptom and the solution.

C.1.3 Cannot Find Alternate Route

Symptom Cisco TransportPlanner warns you that it cannot find an alternate route due to multiple hub 
nodes along the path.

Table C-4 describes the potential causes of the symptom and the solution.

Table C-2 Wavelength Exceeded

Possible Problem Solution

A span in the ring must 
carry more than 32 
wavelengths to implement 
the traffic demands.

Remove the forced path routing on unprotected channels:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Path column, choose Auto from the drop-down list.

3. Reanalyze the network.

A span in the ring must 
carry more than 16/8 
wavelengths.

Change the traffic mapping design rules under the related subnet and 
choose an option that allows a greater number of channels:

1. In the Project Explorer under the Subnets folder, expand Traffic 
Mapping and click System Release.

2. In the Properties pane, choose the new rules option from the C-Band 
Rules or L-Band Rules drop-down list.

3. Reanalyze the network.

Table C-3 Invalid Routing

Possible Problem Solution

In a linear network, the 
direction of each service 
demand is restricted by 
the topology but the user 
applied an unfeasible 
direction forcing.

Remove the forced path routing:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Path column of the Edit <demand> dialog box, choose Auto 
from the drop-down list.

3. Reanalyze the network.
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C.1.4 Cannot Route Service

Symptom Cisco TransportPlanner warns you that it cannot route service through a hub node.

Table C-5 describes the potential causes of the symptom and the solution.

C.1.5 Overlapped Services Assigned to the Same Wavelength

Symptom Cisco TransportPlanner warns you that overlapped services are assigned to the same 
wavelength.

Table C-6 describes the potential causes of the symptom and the solution.

Table C-4 Cannot Find Alternate Route

Possible Problem Solution

Because a hub node does 
not allow express 
channels, if multiple hub 
nodes are present, not all 
point-to-point 
connections are possible. 

Remove the hub functionality constraints:

1. In the Project Explorer under the Sites folder, click C-Band or 
L-Band for the appropriate site.

2. In the Properties pane, choose Auto from the Functionality drop-down 
list.

3. Reanalyze the network.

Table C-5 Cannot Route Service

Possible Problem Solution

Since a hub node does not 
allow express channels, 
not all service routes are 
possible.

Remove the path routing forcing or the hub functionality constraints.

To remove the path routing forcing:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Path column of the Edit <demand> dialog box, choose Auto 
from the drop-down list.

3. Reanalyze the network.

To remove the hub functionality constraints:

1. In the Project Explorer under the Sites folder, click C-Band or 
L-Band for the appropriate site.

2. In the Properties pane, choose Auto from the Functionality drop-down 
list.

3. Reanalyze the network.
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C.1.6 Protected Services Assigned to the Same Wavelength

Symptom Cisco TransportPlanner warns you that protected services are assigned to the same wavelength.

Table C-7 describes the potential causes of the symptom and the solution.

C.1.7 Cannot Route Service Because of Add/Drop Constraints

Symptom Cisco TransportPlanner warns you that it cannot route service because of add/drop equipment 
constraints.

Table C-8 describes the potential causes of the symptom and the solution.

Table C-6 Overlapped Services Assigned to the Same Wavelength

Possible Problem Solution

Some unprotected 
channels with assigned 
wavelengths and 
directions overlap along 
the ring.

Remove path routing forcing and/or wavelengths on the specific channels.

To remove the path routing forcing:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Path column of the Edit <demand> dialog box, choose Auto 
from the drop-down list.

3. Reanalyze the network.

To remove the wavelength forcing:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Wavelength column of the Edit <demand> dialog box, choose 
Auto from the drop-down list.

3. Reanalyze the network.

Table C-7 Protected Services Assigned to the Same Wavelength

Possible Problem Solution

In ring networks, each 
protected/P-ring request 
allocates one wavelength. 
If more than one protected 
service is forced on the 
same wavelength and 
aggregation is not 
possible, the network is 
not feasible.

Remove forced wavelengths on the specific channels:

1. In the Project Explorer under the Service Demands folder, right-click 
the appropriate demand and choose Edit from the shortcut menu.

2. In the Wavelength column of the Edit <demand> dialog box, choose 
Auto from the drop-down list.

3. Reanalyze the network.
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C.1.8 Design Requires a ROADM or Full Mux/Demux Site

Symptom Cisco TransportPlanner warns you that the design requires a ROADM or full 
multiplexer/demultiplexer site, but no valid site was found.

Table C-9 describes the potential causes of the symptom and the solution.

Table C-8 Cannot Route Service Because of Add/Drop Constraints

Possible Problem Solution

Add/drop equipment 
forcing might prevent 
express channels in a 
node, which makes 
unfeasible some channel 
routes.

Remove add/drop equipment constraints.

1. In the Project Explorer under the Sites folder, click C-Band or 
L-Band for the appropriate site.

2. In the Properties pane, choose Auto from the Functionality drop-down 
list.

3. Reanalyze the network.

Table C-9 Cannot Route Service Because of Add/Drop Constraints

Possible Problem Solution

The traffic mapping 
algorithm might not be 
able to find a valid 
solution that respects both 
the user forcing and the 
system specifications (in 
terms of maximum site 
losses and layout 
constraints). In such 
cases, the only possible 
countermeasure for the 
algorithm is to upgrade 
one node to a full capacity 
node (ROADM or full 
Mux/Demux). If no valid 
node is found due to user 
forcing or equipment 
locking, the process stops 
and the network is 
unfeasible.

Remove any forcing/locking that prevents at least one node from being 
upgraded to ROADM or full multiplexer/demultiplexer. Conditions that 
prevent upgrading a node to ROADM or full multiplexer/demultiplexer 
are:

• Site functionality is forced to Add/Drop and site type is forced to 
OADM

• During an upgrade procedure, OADM equipment is locked it the site

To change site functionality and type forcing:

1. In the Project Explorer under the Sites folder, click C-Band or 
L-Band for the appropriate site.

2. In the Properties pane, choose Auto from the Functionality drop-down 
list.

3. Choose Auto from the Type drop-down list.

4. Reanalyze the network.

To unlock OADM equipment:

1. In the Project Explorer under the Sites folder, click Add/Drop under 
the appropriate site. 

2. In the Properties pane, choose Auto from the OADM Forcing 
drop-down list.

3. Reanalyze the network.
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C.2 Amplifier Troubleshooting
The following procedures help you resolve amplifier-related problems with the network design.

C.2.1 Incompatible DCUs (C-Band)

Symptom Cisco TransportPlanner warns you that DCUs are incompatible.

Table C-10 describes the potential causes of the symptom and the solution.

C.2.2 MMU Does Not Have Correct Amplifier (L-Band)

Symptom Cisco TransportPlanner warns you that an L-band node with an MMU requires that the 
OPT-AMP-L card is forced as the preamplifier (PRE) and booster amplifier (BST).

Table C-11 describes the potential causes of the symptom and the solution.

Table C-10 Incompatible DCUs (C-Band)

Possible Problem Solution

If the DCUs in the same 
site are both SMF slope 
compensating, the 
cumulative negative 
dispersion should not be 
over 1600 ps/nm.

Remove or change one of the forced DCUs:

1. In the Project Explorer, click C-Band Amplifiers.

2. In the Properties pane, choose the desired DCU from the DCU1 and/or 
DCU2 drop-down lists.

3. Reanalyze the network.
If the DCUs in the same 
site belong to different 
types, only the following 
DCU combinations are 
allowed: DCU-E-200 and 
DCU-100, or DCU-E-350, 
and DCU-100.

Two E-LEAF slope 
compensating DCUs are 
not allowed at the same 
site.
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C.2.3 MMU Does Not Have Correct Amplifier (C-Band)

Symptom Cisco TransportPlanner warns you that a C-band node with an MMU requires both a 
preamplifier (OPT-PRE) and a booster (OPT-BST).

Table C-12 describes the potential causes of the symptom and the solution.

C.2.4 Output Power or Tilt are Out of Range

Symptom Cisco TransportPlanner warns you that the output power or tilt are out of range for the 
amplifier selected.

Table C-13 describes the potential causes of the symptom and the solution.

Table C-11 MMU Does Not Have the Correct Amplifier (L-Band)

Possible Problem Solution

In L-band, a node with an 
MMU installed has 
amplifier forcing other 
than two OPT-AMP-L 
amplifier units, one as 
PRE and one as BST.

Remove any amplifier forcing in the node:

1. In the Project Explorer under the Sites folder, click L-Band 
Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the PRE and BST 
drop-down lists.

3. Reanalyze the network.

Table C-12 MMU Does Not Have the Correct Amplifier (C-Band)

Possible Problem Solution

In C-band, a node with an 
MMU installed requires 
both OPT-PRE and 
OPT-BST.

Remove any amplifier forcing in the node:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the PRE and BST 
drop-down lists.

3. Reanalyze the network.

Table C-13 Output Power or Tilt are Out of Range

Possible Problem Solution

The output power or tilt 
forced by the user is not 
within the allowed range 
based on the algorithm 
selected and the type of 
amplifier selected.

Remove or change the forced value:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the Tilt drop-down list in the 
From Fibre and To Fibre areas. If you force a value, the tilt value limits 
are -3.0 to +3.0.

3. Reanalyze the network.
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C.2.5 Invalid Fiber Values, Types, and Loss Values

Symptom Cisco TransportPlanner warns you of one of the following:

• Fiber pairs are of invalid types or values

• Fibers have a start of life (SOL) total loss greater than an end of life (EOL) total loss

Table C-14 describes the potential causes of the symptom and the solution.

C.2.6 Attenuator Forcing Not Allowed

Symptom Cisco TransportPlanner warns you that attenuator forcing on channels is not allowed; no 
add/drop ports are available.

Table C-15 describes the potential causes of the symptom and the solution.

Table C-14 Invalid Fiber Values, Types, and Loss Values

Possible Problem Solution

An attenuator is forced in 
a site where there is no 
place to connect.

Remove the attenuator forcing or verify that the attenuator is inserted on 
the correct side and wavelength:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, complete one of the following:

• Choose Auto from the Attenuator drop-down list in the From 
Fibre area to remove the forcing.

• Verify that the attenuator is inserted on the correct side and 
wavelength. If not, revise accordingly.

3. Reanalyze the network.

Table C-15 Attenuator Forcing Not Allowed

Possible Problem Solution

Cisco TransportPlanner 
has an attenuator forced in 
a site where there is no 
place to connect.

Remove the attenuator forcing or verify that the attenuator is inserted on 
the correct side and wavelength:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, complete one of the following:

• Choose Auto from the Attenuator drop-down list for the 
appropriate amplifier.

• Verify that the attenuator is inserted on the correct side and 
wavelength. If not, revise accordingly.

3. Reanalyze the network.
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C.2.7 Unavailable Add/Drop Channels

Symptom Cisco TransportPlanner warns you that an attenuator was present, but add/drop channels are no 
longer available.

Table C-16 describes the potential causes of the symptom and the solution.

C.2.8 Tilt Forced When No Tilt Design is Selected

Symptom Cisco TransportPlanner warns you that tilt is forced for an amplifier although No Tilt Design 
was selected for the network.

Table C-17 describes the potential causes of the symptom and the solution.

Table C-16 Unavailable Add/Drop Channels

Possible Problem Solution

After a network upgrade, a 
client was removed but the 
add/drop attenuator is still 
forced.

Unlock the add/drop attenuator:

1. In the Project Explorer under the Sites folder, click Client for the 
appropriate site.

2. In the Properties pane, choose Auto from the drop-down list for the 
appropriate Rx and Tx attenuator.

3. Reanalyze the network.

Table C-17 Tilt Forced When No Tilt Design is Selected

Possible Problem Solution

The user forced one or 
more amplifier tilt setting, 
but the No Tilt Design 
option is also selected. 

Note To view that No 
Tilt Design is 
selected in the 
Project Explorer, 
click the 
appropriate 
system release 
under DWDM 
Design Rules 
settings in the 
Subnets folder.

Remove forced tilt for the amplifier:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the Tilt drop-down list for 
the appropriate amplifier.

3. Reanalyze the network.
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C.2.9 Cannot Replace 32-DMX with 32DMX-O

Symptom Cisco TransportPlanner warns you that 32-DMX cannot be replaced with 32DMX-O as needed 
because of user forcing.

Table C-18 describes the potential causes of the symptom and the solution.

C.2.10 Preamplifier Working in Invalid Mode

Symptom Cisco TransportPlanner warns you that a preamplifier is working in an invalid mode.

Table C-19 describes the potential causes of the symptom and the solution.

Table C-18 Cannot Replace 32-DMX with 32DMX-O

Possible Problem Solution

Cisco TransportPlanner 
attempts to use the 
32DMX-O card but the 
32-DMX card is forced by 
the user. This could cause 
an overload of alarms or, 
if no channel is alarmed, 
problems during network 
installation.

If channels dropped at the site are alarmed, allow the use of add/drop 
attenuators:

1. In the Project Explorer under the Subnets folder, expand DWDM 
Design Rules and click System Release.

2. In the Properties pane, uncheck No TXT/Line-Card RX Bulk 
Attenuator Design.

3. Reanalyze the network.

If no channel is alarmed, remove the 32-DMX forcing:

1. In the Project Explorer under the Sites folder, click Add/Drop for the 
appropriate site.

2. In the Properties pane, choose Auto from the Demux drop-down list.

3. Reanalyze the network.
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C.2.11 Gain Too Low for an Amplifier

Symptom Cisco TransportPlanner warns you that an amplifier is working with a gain that is too low.

Table C-20 describes the potential causes of the symptom and the solution.

C.2.12 Gain Too High for an Amplifier 

Symptom Cisco TransportPlanner warns you that an amplifier is working with a gain that is too high.

Table C-21 describes the potential causes of the symptom and the solution.

Table C-19 Preamplifier Working in Invalid Mode

Possible Problem Solution

A preamplifier is working 
in power control mode. 
Based on the traffic 
matrix, channel 
survivability might not be 
guaranteed if the fiber is 
cut or the equipment fails.

If the booster amplifier preceding the preamplifer is forced as None by the 
user, remove the None forcing on the booster amplifier:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the Tilt drop-down list for 
the From Fibre (BST) amplifier.

3. Reanalyze the network.

If the span preceding the preamplifier is within the 27 to 30 dB range, use 
a higher powered C- or L-band rules algorithm (such as, 32 Chs + 5 
dBm/ch):

1. In the Project Explorer under the Subnets folder, expand Traffic 
Mapping and click System Release.

2. In the Properties pane, choose the new rules option from the C-Band 
Rules or L-Band Rules drop-down list.

3. Reanalyze the network.

If span is greater than 30 dB, the error is unavoidable.

Table C-20 Gain Too Low for an Amplifier

Possible Problem Solution

An amplifier is working 
with a gain lower than its 
minimum capabilities. 
This could be caused by a 
span that is too short or by 
compensation problems 
(L-band only) coupled 
with the “Use in-line 
attenuator” option not 
selected.

If attenuators are forced or inline attenuators were disabled, remove the 
forcing on the attenuators:

1. In the Project Explorer under the Sites folder, click Add/Drop for the 
appropriate site.

2. In the Properties pane, choose Auto from the Attenuator drop-down 
list.

3. Reanalyze the network.
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C.2.13 User Forcing Overridden

Symptom Cisco TransportPlanner warns you that user forcing will not be allowed.

Note This is a warning and does not prevent the network from being fully functional.

Table C-22 describes the potential causes of the symptom and the solution.

C.2.14 Unsupported Configuration

Symptom Cisco TransportPlanner warns you that the configuration is unsupported because of an 
excessive number of amplifiers or OSC regeneration sites.

Table C-23 describes the potential causes of the symptom and the solution.

Table C-21 Gain Too High for an Amplifier

Possible Problem Solution

An amplifier is working 
with a gain that is greater 
than its physical 
capabilities.

Remove the forcing on the attenuators:

1. In the Project Explorer under the Sites folder, click Add/Drop for the 
appropriate site.

2. In the Properties pane, choose Auto from the Attenuator drop-down 
list.

3. Reanalyze the network.

Table C-22 User Forcing Overridden

Possible Problem Solution

If the warning appears 
during a network upgrade, 
this means the installation 
parameters must be 
updated because the 
upgrade is traffic 
affecting. This warning 
could also appear after 
importing a Cisco 
MetroPlanner 2.5.x 
network with all output as 
forcings.

For a network upgrade, unlock the site with the warning.

For a 2.5.x import, if you cannot update the installation parameters, open 
the design in Cisco MetroPlanner 2.5.x.
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C.2.15 Channel Power Near the Fail Threshold

Symptom Cisco TransportPlanner warns you that the channel power is near the fail threshold.

Table C-24 describes the potential causes of the symptom and the solution.

C.2.16 Channel Power Below the Fail Threshold

Symptom Cisco TransportPlanner warns you that the channel power is below the fail threshold.

Table C-25 describes the potential causes of the symptom and the solution.

Table C-23 Unsupported Configuration

Possible Problem Solution

The system is working 
over its specifications.

Revise the design and reanalyze.

Table C-24 Channel Power Near the Fail Threshold

Possible Problem Solution

Some thresholds are set to 
the minimum value 
allowed; this could lead to 
some false alarms during 
network life.

Remove the forcing:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the PRE and BST 
drop-down lists. 

3. Reanalyze the network.

Table C-25

Possible Problem Solution

The channel power 
received by the site is too 
low, and the fail threshold 
cannot be set.

Remove the forcing:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the PRE and BST 
drop-down lists. 

3. Reanalyze the network.
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C.2.17 OSC Channel Power Below the Fail Threshold

Symptom Cisco TransportPlanner warns you that the OSC channel power is below the fail threshold and 
that the network is not feasible.

Table C-26 describes the potential causes of the symptom and the solution.

Table C-26 OSC Channel Power Below the Fail Threshold

Possible Problem Solution

The OSC channel is not 
working.

Remove the forcing:

1. In the Project Explorer under the Sites folder, click C-Band 
Amplifiers or L-Band Amplifiers for the appropriate site.

2. In the Properties pane, choose Auto from the OSC drop-down list. 

3. Reanalyze the network.

If the span where the OSC fails is longer than 37 dB, the error is 
unavoidable.
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Third-Party DWDM Wavelength Interface Model

Cisco TransportPlanner allows you to define a third-party dense wavelength division multiplexing 
interface to be used in project creation. After you define third-party DWDM interfaces, you can choose 
them when creating traffic demands. This appendix provides background information for calculating 
third-party client wavelength interfaces.

Interface Operative Area
In the Cisco TransportPlanner interface model, the operative area of an interface is defined on a 
two-dimensional Cartesian plane where the x-axis is the optical signal-to-noise ratio (OSNR) value (dB) 
and y-axis is the receiver (Rx) power value (dBm). Three lines border the operative area. These lines are 
an approximation of the ISO-Bit Error Rate (BER) curve corresponding to the maximum BER tolerable 
by the interface:

• On the original ISO-BER curve there are two points, OL and PL, that define the two main borders: 
OSNR limited (OL) and power limited (PL). 

• The upper boundary of the OSNR-limited border is the interface power overload; this is also the 
upper limit to the working area. Physical constraints limit this value to 35 to 40 dB.

Figure D-1 shows the working area in an interface. 
D-1
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Figure D-1 Interface Operative Area

Signal impairments reduce the operative area of the interface. Because of signal distortion, higher OSNR 
and/or power on the Rx are required to get the same BER. When the power and OSNR margins are 
increased, OL and PL identify a new working area (Figure D-2).
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Figure D-2 Interface Margin Application

To define a third-party client interface, you enter parameters in Cisco TransportPlanner that build the 
working area and model its robustness to signal impairments such as dispersion, single interfering, 
Gaussian cross talk (Xt), etc. The input parameters follow:

• Transmitter characteristics:

– Modulation format— Non Return to Zero (NRZ) or Duo Binary

– Transmitter type—Mach Zehnder (MZ), Direct Modulated Laser (DML), or Electro-absorption 
Modulated Laser (EML)

– Receiver threshold—Optimal (minimum BER) or Average (average received power)

– Regeneration type—3R or 2R regeneration mode

– Forward Error Correction (FEC) mode—FEC, Enhanced FEC (E-FEC), or none

– Transmitter stability—The maximum wavelength error allowed (pm)

• Bit rate

• Power range—Transmit (Tx) maximum and minimum power output levels (dBm)

• Back-to-back receiver sensitivity—A configuration in which the receiver is placed in front of the 
transmitter with no other equipment between the two. Back to back is used to measure Tx and Rx 
pairs.

– Overload power (dBm)

– OL_power (dBm)—The minimum power level in the OSNR-limited range

– OL_OSNR (dB)—The minimum OSNR level in the OSNR-limited range (measured on 0.5 nm 
bandwidth)

– PL_power (dBm)—The minimum power level in the power-limited range
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– PL_OSNR (dB)—The minimum power level in the OSNL-limited range (measured in .5 nm 
increments)

• Chromatic dispersion (CD)—The broadening of a light pulse after traveling a distance in the fiber. 
You can set the CD robustness [ps/nm], which is the maximum positive dispersion tolerable by the 
interface.

• Scale value—Calculates how efficient a card is in recovering the signal distortion. For more 
information, see the “Scale Factors” section on page D-4.

• Single-interfering cross-talk penalties—Calculates interference caused by a single signal. For more 
information, see the “Single-Interfering Cross-Talk Penalty Measurement” section on page D-5.

• Gaussian cross-talk penalties—Calculates random power that interferes with a signal. For more 
information, see the “Gaussian Cross-Talk Penalty Measurement” section on page D-6.

Transmitter characteristics, bit rate, and back-to-back sensitivity parameters are required to create a 
third-party interface; the other parameters are optional. Cisco TransportPlanner checks your input to 
determine if the third-party interface could be modeled on a card type already present in the software. If 
the interface is not supported, TransportPlanner displays an error message. For the procedure to define 
third-party interfaces, see “2.2.4 Defining Third-Party DWDM Interfaces” section on page 2-25. 

Scale Factors
The slope of the Q-factor (BER error function) curve versus OSNR or Rx power determines how a BER 
increase could be recovered with an increase of OSNR, power, or both depending in which OSNR/power 
working point the card is. In general, the scale factors are two values (one in OSNR and one in power) 
for each working point (OL and PL) of the interface model. If one is zero, it means that for that working 
point the BER is not sensitive to an increase. At least one factor must be different from zero. 

The scale factors reflect the optical signal after it has passed through the maximum dispersion it can 
tolerate, because when the signal is more distorted the slope is higher and the factors are applied on 
impairments other than dispersion. As a result, the slope should be calculated at the OSNR and power 
of the OL and PL points with the dispersion margins added. Q-factor variation is 2 dB.

F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values entered in Cisco TransportPlanner translate 
a Q-penalty (that is, a BER increase) into power and OSNR penalties. F-P(PL) and F-OSNR(PL) are 
evaluated in the PL working region, while F-P(OL) and F-OSNR(OL) are evaluated in the OL working 
region of the curve with the dispersion margins added.

The formulas follow:

• P-penalty(PL) = Q-penalty *  F-P(PL)

• P-penalty(OL) = Q-penalty *  F-P(OL)

• OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)

• OSNR-penalty(OL) = Q-penalty * F-OSNR(OL) 

Figure D-3 illustrates the increase in OSNR corresponding to a variation of the Q-factor equal to 2 dB.
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Figure D-3 Q-Factor Curve

Single-Interfering Cross-Talk Penalty Measurement
The single interfering cross-talk (Xt) measurement is shown in Figure D-4. The signal is split into two 
parts and recombined after one part has passed through attenuation, polarization scrambling, and linear 
transmission. The cross-talk calculation is the ratio between the two recombined signals. The attenuation 
allows different levels of cross-talk. The polarization scrambling measures the worst case of reciprocal 
polarization between the signal and its attenuated replica and the fiber to avoid phase coherence between 
signal and replica. 

Because the penalty depends on the OSNR and power level, the measurement is calculated in the two 
working points OL and PL with the dispersion margin added. Consequently, a fiber with the maximum 
dispersion the interface can tolerate is placed between the transmitter and the splitter, as shown in 
Figure D-5. Transmission into the fiber should be linear (with channel power less than –10 dBm).

To calculate single-interfering cross-talk, you can input the coefficients for the exponential curves that 
estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and OSNR-penalty(OL) for in the OL and 
PL regions of the interface model with dispersion margins added. The formula is Penalty(IXt) = A_SIXt* 
exp(B_SIXt* IXt). 
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Figure D-4 Generation Block for Single-Interfering Cross-Talk Measurement

Figure D-5 Block Diagram for Crosstalk Measure

Gaussian Cross-Talk Penalty Measurement
Cross-talk with Gaussian statistics can be simulated by recombining a high number of interfering 
signals. The interfering branch shown in Figure D-4 set up has to be replicated in order to obtain more 
interfering signals, as shown in Figure D-6. The signal is split into N parts and each part but one passes 
through an attenuator (from A1 to AN in Figure D-6), a polarization scrambler, and a spool of fiber. Ten 
interfering signals are enough to guarantee a good approximation of the Gaussian statistics. In case of 
the single interfering cross-talk, the penalty depends on the working point, OSNR/power, in which the 
card is working. The measurement should be done in the OL and PL with dispersion margin added with 
the maximum dispersion tolerable by the card, as shown in the block diagram of Figure D-5.

To calculate Gaussion cross-talk levels, you can enter the coefficients for the exponential curves that 
estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and OSNR-penalty(OL) in the OL and PL 
regions of the interface model with dispersion margins added. The formula is Penalty(GXt) = A_GXt  * 
exp(B_GXt *GXt).
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Appendix D      Third-Party DWDM Wavelength Interface Model
Gaussian Cross-Talk Penalty Measurement
Figure D-6 Generation Block for Gaussian Cross-Talk Measurement
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